
Cisco Crosswork Network Controller 6.0 Installation Guide
First Published: 2023-12-19

Last Modified: 2024-04-26

Americas Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000

800 553-NETS (6387)
Fax: 408 527-0883



THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS,
INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH
THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY,
CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of
the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHERWARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS" WITH ALL FAULTS.
CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT
LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network
topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional
and coincidental.

All printed copies and duplicate soft copies of this document are considered uncontrolled. See the current online version for the latest version.

Cisco has more than 200 offices worldwide. Addresses and phone numbers are listed on the Cisco website at www.cisco.com/go/offices.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL:
https://www.cisco.com/c/en/us/about/legal/trademarks.html. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a
partnership relationship between Cisco and any other company. (1721R)

© 2023–2024 Cisco Systems, Inc. All rights reserved.

https://www.cisco.com/c/en/us/about/legal/trademarks.html


C O N T E N T S

Get Started 11P A R T I

Overview 1C H A P T E R 1

About this guide 1

Audience 1

Introduction 2

Security 4

Plan Your Deployment 5C H A P T E R 2

Before You Begin 5

Determine How Many VMs You Need 5

Identify the Resource Footprint 7

Special Considerations 9

Choose Your Installation Workflow 11C H A P T E R 3

Overview 11

Install Cisco Crosswork Network Controller on VMware vCenter 11

Install Cisco Crosswork Network Controller on AWS EC2 13

Install Cisco Crosswork Network Controller on VMware vCenter 17P A R T I I

Installation Prerequisites for VMware vCenter 19C H A P T E R 4

Overview 19

Supported Network Topology Models 19

VMware Settings 25

Host VM Requirements 26

Cisco Crosswork Network Controller 6.0 Installation Guide
iii



Crosswork Cluster VM Requirements 27

Crosswork Data Gateway VM Requirements 28

Crosswork TCP/UDP Port requirements 31

IP Address Restrictions 36

Install Crosswork Cluster on VMware vCenter 39C H A P T E R 5

Installation Overview 39

Installation Parameters 39

Install Cisco Crosswork on VMware vCenter using the Cluster Installer Tool 44

Sample manifest templates for VMware vCenter 49

Set seed node explicitly 57

Manual Installation of Cisco Crosswork using vCenter vSphere UI 58

Build the OVF template 59

Deploy the template 65

Monitor Cluster Activation 69

Log into the Cisco Crosswork UI 71

Troubleshoot the Cluster 73

Install Cisco Crosswork Data Gateway on VMware vCenter 79C H A P T E R 6

Cisco Crosswork Data Gateway Installation Workflow 79

Cisco Crosswork Data Gateway Parameters and Deployment Scenarios 80

Install Cisco Crosswork Data Gateway using vCenter vSphere Client 93

Install Cisco Crosswork Data Gateway via OVF Tool 105

Sample Script for Crosswork Data Gateway IPv4 Deployment 106

Sample Script for Crosswork Data Gateway IPv6 Deployment 108

Log in and Log out of Crosswork Data Gateway VM 110

Access Crosswork Data Gateway VM from SSH 110

Access Crosswork Data Gateway through vCenter 111

Log Out of Crosswork Data Gateway VM 111

Cisco Crosswork Data Gateway Authentication and Enrollment 112

Crosswork Data Gateway Post-installation Tasks 112

Configure Timezone of the Crosswork Data Gateway VM 113

Troubleshoot Crosswork Data Gateway Installation and Enrollment 114

Import Controller Signing Certificate File 117

Cisco Crosswork Network Controller 6.0 Installation Guide
iv

Contents



View the Controller Signing Certificate File 118

Install Cisco Crosswork Network Controller on AWS EC2 119P A R T I I I

Installation Prerequisites for AWS EC2 121C H A P T E R 7

Overview 121

Amazon EC2 Settings 121

Host VM Requirements 124

Crosswork Cluster VM Requirements 124

Crosswork Data Gateway VM Requirements 125

Crosswork TCP/UDP Port requirements 129

IP Address Restrictions 133

Install Cisco Crosswork Network Controller on AWS EC2 135C H A P T E R 8

Installation Overview 135

Extract CF Template Image 135

Roles and Policy Permissions 137

Configure the CloudFormation (CF) Template Parameters 137

CF Template Parameters for Installing Cisco Crosswork Cluster VMs 138

CF Template Parameters for Installing Crosswork Data Gateway 144

CF Template Parameters for Installing NSO 147

CF Template Parameters for Installing Single Hybrid Cluster or Worker Node 148

Install Using Module Deployment Method 150

Install Cisco Crosswork Cluster on Amazon EC2 150

Install Crosswork Data Gateway on Amazon EC2 151

Auto-Configuration for Deploying Crosswork Data Gateway 153

Install Cisco NSO on Amazon EC2 156

Deploy an Additional Crosswork Cluster Node 157

Manage CF Template Deployment 157

Deploy a CF Template 158

Monitor the Installation 159

Accessing the Crosswork UI 159

Crosswork Data Gateway Post-installation Tasks 160

Configure Timezone of the Crosswork Data Gateway VM 160

Cisco Crosswork Network Controller 6.0 Installation Guide
v

Contents



Log in and Log out of Crosswork Data Gateway VM 162

Access Crosswork Data Gateway VM from SSH 162

Log out of Crosswork Data Gateway VM 162

Troubleshoot Crosswork Data Gateway Installation and Enrollment 162

Import Controller Signing Certificate File 165

View the Controller Signing Certificate File 166

Install Crosswork Applications 167P A R T I V

Install Crosswork Applications 169C H A P T E R 9

Install Crosswork Applications 169

Integrate Cisco NSO and SR-PCE with Cisco Crosswork Network Controller 173P A R T V

Integrate Cisco NSO 175C H A P T E R 1 0

NSO Integration Workflow 175

Install Cisco NSO Function Pack Bundles from Crosswork UI 176

View NSO Function Pack Bundles 177

Manage NSO Function Pack Bundles 178

Deploy NSO Function Pack Bundles 180

Troubleshoot the NSO Function Pack Installation 183

View NSO Function Pack Job History 184

Install Cisco NSO Function Packs Manually 185

Add Cisco NSO Providers 185

(Optional) Set up Cisco NSO Layered Service Architecture 187

Integrate SR-PCE 189C H A P T E R 1 1

SR-PCE Integration Workflow 189

Configure SR-PCE 189

Sample SR-PCE config 192

Add Cisco SR-PCE Providers 192

Upgrade Cisco Crosswork Network Controller 197P A R T V I

Cisco Crosswork Network Controller 6.0 Installation Guide
vi

Contents



Upgrade Cisco Crosswork 199C H A P T E R 1 2

Upgrade Overview 199

Upgrade Requirements 200

Upgrade Using Existing Hardware 202

Shut Down Cisco Crosswork Data Gateway VMs 202

Create Backup and Shut Down Cisco Crosswork 203

Install the latest version of the Cisco Crosswork Cluster 205

Install the Cisco Crosswork Applications 206

Migrate Cisco Crosswork Backup 206

Upgrade Crosswork Data Gateway 208

Troubleshoot Crosswork Data Gateway Upgrade Issues 210

Post-upgrade Checklist 210

Upgrade Using Parallel Hardware 212

Deploy a new Cisco Crosswork Cluster 212

Backup Cisco Crosswork Cluster 213

Update DNS Server and Run Migration 215

Add Crosswork Data Gateway to Cisco Crosswork 216

Shut Down the old Cisco Crosswork Cluster 218

Update a Crosswork Application (standalone activity) 219

Uninstall Cisco Crosswork Network Controller 223P A R T V I I

Uninstall Cisco Crosswork 225C H A P T E R 1 3

Uninstall the Crosswork Cluster 225

Delete the VM using the Cluster Installer 225

Delete the VM using the vSphere UI 226

Uninstall Crosswork Data Gateway 226

Delete Crosswork Data Gateway VM from Cisco Crosswork 227

Delete Crosswork Data Gateway from the Crosswork Cluster 227

Uninstall Crosswork Applications 228

Enable Geo Redundancy 231P A R T V I I I

Cisco Crosswork Network Controller 6.0 Installation Guide
vii

Contents



Geo Redundancy Overview 233C H A P T E R 1 4

Disclaimer 233

Introduction 233

Geo Redundancy Requirements 235C H A P T E R 1 5

Unified Endpoint Requirements 235

Crosswork Cluster Requirements 235

Crosswork Data Gateway Requirements 236

Enable Geo Redundancy Solution 237C H A P T E R 1 6

Geo Redundancy Workflow (Day 0) 237

Connectivity Checks 239

Enable Geo Redundancy 241

Sample Cross Cluster Inventory Template 243

View Cross Cluster Status 245

Configure Cross Cluster Storage Settings 246

Configure Cross Cluster Sync Settings 247

Configure Cross Cluster DNS Settings 248

Configure Cross Cluster Arbitration Settings 250

Configure Cross Cluster Notification Settings 251

Geo Redundancy Scenarios 252

Install Geo HA Crosswork Data Gateway 253

Upgrade to Geo Redundancy Solution 255C H A P T E R 1 7

Upgrade from Crosswork Network Controller 5.0 to 6.0 (Geo Redundant) 255

Convert Single Instance NSO to NSO HA 256

Create Backup of the Cisco Crosswork Cluster 257

Install the Cisco Crosswork 6.0 Cluster and Applications 259

Run Migration 260

Install the Standby Cluster and Enable Geo Redundancy 261

Upgrade Crosswork Data Gateway 5.0 to 6.0 Geo Redundancy 262

Update Providers 263

Complete Geo Redundancy Enablement 263

Cisco Crosswork Network Controller 6.0 Installation Guide
viii

Contents



Geo Redundancy Switchover 265C H A P T E R 1 8

Perform Switchover 265

Cisco Crosswork Network Controller 6.0 Installation Guide
ix

Contents



Cisco Crosswork Network Controller 6.0 Installation Guide
x

Contents



P A R T I
Get Started

• Overview, on page 1
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C H A P T E R 1
Overview

This chapter contains the following topics:

• About this guide, on page 1
• Audience, on page 1
• Introduction, on page 2
• Security, on page 4

About this guide
This guide explains the requirements and processes to install or upgrade Crosswork Network Controller
solution.

This document does not cover the installation of integrated components (such as Cisco NSO, Cisco SR-PCE,
or Cisco WAE) that may already be installed or can be used independently. For more details about these
components, please refer to their respective installation documentation.

Audience
This guide is for experienced network users and operators who want to install Crosswork Network Controller
solution in their network. This guide assumes that you are familiar with the following:

• Using a Docker container

• Running scripts in Python

• Deploying OVF templates using VMware vCenter

• Deploying using OVF tool

• Amazon Web Services (AWS), Amazon EC2 concepts, and creation of CloudFormation templates

Cisco Crosswork Network Controller 6.0 Installation Guide
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Introduction
Cisco Crosswork Network Controller

Cisco Crosswork Network Controller is an integrated solution (consisting of Cisco Crosswork Infrastructure,
Cisco Crosswork Data Gateway and the Crosswork applications) that enables you to proactively manage your
end-to-end networks, by providing intent-based and closed-loop automation solutions to ensure faster innovation,
optimal user experience, and operational excellence.

Cisco Crosswork Infrastructure

Cisco Crosswork Infrastructure is a microservices-based platform and is the foundation required for running
Crosswork applications. It employs a cluster architecture to be extensible, scalable, and highly available. The
Crosswork cluster consists of three VMs or nodes operating in a hybrid configuration. Additional VMs or
nodes (maximum up to 2 nodes) in aWorker configuration can be added, as needed, to match the requirements
of the deployed applications. A Hybrid node can run infrastructure and application pods, while aWorker node
can run only application pods. The total number of Hybrid and Worker nodes varies based on the size of the
network and the applications being run. Please work with the Cisco Customer Experience team to determine
the number of nodes required for your deployment (see Plan Your Deployment, on page 5).

Hereafter in this guide, Cisco Crosswork Infrastructure is referred to as "Cisco Crosswork".Note

Cisco Crosswork Data Gateway

Cisco Crosswork integrates with one or more Cisco Crosswork Data Gateway(s) to gather information from
the managed devices and forward it to Cisco Crosswork as well as external destinations. The information is
then analyzed and processed by the Crosswork applications and used to manage the network or respond to
changes in the network. The number of Crosswork Data Gateways deployed in your network depends on the
number of devices, the amount of data being collected, the overall topology, and your redundancy requirements.
Each Crosswork Data Gateway is deployed on an individual VM. Please consult with the Cisco Customer
Experience team for guidance on your deployment to best meet your needs.

Crosswork Data Gateway is an integral part of the Crosswork solution being deployed. For this reason, this
document explains Crosswork Data Gateway as a foundational component that must be installed in tandem
with the Crosswork Infrastructure.

Crosswork Applications

The following table describes the Crosswork applications that can be deployed on the Crosswork Network
Controller and the way they are packaged:

Cisco Crosswork Optimization Engine can be installed without any of the other Crosswork Network Controller
applications (see Install Crosswork Applications, on page 169 for more details). However, it is only delivered
as part of the Essential package on Cisco software download site.

Note

Cisco Crosswork Network Controller 6.0 Installation Guide
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Table 1: Cisco Crosswork Network Controller Packages

DescriptionContentsPackage

An application that provides closed-loop tracking of the
network state and real-time network optimization in response
to changes in network state, allowing operators to effectively
maximize network capacity utilization, as well as increase
service velocity.

Cisco Crosswork
Optimization Engine

Essentials Package

A component of Crosswork Network Controller that enables
visualization of topology and services on logical and
geographical maps.

Cisco Crosswork
Active Topology

A library of functions that provides deep inventory collection,
alarm management and image management using Inventory,
Fault, and Software Image Management (SWIM) functions.

Element Management
Functions

An application that overlays a service level view of the
environment and makes it easier for operators to monitor if
services (for example, L2/L3 VPN) are healthy based on the
rules established by the operator.

Cisco Crosswork
Service Health

Advantage Package

An application that automates the process of deploying changes
to the network. Orchestration is defined via an embedded
Ansible Playbook and then configuration changes are pushed
to Cisco Network Services Orchestrator (NSO) to be deployed
to the network.

Cisco Crosswork
Change Automation

Add-on Package

An application that performs real-time Key Performance
Indicator (KPI) monitoring, alerting, and troubleshooting. Cisco
Crosswork Health Insights enables programmable monitoring
and analytics, and builds dynamic detection and analytics
modules that allow operators to monitor and alert on network
events based on user-defined logic.

Cisco Crosswork
Health Insights

An application that streamlines onboarding and provisioning
of Day 0 configuration resulting in faster deployment of
IOS-XR devices at a lower operating cost.

Cisco Crosswork Zero
Touch Provisioning

Cisco Integrated Components

Cisco Network Services Orchestrator functions as the provider for Cisco Crosswork to configure the devices
according to their expected functions, including optionally configuring MDT sensor paths for data collection.
Cisco NSO provides the important functions of device management, configuration and maintenance services.

Cisco Segment Routing Path Computation Element (SR-PCE) is configured to run on either a physical
or virtual device that runs IOS-XR. The SR-PCE supports both Segment Routing Traffic Engineering (SR-TE)
and Resource Reservation Protocol Traffic Engineering (RSVP-TE). Cisco Crosswork uses the combination
of telemetry and data collected from the Cisco SR-PCE to analyze and compute optimal paths for TE tunnels
and/or to discover devices in the network.

Cisco Crosswork Network Controller 6.0 Installation Guide
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Cisco WAN Automation Engine (Cisco WAE) providers supply traffic and topology analysis to the Cisco
Crosswork applications. The foundation software is Cisco WAE Planning, which provides a cross-sectional
view of traffic, topology, and equipment state.

Syslog storage providers supply storage for data collected during Playbook execution.

Alert providers act as a destination capable of receiving and processing incoming alert packages collected
during KPI monitoring.

Other Integrated Components

• TACACS+, LDAP, and RADIUS servers (see Set Up User Authentication in the Cisco Crosswork
Network Controller 6.0 Administration Guide for more information).

• DHCP server (when using Crosswork ZTP)

• External Kafka (for external data collection destinations)

• External gRPC (for external data collection destinations)

Security
Cisco takes great strides to ensure that all our products conform to the latest industry recommendations. We
firmly believe that security is an end-to-end commitment and are here to help secure your entire environment.
Please work with your Cisco account team to review the security profile of your network.

For details on how we validate our products, see Cisco Secure Products and Solutions and Cisco Security
Advisories.

If you have questions or concerns regarding the security of any Cisco products, please open a case with the
Cisco Customer Experience team and include details about the tool being used and any vulnerabilities it
reports.

Cisco Crosswork Network Controller 6.0 Installation Guide
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C H A P T E R 2
Plan Your Deployment

This chapter contains the following topics:

• Before You Begin, on page 5

Before You Begin
This section explains the decisions you need to make before installing Crosswork Network Controller solution
on your preferred platform.

1. Determine How Many VMs You Need, on page 5

2. Identify the Resource Footprint, on page 7

3. Special Considerations, on page 9

After completing the planning in the above steps, follow the relevant installation workflow steps for your
platform:

• For VMware vCenter: Install Cisco Crosswork Network Controller on VMware vCenter, on page 11

• For AWS EC2: Install Cisco Crosswork Network Controller on AWS EC2, on page 13

Starting with the Crosswork Network Controller version 4.1, Crosswork deployment is no longer supported
for the Cisco CSP platform. For more information, see End-of-Life Announcement for the Cisco Cloud
Services Platform Operating System.

Determine How Many VMs You Need
After you have finalized the Crosswork applications that meet the needs of your production environment, use
the below table to determine the number of VMs you will need to deploy the Crosswork cluster, and the type
of Crosswork Data Gateways you will deploy.

This is a crucial step as each Crosswork application can impact the overall resources needed.

Geo redundancy solution requires double the number of VMs. For more information, see Enable Geo
Redundancy, on page 231 section.

Note

Cisco Crosswork Network Controller 6.0 Installation Guide
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Crosswork Network Controller is available in the following packages:

Table 2: Crosswork Network Controller packages

Recommended number of
cluster VMs
3

Crosswork Data Gateway
Deployment
2

ContentsPackage
1

When only Cisco Crosswork
Optimization Engine is
installed:

• 3 Hybrid nodes

When Essentials package is
installedWITHOUTElement
Management Functions:

• 3 Hybrid nodes

When Essentials package is
installed WITH Element
Management Functions:

• 3 Hybrid nodes + 1
Worker node

On-Premise Standard
(default): Collectors only.

Cisco Crosswork
Optimization Engine

Cisco Crosswork
Network Controller
Essentials

On-Premise Standard
(default): Collectors only.

Cisco Crosswork
Active Topology

On-Premise Standard
(default): Collectors only.

ElementManagement
Functions

3 Hybrid nodes + 2 Worker
nodes

On-Premise Extended:
Collectors and offload
services.

Cisco Crosswork
Service Health

Cisco Crosswork
Network Controller
Advantage

3 Hybrid nodes + 2 Worker
nodes

On-Premise Extended:
Collectors and offload
services.

Cisco Crosswork
Change Automation

Add-on Package
4

On-Premise Extended:
Collectors and offload
services.

Cisco Crosswork
Health Insights

On-Premise Standard
(default): Collectors only.

CiscoCrosswork Zero
Touch Provisioning

1 There are licensing implications for different packages, please consult your Cisco Account team to
understand which packages and licenses are required for your use cases.

2 The VM resource requirements for Crosswork Data Gateway are different for each type and cannot be
modified. Therefore, if your requirements change, you must re-deploy the Crosswork Data Gateway to
move from one type to another. For more information, see the Redeploy a Crosswork Data Gateway
VM section in the Cisco Crosswork Network Controller 6.0 Administration Guide.

3 The number of VMsmentioned is the recommended count. You can add moreWorker nodes (maximum
up to 2 worker nodes) as needed. If your requirements exceed the recommended count, please contact
the Cisco Customer Experience team.

Cisco Crosswork Network Controller 6.0 Installation Guide
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4 Using the add-on package with any combination of the Crosswork applications requires the 5 node
cluster as indicated.

Ensure that you have sufficient worker nodes in your cluster. You can always check the load in your cluster
and choose to add new worker nodes post installation. For more information, see the Deploy New Cluster
Nodes section in the Crosswork Network Controller 6.0 Administration Guide.

Identify the Resource Footprint
Once you determine the Crosswork applications you want and the number of VMs you will need to deploy
to host them, ensure that you have the resources needed for them. The resources required per VM such as
CPU, Memory, and Storage vary based on the data center where your VMs will be hosted (VMware or AWS).

The tables in this topic explain the resource requirements per VM to deploy Crosswork Hybrid or Worker
nodes, Crosswork Data Gateways, NSO, and SR-PCE (refer to the table relevant to your platform).

• The resources listed for NSO are higher than for other NSO use cases due to the additional requirements
Crosswork Network Controller places on NSO.

• The NSO footprint depends on the type of deployment, standalone or LSA.

• The SR-PCE count will depend on the number of head-ends that need to be managed

• The values in Storage column is the space needed for storing Crosswork files and does not consider any
additional overhead that may be required (for example, RAID configuration).

• The storage required for each backup will vary based on the your cluster size, applications in the cluster,
and the scale requirements.

• Upgrade of the cluster temporarily requires double the total disk space used by the cluster.

• The number of data gateways needed depends on the number of devices you have in your network and
the level of redundancy you want (1:n up to 1:1). To determine the number of Crosswork Data Gateways
needed, contact the Cisco Customer Experience team.

Note

Crosswork Resource Footprint for VMware

• Ensure that you have a docker-capable host to load the Crosswork installer tool.Note

As Cisco Crosswork cluster nodes place high demands on the VMs, ensure that you have not oversubscribed
CPU or memory resources on the machines hosting the nodes.

Important

Cisco Crosswork Network Controller 6.0 Installation Guide
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Table 3: Crosswork Resource Footprint for VMware

Storage (Boot
disk + Data
disks)

Network
Interface
Controller
(NIC)

Memory
(RAM)

Clock Freq
(GHz)

vCPUComponent

1 TB10 Gbps96 GB>= 2.2012

Minimum
clock
reservation:
18 GHz

Crosswork Hybrid or Worker node

70 GB (50
GB + 20 GB)

10 Gbps48 GB>= 2.2012CrossworkDataGatewayOn-Premise
Standard

570 GB (50
GB + 520
GB)

10 Gbps112 GB>= 2.2020CrossworkDataGatewayOn-Premise
Extended

1 TB10 Gbps128 GB>= 2.2016Cisco NSO

70 GB10 Gbps24 GB>= 2.208Cisco SR-PCE

This is the requirement
for running a Cisco
XRv9K with SR-PCE
functionality enabled.

Note

At least 25
GB
(recommended)

----Basic SCP Server (for storing
backups)

Crosswork Resource Footprint for AWS EC2

In case of AWS EC2, the additional storage server may be in the AWS cloud or your local environment (must
be reachable from the AWS cloud).

Note

Table 4: Crosswork Resource Footprint for AWS EC2

Storage (Boot disk
+ Data Disks)

Network Interface
Controller (NIC)

Memory (RAM)vCPUComponent

1 TB10 Gbps96 GB12

Minimumclock
reservation: 18
GHz

Crosswork Hybrid or Worker
node

Cisco Crosswork Network Controller 6.0 Installation Guide
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Storage (Boot disk
+ Data Disks)

Network Interface
Controller (NIC)

Memory (RAM)vCPUComponent

70 GB (50 GB +
20GB)

10 Gbps64 GB12Crosswork Data Gateway
On-Premise Standard

570 GB (50 GB +
520 GB)

10 Gbps128 GB24Crosswork Data Gateway
On-Premise Extended

1 TB10 Gbps128 GB16Cisco NSO

70 GB10 Gbps24 GB8Cisco SR-PCE

This is the
requirement for
running a Cisco
XRv9K with
SR-PCE
functionality
enabled.

Note

At least 25 GB
(recommended)

---Basic SCP Server (for storing
backups)

Additional Resource Requirements:

• Storage requirements vary based on factors such as the number of devices being supported and the type
of deployment selected. However, 1 TB disk space should work for most deployments.

• Due to their performance, solid state drives (SSD) are preferred over traditional hard disk drives (HDD).

• If you are using HDD, the minimum speed should be over 15, 000 RPM.

• The VM data store(s) need to have disk access latency < 10 ms or > 5000 IOPS.

Special Considerations
In addition to the above instructions, there may be certain setup options that you need to consider before you
begin the installation.

• Are you going to use self-signed certificates? – if yes, you need to make the certificates available. For
more information on the type of certificates supported and how to manage them, see the Manage
Certificates section in the Crosswork Network Controller 6.0 Administration Guide.

• Do you plan to integrate Crosswork with external authentication servers?– Integrationwith TACACS+
or other external authentication servers will require you to have credentials created for the Crosswork
user accounts and roles.

• Do you want to use a URL of an optional Management network proxy server?– If your environment
requires an HTTP or HTTPS proxy to access the URLs on the public Internet, you must configure a
proxy server for Crosswork Data Gateway to connect to Cisco Crosswork.

Cisco Crosswork Network Controller 6.0 Installation Guide
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• In Crosswork Data Gateway, do you want to configure a Syslog server to collect the syslog?– if
yes, then provide the host name or IPv4 or IPv6 address of an external syslog server. Or, you have the
option to configure the syslog server using the interactive console after the installation is complete.

• In Crosswork Data Gateway, do you want to configure an Auditd server to collect the event logs?–
if yes, then provide the host name or IPv4 or IPv6 address of an external auditd server. As an alternative,
you have the option to configure the auditd server using the interactive console after the installation is
complete.

• Do you plan to enable the automatic execution of linked playbooks? – If yes, youmust enable Playbook
Job Scheduling and disable Credential Prompting for playbook execution in the Network Automation
settings window. For more information, see the Enable Automatic Playbook Execution topic in the
Crosswork Change Automation and Health Insights 6.0 User Guide.

Cisco Crosswork Network Controller 6.0 Installation Guide
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C H A P T E R 3
Choose Your Installation Workflow

This chapter contains the following topics:

• Overview, on page 11
• Install Cisco Crosswork Network Controller on VMware vCenter, on page 11
• Install Cisco Crosswork Network Controller on AWS EC2, on page 13

Overview
This chapter provides the installation workflows for each of the supported environments (VMware and AWS).

The workflows give a high level description of the tasks necessary to install the Crosswork Network Controller
and to integrate it with the required components of the solution. Integration with optional components is
addressed in the Crosswork Network Controller 6.0 Administration Guide.

These workflow steps should be used as your primary installation guidepost and roadmap for the end to end
installation of Crosswork Network Controller. After completing each detailed step, it is recommended that
you refer back to the workflow chart for the next step to perform.

The time taken for the entire installation can vary based on size of your deployment profile and the performance
characteristics of your hardware.

Note

Install Cisco Crosswork Network Controller on VMware vCenter
Before you begin:

• Ensure you have identified the Crosswork components you need and arranged for the resources required
to complete the installation. If not, please refer to the guidelines in Plan Your Deployment, on page 5.

• Please see the Crosswork Network Controller 6.0 Release Notes to know the NSO and SR-PCE versions
compatible with Crosswork Network Controller.

The following table describes the stages to install Crosswork Network Controller on VMware vCenter.

Cisco Crosswork Network Controller 6.0 Installation Guide
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Table 5: Crosswork Installation Workflow

ActionStep

Prepare for installation

Refer to the guidelines in Installation Prerequisites for VMware
vCenter, on page 19.

1. Ensure that your VMware environment
meets all the requirements.

Install the Crosswork cluster

Install using your preferred method:

• Using cluster installer tool: Install Cisco Crosswork on
VMware vCenter using the Cluster Installer Tool , on page
44

• Manual Installation: Manual Installation of Cisco
Crosswork using vCenter vSphere UI, on page 58

2. Install the Cisco Crosswork cluster on
VMware vCenter.

Refer to the guidelines in:

• Monitor Cluster Activation, on page 69

• Log into the Cisco Crosswork UI, on page 71

3. Verify if the installation was successful,
and log into the Cisco Crosswork UI.

Install the Crosswork Data Gateway

Choose the profile for the Cisco Crosswork Data Gateway VM
(Standard or Extended) and install as per your preferred method:

• Using vSphere: Install Cisco CrossworkData Gateway using
vCenter vSphere Client, on page 93

• Using OVF tool: Install Cisco Crosswork Data Gateway
via OVF Tool, on page 105

If you plan to install multiple Cisco Crosswork Data
Gateway VMs due to load or scale requirements,
or you wish to leverage Cisco Data Gateway High
Availability, you are recommended to install all the
Crosswork Data Gateway VMs first and then
proceed with adding them to a Data Gateway pool.

Note

4. Install one or more Crosswork Data
Gateway instances on VMware vCenter.

Follow the steps in Cisco Crosswork Data Gateway
Authentication and Enrollment, on page 112.

After verifying that the Crosswork Data Gateway VM has
enrolled successfully with Cisco Crosswork, set up the Crosswork
Data Gateway for collection by creating a Crosswork Data
Gateway pool. See the Create a Crosswork Data Gateway Pool
section in Cisco Crosswork Network Controller 6.0
Administration Guide.

5. Verify that the Crosswork Data Gateway
VM or multiple VMs have enrolled
successfully with Cisco Crosswork.

Cisco Crosswork Network Controller 6.0 Installation Guide
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ActionStep

Follow the steps in Crosswork Data Gateway Post-installation
Tasks, on page 112.

6. Complete the Crosswork Data Gateway
post-installation tasks.

Install the Cisco Crosswork Applications

Follow the instructions in Install Crosswork Applications, on
page 169.

7. Install the Crosswork Applications

Integrate NSO with Crosswork

If yes, proceed to step 9.

If no, please follow the install instructions in the NSO Installation
Guide.

8. Do you have Cisco NSO already
installed?

Follow the instructions in Add Cisco NSO Providers, on page
185.

9. Add NSO Provider and verify that it is
reachable

Follow the instructions in Install Cisco NSO Function Pack
Bundles from Crosswork UI, on page 176.

10. Install the latest NSO Function Packs

Integrate SR-PCE with Crosswork

If yes, please proceed to step 12.

If no, please choose the type of SR-PCE youwish to use (physical
or virtual device) and follow the appropriate instructions to get
the device (or virtual device) deployed. For more information,
see the Cisco IOS XRv 9000 Router Installation Guide.

For the rest of the document, we will refer to the
physical or virtual device(s) as the SR-PCE(s).

Note

11. Is your SR-PCE installed?

Follow the instructions in Configure SR-PCE, on page 189.12. Configure SR-PCE

Follow the instructions in Add Cisco SR-PCE Providers, on page
192.

13. Add SR-PCE Provider and verify that
it is reachable.

Follow the instructions in Manage Backups chapter in Cisco
Crosswork Network Controller 6.0 Administration Guide.

14. (Recommended) Create a backup of
your Crosswork Network Controller.

Install Cisco Crosswork Network Controller on AWS EC2
Before you begin:

• Ensure you have identified the Crosswork components you need and arranged for the resources required
to complete the installation. If not, please refer to the guidelines in Plan Your Deployment, on page 5.

• Please see the Crosswork Network Controller 6.0 Release Notes to know the NSO and SR-PCE versions
compatible with Crosswork Network Controller.
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Crosswork Network Controller supports Module deployment which allows you to pick and choose to install
the components of the Cisco Crosswork solution (hybrid and worker nodes needed for Crosswork cluster, one
or more Crosswork Data Gateway(s), and NSO) you wish to deploy.

The following table describes the stages to install Crosswork Network Controller on AWS EC2 using
CloudFormation (CF) templates.

Table 6: Crosswork Installation Workflow

ActionStep

Prepare for installation

Refer to the guidelines in Installation Prerequisites for AWS
EC2, on page 121.

1. Ensure that your AWSEC2 environment
meets all the requirements.

Follow the instructions in Extract CF Template Image, on page
135.

2. Extract the CF template package

Install Crosswork components

Install the Crosswork components individually:

• Install the Crosswork cluster: Install Cisco Crosswork
Cluster on Amazon EC2, on page 150

• Install one or more Crosswork Data Gateway(s): Install
Crosswork Data Gateway on Amazon EC2, on page 151

Crosswork Data Gateway is deployed with the default
parameter values if youmissed configuring the values during
deployment. For more information, see Auto-Configuration
for Deploying Crosswork Data Gateway, on page 153.

• Install Cisco NSO: Install Cisco NSO on Amazon EC2, on
page 156

3. Module deployment:Install the Cisco
Crosswork components using module
deployment.

Refer to the guidelines in Accessing the Crosswork UI, on page
159

4. Verify the installation and access
Crosswork UI

Install the Crosswork Applications

Follow the instructions in Install Crosswork Applications, on
page 169.

5. Install the Crosswork Applications

Integrate NSO with Crosswork

Follow the instructions in Install Cisco NSO Function Pack
Bundles from Crosswork UI, on page 176.

6. Install the NSO Function Packs

Follow the instructions in Add Cisco NSO Providers, on page
185.

7. Add NSO Provider and verify that is
reachable.

Integrate SR-PCE with Crosswork
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ActionStep

If yes, please proceed to step 9.

If no, please select the SR-PCE type (for AWS) and follow the
relevant install instructions in the Cisco IOS XRv 9000 Router
Installation Guide.

8. Is your SR-PCE installed?

Follow the instructions in Configure SR-PCE, on page 189.9. Configure SR-PCE

Follow the instructions in Add Cisco SR-PCE Providers, on page
192.

10. Add SR-PCE Provider and verify that
SR-PCE is reachable.

Follow the instructions in Manage Backups chapter in the Cisco
Crosswork Network Controller 6.0 Administration Guide.

11. (Recommended) Create a backup of
your Crosswork Network Controller.

Cisco Crosswork Network Controller 6.0 Installation Guide
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P A R T II
Install Cisco Crosswork Network Controller on
VMware vCenter

• Installation Prerequisites for VMware vCenter, on page 19
• Install Crosswork Cluster on VMware vCenter, on page 39
• Install Cisco Crosswork Data Gateway on VMware vCenter, on page 79





C H A P T E R 4
Installation Prerequisites for VMware vCenter

This chapter contains the following topics:

• Overview, on page 19
• Supported Network Topology Models, on page 19
• VMware Settings, on page 25
• Host VM Requirements, on page 26
• Crosswork TCP/UDP Port requirements, on page 31
• IP Address Restrictions, on page 36

Overview
This chapter explains the general (such as VM requirements, port requirements, application requirements,
etc.) and platform-specific prerequisites to install each Crosswork component.

The data center resources needed to operate other integrated components or applications (such as WAE,
DHCP, and TFTP servers) are not addressed in this document. Refer to the respective installation documentation
of those components for more details.

Supported Network Topology Models
This section introduces the different topology models supported when deploying Cisco Crosswork and the
other solution components on a data center using VMware.

Routed and Device Networks

The following table describes the types of traffic that comes from the Crosswork Network Controller. This
traffic can use a single NIC (typically in lab installs) or dual NICs.

Table 7: Types of Crosswork Network Traffic

DescriptionTraffic

For accessing the UI and Crosswork Network Controller command line, and passing
information between servers (for example, Cisco Crosswork to Crosswork Data
Gateway or NSO).

Management
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DescriptionTraffic

Data and configuration transfer betweenCisco Crosswork and CrossworkData Gateway
and other data destinations (external Kafka/gRPC).

Data

The device access that the servers (Crosswork, NSO, Crosswork Data Gateway, or
others) use to communicate with the managed devices in the network.

Device Access

Connectivity between the various components should be accomplished via an external routing entity. The
Network Topology figures in this section show various line styles suggesting possible routing domains within
the routed network.

• Solid - Management routing domain.

• Dotted - Data/Control routing domain (information transferred between Cisco Crosswork and Cisco
Crosswork Data Gateway, and other data destinations (external Kafka or gRPC)).

• Dashes - Device access routing domain (from Cisco Crosswork Data Gateway and NSO).

• Blue dotted/dashed line - Alternate SR-PCE configuration path

The IP/subnet addressing scheme on each of these domains depends on the type of deployment.

Routing between domains is needed for Crosswork and NSO to reach the devices. However, proper firewall
rules need to be in place to allow only select sources (for example, Crosswork and NSO) to reach the devices.

• It is vital to have secure firewalls between Crosswork Network Controller and the network devices.
However, the firewalls are not provided by Crosswork Network Controller and must be set up separately
by the user. This topic highlights what application flows need to be allowed through the user-provided
firewall system.

• On the device network, devices can be reached in-band or using out-of-band management interfaces,
depending on the local security policies of each deployment.

Important

The three supported configurations are:

• 1 NIC Network Topology: The Crosswork cluster, Crosswork Data Gateway, NSO, and SR-PCE use
one network interface to communicate between each other and a routed interface to communicate with
the network devices.

• 2 NIC Network Topology: The Crosswork cluster, Crosswork Data Gateway, NSO, and SR-PCE use
one network interface to communicate between their management interfaces, a second interface to pass
the data between Crosswork Network Controller and Crosswork Data Gateway, and a routed interface
to communicate with the network devices.

• 3 NIC Network Topology: The Crosswork cluster, Crosswork Data Gateway, NSO, and SR-PCE use
one network interface to communicate between their management interfaces, a second interface to pass
the data between Crosswork Network Controller and Crosswork Data Gateway, and a third interface for
Crosswork Data Gateway to communicate with the network devices. NSO may use either the third
interface or a routed interface to communicate with the network devices.
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Figure 1: Cisco Crosswork - 1 NIC Network Topology
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Figure 2: Cisco Crosswork - 2 NIC Network Topology
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Figure 3: Cisco Crosswork - 3 NIC Network Topology

Cisco Crosswork Virtual Machine (VM)

The Cisco Crosswork VM has the following vNIC deployment options:

Table 8: Cisco Crosswork vNIC deployment modes

DescriptionvNICNo. of vNICs

Management, Data, and Device access passing through a single
NIC

(For lab use only)

Management1
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DescriptionvNICNo. of vNICs

ManagementManagement2

Data and Device accessData

Cisco Crosswork Data Gateway VM

The Cisco Crosswork Data Gateway VM has the following vNIC deployment options:

If you use one interface on your Crosswork cluster, you must use only one interface on the Crosswork Data
Gateway. If you use two interfaces on your Crosswork Cluster, then you can use two or three interfaces on
the Crosswork Data Gateway as per your network requirements.

Note

Preference for the number of vNICs can vary from one deployment to another. The number of vNICs can
depend on the security and traffic isolation needs of the deployment.

Table 9: Cisco Crosswork Data Gateway default vNIC deployment modes

RolesvNICNo. of vNICs

Default Gateway, Administration, External Logging,
Management, Control, Northbound External Data, and
Southbound Data traffic passing through a single NIC.

vNIC01

Default Gateway, Administration, External Logging, and
Management traffic.

vNIC02

Control, Northbound External Data, and SouthboundData traffic.vNIC1

Default Gateway, Administration, External Logging, and
Management traffic.

vNIC03

Control and Northbound External Data traffic.vNIC1

Southbound Data trafficvNIC2

SR-PCE Configuration

The Segment Routing Path Computation Element (SR-PCE) is both a device and a Software-Defined
Networking (SDN) controller. Some deployments may want to treat an SR-PCE instance as a device, in which
case they would need access via the device network. Some deployments may want to treat an SR-PCE instance
as an SDN controller and access it on the Management routing domain. Crosswork supports both models. By
default, Crosswork will use eth0 (Management) to access SR-PCE as an SDN controller on theManagement
domain (shown in the figures). For more information on enabling Crosswork access to an SR-PCE instance
as a device on the device network (shown as alternate path in the figures), please refer to Add Cisco SR-PCE
Providers, on page 192.
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ZTP Requirements

If you plan to use Zero Touch Provisioning, the device network needs to be equipped with a DHCP server
(not provided as part of Cisco Crosswork). Some forms of ZTP also require a TFTP server (not provided as
part of Cisco Crosswork). Additionally, all devices that use ZTP must have network connectivity to the
Crosswork cluster as they will pull files (software and/or configuration) directly from the Crosswork cluster.
For more information on Zero Touch Provisioning concepts and features, please refer to the Zero Touch
Provisioning chapter in the Cisco Crosswork Network Controller 6.0 Administration Guide.

Cisco Network Services Orchestrator (NSO) VM

The NSO VM has the following vNICs:

• Management: Used for Crosswork applications to reach NSO.

• Device Access: Used for NSO to reach devices or NSO Resource Facing Services (RFS).

VMware Settings
The following requirements are mandatory if you are planning to install Cisco Crosswork using the cluster
installer. If your vCenter data center does not meet these requirements, the VMs have to be deployed
individually. For more information on manual installation, see Manual Installation of Cisco Crosswork using
vCenter vSphere UI, on page 58.

• Hypervisor and vCenter supported:

• VMware vCenter Server 7.0 and ESXi 7.0.

• VMware vCenter Server 6.7 (Update 3g or later) and ESXi 6.7 (Update 1).

• If you plan to use the Crosswork installer tool, the machine where you run the installer must have network
connectivity to the vCenter data center where you plan to install the cluster. If this mandatory requirement
cannot be met, you must manually install the cluster. For more information on manual installation, see
Manual Installation of Cisco Crosswork using vCenter vSphere UI, on page 58.

• Cisco Crosswork cluster VMs (Hybrid nodes andWorker nodes) must be hosted on hardware with Hyper
Threading disabled.

• As Cisco Crosswork cluster nodes place high demands on the VMs, ensure that you have not
oversubscribed CPU or memory resources on the machines hosting the nodes.

• All the physical host machines must be organized within the same VMware Data Center, and while it is
possible to deploy all the cluster nodes on a single physical host (provided it meets the requirements), it
is recommended that the nodes be distributed across multiple physical hosts. This prevents the host from
being a single point of failure and improves solution resilience.

• Ensure that profile-driven storage is enabled by the vCenter admin user. Query permissions for the
vCenter user at the root level (for all resources) of the vCenter.

• The networks required for the CrossworkManagement and Data networks need to be built and configured
in the data centers, and must allow low latency L2 communication (latency with RTT <= 10 ms).
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The same network names must be used and configured on all the ESXi host
machines hosting the Crosswork VMs.

Note

• To allow use of VRRP (Virtual Router Redundancy Protocol) , the DVS Port group needs to be set as
follows:

ValueProperty

RejectPromiscuous mode

RejectMAC address changes

• The VRRP protocol requires unique router_id advertisements to be present on the network segment. The
IDs can vary based on the deployment. For example, Crosswork usually uses the ID 169 on the
management and ID 170 on the data network segments when multicast is used in discovery. In case of
a symptom of conflict such as the VIP address not being reachable, check if any of the router IDs is
duplicated and remove the conflicting VRRP router machines or use a different network.

• Ensure the user account you use for accessing vCenter has the following privileges:

• VM (Provisioning): Clone VM on the VM you are cloning.

• VM (Provisioning): Customize on the VM or VM folder if you are customizing the guest operating
system.

• VM (Inventory): Create from the existing VM on the data center or VM folder.

• VM (Configuration): Add new disk on the data center or VM folder.

• Resource: Assign VM to resource pool on the destination host, cluster, or resource pool.

• Datastore: Allocate space on the destination datastore or datastore folder.

• Network: Assign network to which the VM will be assigned.

• Profile-driven storage (Query): This permission setting needs to be allowed at the root of the data
center tree level.

• We also recommend you to enable vCenter storage control.

Host VM Requirements
This section explains the resource requirements per VM to deploy the Crosswork Cluster and Crosswork Data
Gateway.

• Crosswork Cluster VM Requirements, on page 27

• Crosswork Data Gateway VM Requirements, on page 28
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Crosswork Cluster VM Requirements
The Crosswork cluster consists of three VMs or nodes operating in a hybrid configuration. This is the minimum
configuration necessary to support the applications in a standard network. Additional VMs or nodes (maximum
up to 2 worker nodes) in a worker configuration can be added later to scale your deployment, as needed, to
match the requirements of your network, or as other applications are introduced (see Table 2: Crosswork
Network Controller packages, on page 6 for more information on VM count for each Crosswork Network
Controller package). Please consult with the Cisco Customer Experience team for guidance on your deployment
to best meet your needs.

The table below explains the network requirements per VM host:

Table 10: Network Requirements (per VM)

DescriptionRequirement

For production deployments, we recommend that you use dual interfaces, one
for the Management network and one for the Data network.

For optimal performance, the Management and Data networks should use links
configured at a minimum of 10 Gbps with a latency of less than 10 milliseconds.

Network Connections

When using dual NICs (one for the Management network and one for the Data
network): A management and data IP address (IPv4 or IPv6) for each node being
deployed (Hybrid or Worker) and two additional IP addresses to be used as the
Virtual IP (VIP) address (one for the Management network and one for the Data
network).

When using single NIC: One IP address (IPv4 or IPv6) for each node being
deployed (Hybrid or Worker) and one additional IP address to be used as the
Virtual IP (VIP) address.

For example, in the case of a cluster with 3 hybrid VMs and 1 worker VM with
a single NIC, you need 5 IP addresses, and in the case of the same configuration
with dual NIC, you need 10 IP addresses (5 for management network and 5 for
data network).

Note • The IP addresses must be able to reach the gateway address
for the network where Cisco Crosswork Data Gateway will be
installed, or the installation will fail.

• When deploying a IPv6 cluster, the installer needs to run on
an IPv6 enabled container/VM.

• At this time, your IP allocation is permanent and cannot be
changed without re-deployment. For more information, contact
the Cisco Customer Experience team.

IP Addresses

The IPv4 or IPv6 addresses or host names of the NTP server you plan to use. If
you want to enter multiple NTP servers, separate themwith spaces. These should
be the same NTP servers you use to synchronize the Crosswork application VM
clock, devices, clients, and servers across your network.

Ensure that the NTP servers are reachable on the network before attempting
installation. The installation will fail if the servers cannot be reached.

NTP Server
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DescriptionRequirement

The IPv4 or IPv6 addresses of the DNS servers you plan to use. These should be
the same DNS servers you use to resolve host names across your network.

Ensure that the DNS servers are reachable on the network before attempting
installation. The installation will fail if the servers cannot be reached.

DNS Servers

The search domain you want to use with the DNS servers, for example, cisco.com.
You can have only one search domain.

DNS Search Domain

Cisco Crosswork will back up the configuration of the system to an external
server using SCP. The SCP server storage requirements will vary slightly but
you must have at least 25 GB of storage.

Backup Server

The installation process supports using either a VIP (Virtual IP address) or a
FQDN (Fully Qualified Domain Name) to access the cluster.

If you choose to use the FQDN, you will need one for the Management and one
for the Data network. In case of lab installation using single NIC, the FQDN is
only required for the Management network.

Secure ZTP and Secure Syslog require the Crosswork cluster to be
deployed with FQDN.

Note

FQDN (Optional)

Cisco Crosswork Infrastructure and applications are built to run as a distributed collection of containers
managed by Kubernetes.

Crosswork Data Gateway VM Requirements
This section provides information about the general guidelines and minimum requirements for installing
Crosswork Data Gateway.

• Selecting the Crosswork Data Gateway Deployment Type, on page 28

• Crosswork Data Gateway VM Requirements, on page 29

Selecting the Crosswork Data Gateway Deployment Type

The following table lists the deployment profile that must be used for installing Crosswork Data Gateway in
each Crosswork product:

The VM resource requirements for Crosswork Data Gateway are different for each type and cannot bemodified.
Therefore, if your requirements change, you must re-deploy the Crosswork Data Gateway to move from one
type to another. For more information, see the Redeploy a Crosswork Data Gateway VM section in Cisco
Crosswork Network Controller 6.0 Administration Guide.

Note
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Table 11: Crosswork Data Gateway deployment types

Crosswork Data Gateway DeploymentCisco Crosswork Product

On-Premise StandardCrosswork Network Controller (combination of
Crosswork Active Topology & Crosswork
Optimization Engine)

On-Premise StandardCrosswork Optimization Engine

On-Premise StandardCrosswork Zero Touch Provisioning

On-Premise ExtendedCrosswork Change Automation

On-Premise ExtendedCrosswork Health Insights

On-Premise ExtendedCrosswork Service Health

Crosswork Data Gateway VM Requirements

The VM requirements for Crosswork Data Gateway are listed in the following table.

Table 12: Crosswork Data Gateway Requirements for on-premise applications

DescriptionRequirement

VMware. See Installation Prerequisites for VMware vCenter, on page 19.Data Center
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DescriptionRequirement

Minimum: 1

Maximum: 3

Cisco Crosswork Data Gateway can be deployed with either 1, 2, and 3 interfaces as
per the combinations below:

If you use one interface on your Crosswork cluster, you must use only
one interface on the Crosswork Data Gateway. If you use two interfaces
on your Crosswork Cluster, then you can use two, or three interfaces on
the Crosswork Data Gateway as per your network requirements.

Note

Interfaces

vNIC2vNIC1vNIC0No. of
NICs

——• Management Traffic

• Control/Data Traffic

• Device Access Traffic

1

—• Control/Data
Traffic

• Device Access
Traffic

Management Traffic2

Device Access
Traffic

Control/Data TrafficManagement Traffic3

• Management traffic: for accessing the Interactive Console and passing the
Control/Data information between servers (for example, a Crosswork application
to Crosswork Data Gateway).

• Control/Data traffic: for data and configuration transfer between Cisco Crosswork
Data Gateway and Crosswork applications and other external data destinations.

• Device access traffic: for device access and data collection.

Due to security policies, traffic from subnets of a vNIC received on other
vNICs is dropped. For example, in a 3 vNIC model setup, all device
traffic (incoming and outgoing) must be routed through default vNIC2.
Crosswork Data Gateway drops device traffic received over vNIC0 and
vNIC1.

Note
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DescriptionRequirement

1 or 2 IPv4 or IPv6 addresses based on the number of interfaces you choose to use.

An additional IP address to be used as the Virtual IP (VIP) address. For each active
data gateway, a unique VIP is required.

For more information, refer to the Interfaces section in the Table 25: Cisco Crosswork
Data Gateway Deployment Parameters and Scenarios, on page 81.

Crosswork does not support dual stack configurations. Therefore, all
addresses for the environment must be either IPv4 or IPv6.

In a 3-NIC deployment, you need to provide an IP address for
Management interface (vNIC0) and Control/Data interface (vNIC1)
during installation. A virtual IP address for Device Access Traffic (vNIC2)
is assigned when you create a Crosswork Data Gateway to a pool as
explained in theCreate a Crosswork Data Gateway Pool section inCisco
Crosswork Network Controller 6.0 Administration Guide.

Note

IP Addresses

The IPv4 or IPv6 addresses or host names of the NTP servers you plan to use. If you
want to enter multiple NTP servers, separate them with spaces. These should be the
same NTP servers you use to synchronize devices, clients, and servers across your
network. Verify that the NTP IP address or host name is reachable on the network else
the installation fails.

Also, the ESXi hosts that run the Crosswork application and Cisco Crosswork Data
Gateway VM must have NTP configured, or the initial handshake may fail with
"certificate not valid" errors.

NTP Servers

The IPv4 or IPv6 addresses of the DNS servers you plan to use. These should be the
same DNS servers you use to resolve host names across your network. Confirm that
the DNS servers are reachable on the network before attempting installation. The
installation fails if the servers cannot be reached.

DNS Servers

The search domain you want to use with the DNS servers, for example, cisco.com.
You can have only one search domain.

DNS Search
Domain

Crosswork does not support dual stack configurations. Therefore, all FQDN addresses
configured for the deployment environment must be either IPv4 or IPv6.

The FQDN addresses are configured for Amazon EC2 deployments.

FQDN

The Crosswork uses ICMP in the communications with Crosswork Data Gateway.
Ensure that the firewall between Crosswork and the Crosswork Data Gateway passes
this traffic.

Internet Control
Message Protocol
(ICMP)

Crosswork TCP/UDP Port requirements
As a general policy, ports that are not needed should be disabled. To view a list of all the open listening ports
once all the applications are installed and active, log in as a Linux CLI admin user on any Crosswork cluster
VM, and run the netstat -aln command.
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All IP addresses (including Virtual IP addresses) between Crosswork Cluster, Crosswork applications, and
Crosswork Data Gateway need to be reachable (to be pinged to/from) between each other.

Note

Crosswork Cluster Port Requirements

The following TCP/UDP port numbers need to be allowed through any external firewall or access-list rules
deployed by the data center administrator. Depending on the NIC deployment, these ports may be applicable
to only one or both NICs.

Crosswork cluster ports allow bidirectional flow of information.Note

Table 13: External Ports used by Crosswork Cluster

Location (in 2 NIC deployment)Used forProtocolPort

Management Network / vNIC0Remote SSH trafficTCP22

Management Network / vNIC0GlusterFS (port mapper)TCP/UDP111

Management Network / vNIC0Calico BGP (Kubernetes)TCP179

Management Network / vNIC0Accessing the EC2 APITCP80, 443

Management Network / vNIC0IPSecUDP500

Management Network / vNIC0Kubernetes etcdTCP2379/2380

Management Network / vNIC0IPSecUDP4500

Management Network / vNIC0kube-apiserver (Kubernetes)TCP6443

Management Network / vNIC0Kubernetes metamonitoringTCP9100

Management Network / vNIC0kubelet (Kubernetes)TCP10250

Management Network / vNIC0GlusterFSTCP24007

Management Network / vNIC0User interface (NGINX server listens for secure
connections on port 443)

TCP30603

Management Network / vNIC0Docker RegistryTCP30606

Management Network / vNIC0For FTP (available on data interface only). The
additional ports used for file transfer are 31121
(TCP), 31122 (TCP), and 31123 (TCP).

This port is available only when the supported
application is installed on Cisco Crosswork and
the FTP settings are enabled.

TCP30621
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Location (in 2 NIC deployment)Used forProtocolPort

Management Network / vNIC0For SFTP (available on data interface only)

This port is available only when the supported
application is installed on Cisco Crosswork and
the SFTP settings are enabled.

TCP30622

Management Network / vNIC0GlusterFSTCP49152:49370

Table 14: Ports used by other Crosswork components

Location (in 2 NIC deployment)Used forProtocolPort

Management Network / vNIC0To monitor the installation (Crosswork Network
Controller)

TCP30602

Management Network / vNIC0Crosswork Network Controller Web User interface
(NGINX server listens for secure connections on port
443)

TCP30603

Management Network / vNIC0Used for Classic Zero Touch Provisioning (Classic
ZTP) on the NGINX server

TCP30604

Data Network / vNIC1Crosswork Data Gateway vitals collectionTCP30607

Data Network / vNIC1DataGateway gRPC channel withDataGatewayVMsTCP30608

Management Network / vNIC0Used by the Expression Orchestrator (Crosswork
Service Health)

TCP30609

Management Network / vNIC0Used by the Metric Scheduler (Crosswork Service
Health)

TCP30610

Management Network / vNIC0Used by the Expression Tracker component
(Crosswork Service Health)

TCP30611

Management Network / vNIC0Used for Secure Zero Touch Provisioning (Secure
ZTP) on the ZTP server

TCP30617

Management Network / vNIC0Used to receive plug-and-play HTTP traffic on the
ZTP server

TCP30620

Data Network / vNIC1To set up and monitor Crosswork Data Gateway
collection status

TCP30649

Data Network / vNIC1The astack gRPC channel with astack-client running
on Data Gateway VMs

TCP30650

Data Network / vNIC1Crosswork Data Gateway sending the collected data
to Crosswork Kafka destination

TCP30993,
30994,
30995
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Table 15: Destination Ports used by Crosswork Cluster

Location (in 2 NIC deployment)Used forProtocolPort

Management Network / vNIC0Discover endpoints using ICMPTCP/UDP7

Management Network / vNIC0Initiate SSH connections with managed devicesTCP22

Management Network / vNIC0Connect to DNSTCP/UDP53

Management Network / vNIC0Network Time Protocol (NTP)UDP123

Management Network / vNIC0Initiate NETCONFTCP830

Management Network / vNIC0Used for communication between Crosswork and
Cisco NSO (for NETCONF)

TCP2022

Management Network / vNIC0REST API to SR-PCETCP8080

Management Network / vNIC0Used for communication between Crosswork and
Cisco NSO (for HTTPS)

TCP8888

Management Network / vNIC0Used by the DLM Function Pack for communication
between DLM and Cisco NSO

TCP20243

Management Network / vNIC0Used to internally manage the DLM Function Pack
listener during a Reload Packages scenario on Cisco
NSO

TCP20244

Crosswork Data Gateway Port Requirements

The following tables show the minimum set of ports required for Crosswork Data Gateway to operate correctly.

Inbound: Crosswork Data Gateway listens on the specified ports.

Outbound: Crosswork Data Gateway connects to external destination IP on the specified ports.

Table 16: Ports to be Opened for Management Traffic

DirectionUsed forProtocolPort

InboundSSH serverTCP22

OutboundSCP clientTCP22

OutboundNTP ClientUDP123

OutboundDNS ClientUDP53

OutboundCrosswork ControllerTCP30607

SCP port can be tuned.Note
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Table 17: Ports to be Opened for Device Access Traffic

DirectionUsed forProtocolPort

OutboundSNMP CollectorUDP161

InboundSNMP Trap Collector

This is the default value.
You can change this value
after installation from the
Cisco Crosswork UI. See
Configure Crosswork
Data Gateway Global
Parameters for more
information.

UDP1062

InboundMDT CollectorTCP9010

OutboundCLI CollectorTCP22

InboundSyslog Collector

This is the default value.
You can change this value
after installation from the
Cisco Crosswork UI. See
Configure Crosswork
Data Gateway Global
Parameters for more
information.

TLS6514

TCP9898

UDP9514

OutboundgNMI CollectorTCPSite Specific

Check the
platform-specific
documentation.

Table 18: Ports to be Opened for Control/Data Traffic

DirectionUsed forProtocolPort

OutboundCrosswork ControllerTCP30649

OutboundCrosswork KafkaTCP30993

30994

30995

OutboundKafka and gRPC
Destination

Site SpecificSite Specific
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IP Address Restrictions
Crosswork cluster uses the following IP ranges for internal communications. This cannot be changed. As a
result, these subnets cannot be used for devices or other purposes within your network.

You are recommended to isolate your Crosswork cluster to ensure all the communications stay within the
cluster. Please also ensure that address spaces do not overlap for any of the external integration points (e.g.
connections to devices, connections to external servers that Crosswork is sending data to, connections to the
NSO server, etc.).

This is applicable for cluster installation and for adding a static route.Note

The default values for the K8sServiceNetwork (10.96.0.0) and K8sPodNetwork (10.244.0.0) parameters can
be changed.

Note

Table 19: Protected IP Subnets

RemarksSubnetIP Type
5

Docker Subnet (Infrastructure)172.17.0.0/16IPv4

Link local address block169.254.0.0/16

Loopback address127.0.0.0/8

Reserved, previously used for relay servers to do IPv6 over IPv4192.88.99.0/24

Reserved for future use (previously class E block)240.0.0.0/4

MCAST-TEST-NET224.0.0.0/4

Current network, valid as source address only0.0.0.0/8
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RemarksSubnetIP Type
5

Docker Subnet (Infrastructure)2001:db8:1::/64IPv6

Pod Subnet (Infrastructure)fdfb:85ef:26ff::/48

Service Subnet (Infrastructure)fd08:2eef:c2ee::/110

Loopback address::1/128

Link localfe80::/10

IPv6 Multicastff00::/8

Reserved, previously used for relay servers to do IPv6 over IPv42002::/16

Terredo tunnel and relay2001:0000::/32

Used by ORCHID and not IPv6 routable2001:20::/28

Discard prefix, used in specific use-cases not applicable to
Crosswork Zero Touch Provisioning

100::/64

Unspecified address, cannot be assigned to hosts::/128

IPv4 mapped addresses::ffff:0:0/96

IPv4 translated addresses::ffff:0:0:0/96

5 Dual stack configuration is not supported in Crosswork Platform Infrastructure. Therefore, all addresses
for the environment must be either IPv4 or IPv6.
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C H A P T E R 5
Install Crosswork Cluster on VMware vCenter

This chapter contains the following topics:

• Installation Overview, on page 39
• Installation Parameters, on page 39
• Install Cisco Crosswork on VMware vCenter using the Cluster Installer Tool , on page 44
• Manual Installation of Cisco Crosswork using vCenter vSphere UI, on page 58
• Monitor Cluster Activation, on page 69
• Log into the Cisco Crosswork UI, on page 71
• Troubleshoot the Cluster, on page 73

Installation Overview
Crosswork Network Controller Crosswork Cluster can be installed using the following methods:

• Cluster Installer Tool: The cluster installer tool is a day-0 installation tool used to deploy the Crosswork
cluster with user specified parameters supplied via a template file. The tool is run from a Docker container
which can be hosted on any Docker capable platform including a regular PC/laptop. The Docker container
contains a set of template files which can be edited to provide the deployment specific data.

• Manual Installation (via the VMware UI): This option is available for deployments that cannot use
the installer tool.

The installer tool method is the preferred option as it is faster and easier to use.

Secure ZTP and Secure Syslog require the Crosswork cluster to be deployed with FQDN.Note

Installation Parameters
This section explains the important parameters that must be specified while installing the Crosswork cluster.
Kindly ensure that you have relevant information to provide for each of the parameters mentioned in the table
and that your environment meets all the requirements specified under Installation Prerequisites for VMware
vCenter, on page 19.

Cisco Crosswork Network Controller 6.0 Installation Guide
39



Crosswork Network Controller supports only "Large" deployment profile for customer deployments.Note

Please use the latest template file that comes with the Crosswork installer tool.Attention

Table 20: General parameters

DescriptionParameter Name

Name of the cluster fileClusterName

The IP stack protocol: IPv4 or IPv6ClusterIPStack

The Management IP address of the VM (IPv4 or IPv6).ManagementIPAddress

The Management IP subnet in dotted decimal format (IPv4 or IPv6).ManagementIPNetmask

The Gateway IP on the Management Network (IPv4 or IPv6). The address
must be reachable, otherwise the installation will fail.

ManagementIPGateway

The Management Virtual IP for the cluster.ManagementVIP

Name of the Management Virtual IP for the cluster. This is an optional
parameter used to reach Crosswork cluster Management VIP via DNS name.
If this parameter is used, the corresponding DNS record must exist in the
DNS server.

ManagementVIPName

The Data IP address of the VM (IPv4 or IPv6).DataIPAddress

The Data IP subnet in dotted decimal format (IPv4 or IPv6).DataIPNetmask

The Gateway IP on the Data Network (IPv4 or IPv6). The address must be
reachable, otherwise the installation will fail.

DataIPGateway

The Data Virtual IP for the cluster.DataVIP

Name of the Data Virtual IP for the cluster. This is an optional parameter
used to reach Crosswork cluster Data VIP via DNS name. If this parameter
is used, the corresponding DNS record must exist in the DNS server.

DataVIPName

The IP address of the DNS server (IPv4 or IPv6). The address must be
reachable, otherwise the installation will fail.

DNS

NTP server address or name. The address must be reachable, otherwise the
installation will fail.

NTP

The domain name used for the cluster.DomainName

Username to log into Cisco Crosswork.CWusername
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DescriptionParameter Name

Password to log into Cisco Crosswork.

Use a strong VM Password (8 characters long, including upper & lower case
letters, numbers, and at least one special character). Avoid using passwords
similar to dictionary words (for example, "Pa55w0rd!") or relatable words
(for example, C!sco123 or Cwork321!). While they satisfy the criteria, such
passwords are weak and will be rejected resulting in failure to setup the VM.

CWPassword

VM size for the cluster. Value is Large.VMSize

Name of the VM

A unique VM name is required for each node on the cluster (Hybrid or
Worker).

VMName

Indicates the type of VM. Choose either "Hybrid" or "Worker".

The Crosswork cluster requires at least three VMs operating in
a hybrid configuration.

Note

NodeType

Choose "True" if this is the first VM being built in a new cluster.

Choose "False" for all other VMs, or when rebuilding a failed VM.

This parameter is optional for installing using the cluster installer tool.

IsSeed

Total number of nodes in the cluster including Hybrid and Worker nodes.
The default value is 3. Set this to match the number of VMs (nodes) you are
going to deploy. For more information on VM count, see Table 2: Crosswork
Network Controller packages, on page 6.

This parameter is optional for installing using the cluster installer tool.

InitNodeCount

Total number of Hybrid nodes in the cluster. The default value is 3.

This parameter is optional for installing using the cluster installer tool.

InitLeaderCount

Minimum percentage of the data disk space to be used for the size of the
backup partition. The default value is 50 (valid range is from 1 to 80).

Please use the default value unless recommended otherwise.

The final backup partition size will be calculated dynamically.
This parameter defines the minimum.

Note

BackupMinPercent

Refers to the data disk size for Hybrid nodes (in Giga Bytes). This is an
optional parameter and the default value is 450 (valid range is from 450 to
8000), if not explicitly specified.

Please use the default value unless recommended otherwise.

ManagerDataFsSize

Refers to the data disk size for Worker nodes (in Gigabytes). This is an
optional parameter and the default value is 450 (valid range is from 450 to
8000), if not explicitly specified.

Please use the default value unless recommended otherwise.

WorkerDataFsSize
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DescriptionParameter Name

Set to "false" for production deployments.ThinProvisioned

Determines the enforcement of VM CPU and Memory profile reservations
(see Installation Prerequisites for VMware vCenter, on page 19 for more
information). This is an optional parameter and the default value is true, if
not explicitly specified.

If set as true, the VM's resources are provided exclusively. In this state, the
installation will fail if there are insufficient CPU cores, memory or CPU
cycles.

If set as false (only set for lab installations), the VM's resources are provided
on best efforts. In this state, insufficient CPU cores can impact performance
or cause installation failure.

EnableHardReservations

Size of the Ram disk.

This parameter is only used for lab installations (value must be at least 2).
When a non-zero value is provided for RamDiskSize, the HSDatastore value
is not used.

RamDiskSize

This optional parameter is used (uncommented) to import inventory post
manual deployment of Crosswork cluster.

The parameter refers to the state for this VM. To indicate a running status,
the value must be 2 (#OP_Status = 2). For more information, see the Import
Cluster Inventory topic in the Cisco Crosswork Network Controller 6.0
Administration Guide.

OP_Status

The configurationManifest schema version. This indicates the version of the
installer to use with this template.

Schema version should map to the version packaged with the sample template
in the cluster installer tool on cisco.com. You should always build a new
template from the default template provided with the release you are
deploying, as template requirements may change from one release to the next.

SchemaVersion

Log partition size (in Giga Bytes). Minimum value is 10 GB and Maximum
value is 1000 GB. You are recommended to use the default value.

LogFsSize

Enter the timezone. Input is a standard IANA time zone (for example,
"America/Chicago").

If left blank, the default value (UTC) is selected.

This is an optional parameter.

The timestamp in Kafka logmessages represents the NSO server
time. If you change the Timezone parameter in Crosswork
without updating the NSO server time, there will be a mismatch
between the Crosswork server time and the NSO event time.

Note

Timezone
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DescriptionParameter Name

Any pods marked as skip auto install will not be brought up until a dependent
application/pod explicitly asks for it.

If left blank, the default value ("False") is selected.

EnableSkipAutoInstallFeature

Enforces minimum resource reservations for the pod.

If left blank, the default value ("True") is selected.

EnforcePodReservations

The network address for the kubernetes service network. By default, the CIDR
range is fixed to '/16'.

K8sServiceNetwork

The network address for the kubernetes pod network. By default, the CIDR
range is fixed to '/16'.

K8sPodNetwork

Table 21: VMware template parameters

DescriptionParameter Name

The vCenter IP or host name.vCentreAddress

The username needed to log into vCenter.vCentreUser

The password needed to log into vCenter.vCentrePassword

The name of the Data Center resource to use.

Example: DCname = "WW-DCN-Solutions"

DCname

The name of the vCenter network to attach to the VM'sManagement interface.

This network must already exist in VMware or the installation will fail.

MgmtNetworkName

The name of the vCenter network to attach to the VM's Data interface.

This network must already exist in VMware or the installation will fail.

DataNetworkName

The ESXi host, or ONLY the vcenter cluster/resource group name where the
VM is to be deployed.

The primary option is to use the host IP or name (all the hosts should be under
the data center). If the hosts are under a cluster in the data center, only provide
the cluster name (all hosts within the cluster will be picked up).

The subsequent option is to use a resource group. In this case, a full path
should be provided.

Example: Host = "Main infrastructure/Resources/00_trial"

Host

The datastore name available to be used by this host or resource group.

The primary option is to use host IP or name. The subsequent option is to use
a resource group.

Example: Datastore =

"SDRS-DCNSOL-prodexsi/bru-netapp-01_FC_Prodesx_ds_15"

Datastore
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DescriptionParameter Name

The high speed datastore available for this host or resource group.

When not using a highspeed data store, set to same value as Datastore.

HSDatastore

The resource folder name on vCenter. To be used if you do not have root
access as a VMware user, or when you need to create VMs in separate folders
for maintenance purposes. You must provide the complete path as value for
the DCfolder.

Example: DCfolder = "/WW-DCN-Solutions/vm/00_trial"

Please contact your VMware administrator for any queries regarding the
complete folder path.

Leave as empty if not used.

DCfolder

The name of Crosswork cluster VM image in vCenter.

This value is set as an option when running the cluster installer tool and does
not need to be set in the template file.

Cw_VM_Image

The IDs of the VMs to be hosted by the ESXi host or resource.HostedCwVMs

After you have decided the installation parameters values for Crosswork Network Controller, choose the
method you prefer and begin your deployment:

• Install Cisco Crosswork on VMware vCenter using the Cluster Installer Tool , on page 44

• Manual Installation of Cisco Crosswork using vCenter vSphere UI, on page 58

Install Cisco Crosswork on VMware vCenter using the Cluster
Installer Tool

This section explains the procedure to install Cisco Crosswork on VMware vCenter using the cluster installer
tool.

The time taken to create the cluster can vary based on the size of your deployment profile and the performance
characteristics of your hardware.

Note

Before you begin

Few pointers to know when using the cluster installer tool:

• Make sure that your environment meets all the vCenter requirements specified in Installation Prerequisites
for VMware vCenter, on page 19.

• The edited template in the /data directory contains sensitive information (VM passwords and the
vCenter password). The operator needs to manage access to this content. Store the templates used for
your install in a secure environment or edit them to remove the passwords.
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• Theinstall.log,install_tf.log, andcrosswork-cluster.tfstate fileswill be created
during the install and stored in the /data directory. If you encounter any trouble with the installation,
provide these files to the Cisco Customer Experience team when opening a case.

• The install script is safe to run multiple times. Upon error, input parameters can be corrected and rerun.
You must remove the install.log, install_tf.log, and tfstate files before each re-run.
Running the tool multiple times may result in the deletion and re-creation of VMs.

• In case you are using the same installer tool for multiple Crosswork cluster installations, it is important
to run the tool from different local directories, allowing for the deployment state files to be independent.
The simplest way for doing so is to create a local directory for each deployment on the host machine and
map each one to the container accordingly.

• Docker version 19 or higher is required while using the cluster installer option. For more information on
Docker, see https://docs.docker.com/get-docker/

• To change install parameters or to correct parameters following installation errors, it is important to
distinguish whether the installation has managed to deploy the VMs or not. Deployed VMs are evidenced
by the output of the installer similar to:

vsphere_virtual_machine.crosswork-IPv4-vm["1"]: Creation complete after 2m50s

[id=4214a520-c53f-f29c-80b3-25916e6c297f]

• In the case of deployed VMs, changes to the Crosswork VM settings or the Data Center host for a deployed
VM are NOT supported. To change a setting using the installer when the deployed VMs are present, the
clean operation needs to be run and the cluster redeployed. For more information, see Delete the VM
using the Cluster Installer, on page 225.

• A VM redeployment will delete the VM's data, hence caution is advised. We recommend you perform
VM parameter changes from the Crosswork UI, or alternatively one VM at a time. Installation parameter
changes that occur prior to any VM deployment, for example, an incorrect vCenter parameter, can be
performed by applying the change and simply re-running the install operation.

Known limitations:

These following scenarios are the caveats for installing the Crosswork cluster using the cluster installer tool.

• The vCenter host VMs defined must use the same network names (vSwitch) across all hosts in the data
center.

• The vCenter storage folders or datastores organized under a virtual folder structure, are not supported
currently. Please ensure that the datastores referenced are not grouped under a folder.

• Any VMs that are not created by the day 0 installer (for example, manually brought up VMs), cannot be
changed either by the day 0 installer or via the Crosswork UI later. Similarly, VMs created via the
Crosswork UI cannot be modified using the day 0 installer. When making modifications after the initial
deployment of the cluster, ensure that you capture the inventory information. For more information, see
the Manage Clusters chapter in the Crosswork Network Controller 6.0 Administration Guide.

• Crosswork does not support dual stack configurations, and all addresses for the environment must be
either IPv4 or IPv6. However, vCenter UI provides a service where a user accessing via IPv4 can upload
images to the IPv6 ESXi host. Cluster installer cannot use this service. Follow either of the following
workarounds for IPv6 ESXi hosts:

1. Upload the OVA template image manually, via the GUI and convert it to template.

2. Run the cluster installer from an IPv6 enabled machine. To do this, configure the Docker daemon
to map an IPv6 address into the docked container.
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The installer tool will deploy the software and power on the virtual machines. If you wish to power on the
virtual machines yourself, use the manual installation.

Note

Step 1 In your vCenter data center, go to Host > Configure > Networking > Virtual Switches and select the virtual switch.
In the virtual switch, select Edit > Security, and configure the following DVS port group properties:

• Set Promiscuous mode as Reject

• Set MAC address changes as Reject

Confirm the settings and repeat the process for each virtual switch used in the cluster.

Step 2 In your Docker-capable machine, create a directory where you store everything you will use during this installation.

If you are using a Mac, please ensure that the directory name is in lower case.Note

Step 3 Download the installer bundle (.tar.gz file) and the OVA file from cisco.com to the directory you created previously.
In these instructions, we will use the file names as signed-cw-na-platform-installer-6.0.0-114-release-231211.tar.gz
and signed-cw-na-platform-6.0.0-114-release-231211.ova respectively.

The file names mentioned in this topic are sample names and may differ from the actual file names in
cisco.com.

Attention

Step 4 Use the following command to unzip the installer bundle:
tar -xvf signed-cw-na-platform-installer-6.0.0-114-release-231211.tar.gz

The contents of the installer bundle is unzipped to a new directory (for example,
signed-cw-na-platform-installer-6.0.0-114-release). This new directory will contain the installer image
(cw-na-platform-installer-6.0.0-114-release-231211.tar.gz) and files necessary to validate the image.

Step 5 Change the directory to the directory created by opening the file and then review the contents of the README file in
order to understand everything that is in the package and how it will be validated in the following steps.

Step 6 Use the following command to verify the signature of the installer image:

Use python --version to find out the version of python on your machine.Note

If you are using python 2.x, use the following command to validate the file:
python cisco_x509_verify_release.py -e <.cer file> -i <.tar.gz file> -s <.tar.gz.signature file>
-v dgst -sha512

If you are using python 3.x, use the following command to validate the file:
python cisco_x509_verify_release.py3 -e <.cer file> -i <.tar.gz file> -s <.tar.gz.signature file>
-v dgst -sha512

If you do not have python installed, go to python.org and download the version of python that is appropriate
for your work station.

Note

Step 7 Use the following command to load the installer image file into your Docker environment.
docker load -i <.tar.gz file>
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For example:
docker load -i cw-na-platform-installer-6.0.0-114-release-231211.tar.gz

Step 8 Run Docker image list or Docker images command to get the "image ID" (which is needed in the next step).

For example:
docker images

The result will be similar to the following: (section we will need is underlined for clarity)
My Machine% docker images
REPOSITORY TAG IMAGE ID

CREATED SIZE
dockerhub.cisco.com/cw-installer cw-na-platform-installer-6.0.0-114-release-231211 a4570324fad30
7 days ago 276MB

Pay attention to the "CREATED" time stamp in the table presented when you run docker images, as you
might have other images present from the installation of prior releases. If you wish to remove these, the
docker image rm {image id} command can be used.

Note

Step 9 Launch the Docker container using the following command:
docker run --rm -it -v `pwd`:/data {image id of the installer container}

To run the image loaded in our example, the command would be:
docker run --rm -it -v `pwd`:/data a4570324fad30

• You do not have to enter that full value. In this case, "docker run --rm -it -v `pwd`:/data a45" was
adequate. Docker requires enough of the image ID to uniquely identify the image you want to use for
the installation.

• In the above command, we are using the backtick (`). Do not use the single quote or apostrophe (') as
the meaning to the shell is different. By using the backtick (recommended), the template file and OVA
will be stored in the directory where you are on your local disk when you run the commands, instead
of inside the container.

• When deploying a IPv6 cluster, the installer needs to run on an IPv6 enabled container/VM. This
requires additionally configuring the Docker daemon before running the installer, using the following
method:

• Linux hosts (ONLY): Run the Docker container in host networking mode by adding the
"–network host" flag to the Docker run command line.
docker run --network host <remainder of docker run options>

• Centos/RHEL hosts, by default, enforce a strict SELinux policy which does not allow the installer
container to read from or write to the mounted data volume. On such hosts, run the Docker volume
command with the Z option as shown below:
docker run --rm -it -v `pwd`:/data:Z <remainder of docker options>

Note
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The Docker command provided will use the current directory to read the template and the ova files, and
to write the log files used during the install. If you encounter either of the following errors you should
move the files to a directory where the path is in lowercase (all lowercase, no spaces or other special
characters). Then navigate to that directory and rerun the installer.

Error 1:
% docker run --rm -it -v `pwd`:/data a45
docker: invalid reference format: repository name must be lowercase.
See 'docker run --help'

Error 2:
docker: Error response from daemon: Mounts denied: approving /Users/Desktop: file does
not exist
ERRO[0000] error waiting for container: context canceled

Note

Step 10 Navigate to the directory with the VMware template.
cd /opt/installer/deployments/6.0.0/vcentre

Step 11 Copy the template file found under
/opt/installer/deployments/6.0.0/vcentre/deployment_template_tfvars to the /data
folder using a different name.

For example: cp deployment_template_tfvars /data/deployment.tfvars

For the rest of this procedure, we will use deployment.tfvars in all the examples.

Step 12 Edit the template file located in the /data directory in a text editor, to match your planned deployment. Refer to the
Installation Parameters, on page 39 table for details on the required and optional fields and their proper settings. The
Sample manifest templates for VMware vCenter, on page 49 includes an example that you can reference for proper
formatting. The example is more compact due to the removal of descriptive comments:

Step 13 From the /opt/installer directory, run the installer.
./cw-installer.sh install -p -m /data/<template file name> -o /data/<.ova file>

For example:
./cw-installer.sh install -p -m /data/deployment.tfvars -o
/data/signed-cw-na-platform-6.0.0-114-release-231211.ova

Step 14 Read, and then enter "yes" if you accept the End User License Agreement (EULA). Otherwise, exit the installer and
contact your Cisco representative.

Step 15 Enter "yes" when prompted to confirm the operation.
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It is not uncommon to see some warnings like the following during the install:
Warning: Line 119: No space left for device '8' on parent controller '3'.
Warning: Line 114: Unable to parse 'enableMPTSupport' for attribute 'key' on element 'Config'.

If the install process proceeds to a successful conclusion (see sample output below), these warnings can be
ignored.

Sample output:

cw_cluster_vms = <sensitive>
INFO: Copying day 0 state inventory to CW
INFO: Waiting for deployment status server to startup on 10.90.147.66. Elapsed time 0s,
retrying in 30s
Crosswork deployment status available at
http://{VIP}:30602/d/NK1bwVxGk/crosswork-deployment-readiness?orgId=1&refresh=10s&theme=dark

Once deployment is complete login to Crosswork via: https://{VIP}:30603/#/logincontroller
INFO: Cw Installer operation complete.

Note

If the installation fails due to a timeout, you should try rerunning the installation (step 13) without the -p
option. This will deploy the VMs serially rather than in parallel.

If the installer fails for any other reason (for example, mistyped IP address), correct the error and rerun the
install script.

If the installation fails (with or without the -p), open a case with Cisco and provide the .log files that were
created in the /data directory (and the local directory where you launched the installer docker container),
to Cisco for review. The two most common reasons for the install to fail are: (a) password that is not
adequately complex, and (b) errors in the template file.

Note

What to do next

• See Monitor Cluster Activation, on page 69 to know how you can check the status of the installation.

• See Troubleshoot the Cluster, on page 73 for common troubleshooting scenarios.

Sample manifest templates for VMware vCenter
This topic contains manifest template examples for various scenarios of Crosswork cluster deployment.

In case you are using resource pools, please note that individual ESXi host targetting is not allowed and
vCenter is responsible for assigning the VM to a host in the resource pool. If vCenter is not configured with
resource pools, then the exact ESXi host path must be passed.

Note

Example 1

The following example deploys a Crosswork cluster containing 3 Hybrid nodes (IDs 0,1, 2) and 2 worker
nodes (IDs 3, 4).
*******
vCenter Example
********
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# In case of IPv6, specify ClusterIPstack as IPv6 and continue specifying IPv6 Configuration.

ClusterIPStack = "IPv4"
ManagementVIP = "172.25.87.94"
ManagementIPNetmask = "255.255.255.192"
ManagementIPGateway = "172.25.87.65"
DataVIP = "192.168.123.94"
DataIPNetmask = "255.255.255.0"
DataIPGateway = "0.0.0.0"
DNS = "171.70.168.183"
DomainName = "cisco.com"
CWPassword = "Password!!"
VMSize = "Large"
NTP = "ntp.cisco.com"
CloneTimeOut = 90
ManagerDataFsSize = 450
ThinProvisioned = true
BackupMinPercent = 50
EnableHardReservations = false
ManagerDataFsSize = 450
WorkerDataFsSize = 450

CwVMs = {
"0" = {
VMName = "vm0",
ManagementIPAddress = "172.25.87.82",
DataIPAddress = "192.168.123.82",
NodeType = "Hybrid"

},
"1" = {
VMName = "vm1",
ManagementIPAddress = "172.25.87.83",
DataIPAddress = "192.168.123.83",
NodeType = "Hybrid"

},
"2" = {
VMName = "vm2",
ManagementIPAddress = "172.25.87.84",
DataIPAddress = "192.168.123.84",
NodeType = "Hybrid"

},
"3" = {

VMName = "vmworker0",
ManagementIPAddress = "172.25.87.85",
DataIPAddress = "192.168.123.84",
NodeType = "Worker"

},
"4" = {

VMName = "vmworker1",
ManagementIPAddress = "172.25.87.86",
DataIPAddress = "192.168.123.86",
NodeType = "Worker"

},

}

/********* vCentre Resource Data with Cw VM assignment *********/

VCentreDC = {
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VCentreAddress = "172.25.87.90",
VCentreUser = administrator@vsphere.local,
VCentrePassword = "******",
DCname = "dc-cr",
MgmtNetworkName = "VM Network",
DataNetworkName = "DPortGroup10",
VMs = [
{
HostedCwVMs = ["0","1","2","3", "4"],
Host = "172.25.87.93",
Datastore = "datastore3"
HSDatastore = "datastore3",
},]

}

Example 2

The following example deploy Crosswork cluster with Hosts specified:
/********************************************
* Cw Cluster deployment input data TEMPLATE *
* vcentre version *
* EDIT BEFORE USE *
* v4.2.0 *
*********************************************
#See at the end of the file for a configured sample

/********* Crosswork Cluster Data *********/

# The name of the Crosswork Cluster.
ClusterName = "CW-Cluster-01"

# Provide name of Cw VM image in vcentre or leave empty
# When empty the image name will be populated from the uploaded image
Cw_VM_Image = "cw-na-platform-4.3.0-88-release-220809" # Line added automatically by

installer.

# The IP stack protocol: IPv4 or IPv6
ClusterIPStack = "IPv4"

# The Management Virtual IP for the cluster
ManagementVIP = "10.90.147.66"

# Optional: The Management Virtual IP host-name
ManagementVIPName = ""

# The Management IP subnet in dotted decimal format for ipv4 or prefix length for ipv6
ManagementIPNetmask = "255.255.255.192"

# The Gateway IP on the Management Network
ManagementIPGateway = "10.90.147.65"

# The Data Virtual IP for the cluster. Use 0.0.0.0 or ::0 to disable
DataVIP = "192.168.5.66"

# Optional: The Data Virtual IP host-name
DataVIPName = ""

# The Data IP subnet in dotted decimal format for ipv4 or prefix length for ipv6
# Provied any regular mask when not in use
DataIPNetmask = "255.255.255.0"

# The Gateway IP on the Management Network
DataIPGateway = "192.168.5.1"
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# The IP address of the DNS server
DNS = "171.70.168.183"

# The domain name to use for the cluster
DomainName = "cisco.com"

# Sets the cw-admin user ssh login password for all VMs in the cluster
# The password MUST be of min length 8 and strong
CWPassword = "Password!!"

# Sets the VM size for the cluster.
# Options are: Small | Large.
VMSize = "Large"

# NTP server address or name
NTP = "ntp.esl.cisco.com"

# Configuration Manifest schema version
SchemaVersion = "6.0.0"

# Data disk size for Manager/Hybrid nodes in GB. Min 450 Max 8000
ManagerDataFsSize = 450
# Data disk size for Worker nodes in GB. Min 450 Max 8000
WorkerDataFsSize = 450

// Thin or thick provisioning for all disks. Set to true for thin provisioning, false for
thick
ThinProvisioned = true

# Log partition size in GB. Min 10 Max 1000
LogFsSize = 10

# Minimum percentage of the data disk space to be used for the size of the backup partition

# Note: The final backup partition size will be calculated dynamically. This parameter
defines the minimum.
# Valid range 1 - 80
BackupMinPercent = 50

# Enforces VM profile reservations as "hard"
EnableHardReservations = true

# FOR DEMO USE ONLY - NOT TO BE USED IN PRODUCTION DEPLOYMENTS
# Ram disk size in GB
RamDiskSize = 10

/********* Crosswork VM Data Map *********/
# Configure named entries for each Cw VM.
# Number of Hybrid VMs minimum: 3; maximum: 3
# Number of Worker VMs minimum: 0; maximum: 3

CwVMs = {
# Seed VMs' data.
# IMPORTANT: A VM with id "0" MUST be present in the initial day0 install manifest and

its role MUST be
# set to either MASTER or HYBRID.

"0" = {

# This VM's name
VMName = "CW_Node_0",

# This VMs' management IP address
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ManagementIPAddress = "10.90.147.67",

# This VMs' data IP address. Use 0.0.0.0 or ::0 to disable
DataIPAddress = "192.168.5.67",

# This Cw VM's type - use "Hybrid" for initial install
NodeType = "Hybrid",

# The state for this VM; 2 = running. Only uncomment when doing a manual inventory
import

#Op_Status = 2
},

# Second VMs' data
"1" = {

# This VM's name
VMName = "CW_Node_1",

# This VMs' management IP address
ManagementIPAddress = "10.90.147.68",

# This VMs' data IP address
DataIPAddress = "192.168.5.68",

# This Cw VM's type - use "Hybrid" for initial install
NodeType = "Hybrid",

# The state for this VM; 2 = running. Only uncomment when doing a manual inventory
import

#Op_Status = 2
},

"2" = {

# This VM's name
VMName = "CW_Node_2",
ManagementIPAddress = "10.90.147.69",
DataIPAddress = "192.168.5.69",

# This Cw VM's type - use "Hybrid" for initial install
NodeType = "Hybrid",

# The state for this VM; 2 = running. Only uncomment when doing a manual inventory
import

#Op_Status = 2
}

}

/********* vcentre Resource Data with Cw VM assignment *********/

VCentreDC = {

# The vcentre IP or host name
VCentreAddress = "10.88.192.244",

# The username to use for logging into vcentre
VCentreUser = "Cisco_User",

# The vcentre password for the user
VCentrePassword = "Password",
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# The name of the Data Centre resource to use
DCname = "Cisco-CX-Lab",

# The name of the vcentre network to attach to the Cw VM Management interface
# NOTE: Escape any special characters using their URL escape codes, eg use "%2f" instead
of "/"
MgmtNetworkName = "VM Network",

# The name of the vcentre network to attach to the Cw VM Data interface.
# Leave empty if not used.
# NOTE: Escape any special characters using their URL escape codes, eg use "%2f" instead
of "/"
DataNetworkName = "Crosswork-Internal",

# The resource folder name on vcentre. Leave empty if not used.
DCfolder = "",

# List of the vcentre host resources along with the VMs names
# that each that each resource will host. Add additional stanzas, separated by a ','
# for each additional ESXi host or resource
VMs = [{

# The ESXi host, or ONLY the vcentre cluster/resource group name.
Host = "10.90.147.99",

# The datastore name available to be used by this host or resource group.
Datastore = "Datastore-1",

# The high speed datastore available for this host or resource group.
# Set to same value as Datastore if unsure.
HSDatastore = "Datastore-1"

# The ids of the VMs to be hosted by the above ESXi host or resource. These have to
match to the Cw VM

# ids specified in the Cw VM map. Separate multiple VMs the given
# host with a ',', eg ["0","1"].
HostedCwVMs = ["0","1"]

},
{
Host = "10.90.147.93"
Datastore = "Datastore-2"
HSDatastore = "Datastore-2"
HostedCwVMs =["2"]
}

]
}

Example 3

The following example deploys Crosswork cluster with resource groups:
/********************************************
* Cw Cluster deployment input data TEMPLATE *
* vcentre version *
* EDIT BEFORE USE *
* v6.0.0 *
*********************************************
#See at the end of the file for a configured sample

/********* Crosswork Cluster Data *********/

# The name of the Crosswork cluster.
ClusterName = "CW-cluster-01"
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# Provide name of Cw VM image in vcentre or leave empty
# When empty the image name will be populated from the uploaded image
Cw_VM_Image = "cw-na-platform-6.0.0-414-develop-230926" # Line added automatically by
installer.

# The IP stack protocol: IPv4 or IPv6
ClusterIPStack = "IPv4"

# The Management Virtual IP for the cluster
ManagementVIP = "10.201.240.158"

# Optional: The Management Virtual IP host-name
ManagementVIPName = ""

# The Management IP subnet in dotted decimal format for ipv4 or prefix length for ipv6
ManagementIPNetmask = "255.255.255.224"

# The Gateway IP on the Management Network
ManagementIPGateway = "10.201.240.129"

# The Data Virtual IP for the cluster. Use 0.0.0.0 or ::0 to disable
DataVIP = "192.168.77.158"

# Optional: The Data Virtual IP host-name
DataVIPName = ""

# The Data IP subnet in dotted decimal format for ipv4 or prefix length for ipv6
# Provied any regular mask when not in use
DataIPNetmask = "255.255.255.0"

# The Gateway IP on the Management Network
DataIPGateway = "192.168.77.1"

# The IP address of the DNS server
DNS = "172.18.108.43 172.18.108.34"

# The domain name to use for the cluster
DomainName = "cisco.com"

# Kubernetes Service Network Customization - The default network '10.96.0.0'.
# NOTE: The CIDR range is fixed '/16', no need to enter.
# Only IPv4 is supported, IPv6 customization is NOT supported.
K8sServiceNetwork = "10.96.0.0"

# Kubernetes Service Network Customization - The default network '10.244.0.0'.
# NOTE: The CIDR range is fixed '/16', no need to enter.
# Only IPv4 is supported, IPv6 customization is NOT supported.
K8sPodNetwork = "10.244.0.0"

# Sets the cw-admin user ssh login password for all VMs in the cluster
# The password MUST be of min length 8 and strong
CWPassword = "Password"

# Sets the VM size for the cluster.
# Options are: Small | Large.
VMSize = "Large"

# NTP server address or name
NTP = "ntp.esl.cisco.com"

# Configuration Manifest schema version
SchemaVersion = "6.0.0"
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# Data disk size for Manager/Hybrid nodes in GB. Min 450 Max 8000
ManagerDataFsSize = 450
# Data disk size for Worker nodes in GB. Min 450 Max 8000
WorkerDataFsSize = 450

// Thin or thick provisioning for all disks. Set to true for thin provisioning, false for
thick
ThinProvisioned = true

# Log partition size in GB. Min 10 Max 1000
LogFsSize = 10

# Minimum percentage of the data disk space to be used for the size of the backup partition

# Note: The final backup partition size will be calculated dynamically. This parameter
defines the minimum.
# Valid range 1 - 80
BackupMinPercent = 50

# Enforces VM profile reservations as "hard"
EnableHardReservations = "false"

# FOR DEMO USE ONLY - NOT TO BE USED IN PRODUCTION DEPLOYMENTS
# Ram disk size in GB
RamDiskSize = 0

# Pods that are marked as skip auto install will not be brought up until a dependent
application/pod explicitly asks for it
EnableSkipAutoInstallFeature = "False"

# DEMO/DEV USE ONLY - Enforce pod minimum resource reservations. Default and for production
use is True
EnforcePodReservations = "True"

# Optional: Provide a standard IANA time zone. Default value is Etc/UTC if not specified
Timezone = ""

/********* Crosswork VM Data Map *********/
# Configure named entries for each Cw VM.
# Number of Hybrid VMs minimum: 3; maximum: 3
# Number of Worker VMs minimum: 0; maximum: 3

CwVMs = {
"0" = {
VMName = "cw-vm-0",
ManagementIPAddress = "10.201.240.130",
DataIPAddress = "192.168.77.130",
NodeType = "Hybrid",
#Op_Status = 2

},
"1" = {
VMName = "cw-vm-1",
ManagementIPAddress = "10.201.240.131",
DataIPAddress = "192.168.77.131",
NodeType = "Hybrid",
#Op_Status = 2

},
"2" = {
VMName = "cw-vm-2",
ManagementIPAddress = "10.201.240.132",
DataIPAddress = "192.168.77.132",
NodeType = "Hybrid",
#Op_Status = 2

},

Cisco Crosswork Network Controller 6.0 Installation Guide
56

Install Cisco Crosswork Network Controller on VMware vCenter
Sample manifest templates for VMware vCenter



"3" = {
# This VM's name
VMName = "cw-worker-3",
ManagementIPAddress = "10.201.240.133",
DataIPAddress = "192.168.77.133",
NodeType = "Worker",

# The state for this VM; 2 = running. Only uncomment when doing a manual inventory
import

#Op_Status = 2
},
"4" = {
# This VM's name
VMName = "cw-worker-4",
ManagementIPAddress = "10.201.240.134",
DataIPAddress = "192.168.77.134",
NodeType = "Worker",
#Op_Status = 2

}
}

/********* vcentre Resource Data with Cw VM assignment *********/

VCentreDC = {
VCentreAddress = "10.88.192.244",
VCentreUser = "Cisco_User",
VCentrePassword = "Password",
DCname = "rcdn5-spm-dc-01",
MgmtNetworkName = "Management Network",
DataNetworkName = "Data Network",
DCfolder = ""
VMs = [{
Host = "{path to resource Group}",

Datastore = "iSCSI-DataStore",

HSDatastore = "iSCSI-DataStore",

HostedCwVMs = ["0","1","2","3","4"],

}
]

}

Set seed node explicitly
The cluster installer tool, by default, selects the first VM (VM 0) as the seed node. You can set the seed node
explicitly by adding the following section to the manifest template (.tfvars file) indicating the unique key of
the seed node.

You are recommended not to modify the default seed node value unless advised to do so by the Cisco Customer
Experience team.

Note

cluster_settings = {
#Default Minimum number of nodes in inventory

min_inventory = 3
#Default Max number of nodes in inventory
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max_inventory = 6
#Default Min number of manager nodes

min_mngr_nodes = 2
#Default Max number of manager nodes

max_mngr_nodes = 3
#Default seed node key name

default_seed_node = "0"
}

Manual Installation of Cisco Crosswork using vCenter vSphere
UI

This section explains how to build the cluster using the vCenter user interface. This same procedure can be
used to add or replace nodes if necessary.

The manual installation workflow is broken into two parts. In the first part, you create a template. In the second
part, you deploy the template as many times as needed to build the cluster of 3 Hybrid nodes (typically) along
with any Worker nodes that your environment requires.

1. Build the OVF template, on page 59

2. Deploy the template, on page 65

If the cluster has already been installed (no matter the method used) the template file will already exist unless
it was deleted. In this case, you can directly go to deploying the template (the second part of this procedure).

Note

The manual installation is preferred if you face any of the following reasons:

• Owing to your data center configuration, you cannot deploy the cluster using the installer tool.

• You need to add nodes to the existing cluster.

• You need to replace a failed node.

• You want to migrate a node to a new host machine.

Anytime the configuration of the cluster is changed manually to install Crosswork cluster, or to add nodes,
or move nodes to new hosts using the procedures detailed in this section, you must import the cluster inventory
file (.tfvars file) to the Crosswork UI. The inventory file (a sample can be downloaded from the Crosswork
UI) will contain information about the VMs in your cluster along with the data center parameters. You must
set the parameter OP_Status = 2 to enable manual import of the inventory.

Cisco Crosswork cannot deploy or remove VM nodes in your cluster until you complete this operation. For
more information, see the Import Cluster Inventory topic in the Cisco Crosswork Network Controller 6.0
Administration Guide.

Important
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Build the OVF template

Before you begin

• Make sure that your environment meets all the vCenter requirements specified under Crosswork Cluster
VM Requirements, on page 27 and Installation Prerequisites for VMware vCenter, on page 19.

Step 1 Download the latest available Cisco Crosswork platform image file (*.ova) to your system.
Step 2 With VMware ESXi running, log into the VMware vSphere Web Client. On the left navigation pane, choose the ESXi

host or cluster where you want to deploy the VM.
Step 3 In the vSphere UI, go to Host > Configure > Networking > Virtual Switches and select the virtual switch. In the

virtual switch, select Edit > Security, and configure the following DVS port group properties:

• Set Promiscuous mode as Reject

• Set MAC address changes as Reject

Confirm the settings and repeat the process for each virtual switch used in the cluster.

Step 4 Review and confirm that your network settings meet the requirements.

Ensure that the networks that you plan to use for Management network and Data network are connected to the host.

Step 5 Choose Actions > Deploy OVF Template.

The default VMware vCenter deployment timeout is 15 minutes. If vCenter times out during deployment,
the resulting VMwill not be bootable. To prevent this, we recommend that you document the choices (such
as IP address, gateway, DNS server, etc.) so that you can enter the information quickly and avoid any
issues with the VMware configuration.

Caution

Step 6 The VMware Deploy OVF Template window appears, with the first step, 1 - Select an OVF template, highlighted.
Click Choose Files to navigate to the location where you downloaded the OVA image file and select it. Once selected,
the file name is displayed in the window.

Step 7 Click Next. The Deploy OVF Template window is refreshed, with 2 - Select a name and folder now highlighted.
Enter a name and select the respective data center for the Cisco Crosswork VM you are creating.

We recommend that you include the Cisco Crosswork version and build number in the name, for example: Cisco
Crosswork 6.0 Build 152.

Step 8 Click Next. The Deploy OVF Template window is refreshed, with 3 - Select a compute resource highlighted. Select
the host or cluster for your Cisco Crosswork VM.

Step 9 Click Next. The VMware vCenter Server validates the OVA. Network speed will determine how long validation takes.
After the validation is complete, the Deploy OVF Template window is refreshed, with 4 - Review details highlighted.

Step 10 Review the OVF template that you are deploying. Note that this information is gathered from the OVF, and cannot be
modified.

Step 11 Click Next. The Deploy OVF Template window is refreshed, with 5 - License agreements highlighted. Review the
End User License Agreement and if you agree, click the I accept all license agreements checkbox. Otherwise, contact
your Cisco Experience team for assistance.

Step 12 Click Next The Deploy OVF Template window is refreshed, with 6 - Configuration highlighted. Choose the desired
deployment configuration.
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Figure 4: Select a deployment configuration

If Cisco Crosswork is deployed using a single interface, then Cisco Crosswork Data Gateway must be
deployed using a single interface as well (only recommended for lab deployments).

Note

Step 13 ClickNext. TheDeploy OVF Templatewindow is refreshed, with 7 - Select Storage highlighted. Choose the relevant
option from the Select virtual disk format drop-down list. From the table, choose the datastore you want to use, and
review its properties to ensure there is enough available storage.

Figure 5: Select Storage
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For production deployment, choose theThick Provision Eager Zeroed option because this will preallocate
disk space and provide the best performance. For lab purposes, we recommend the Thin Provision option
because it saves disk space.

Note

Step 14 Click Next. The Deploy OVF Template window is refreshed, with 8 - Select networks highlighted. From the
Destination Network drop-down list, select the proper networks for the Management Network and the Data Network.

Figure 6: Select a deployment configuration

Admin Network and NBI Network are not applicable for Crosswork Network Controller deployments.
You can leave these fields with the default values.

Important

Step 15 Click Next. The Deploy OVF Template window is refreshed, with 9 - Customize template highlighted.

As you are creating a template now and will not build a VM until the next section (Deploy the template,
on page 65), you can enter placeholder values for all the required fields.

Note

a) Expand the Management Network settings. Provide information for the IPv4 or IPv6 deployment (as per your
selection).

b) Expand the Data Network settings. Provide information for the IPv4 or IPv6 deployment (as per your selection).
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Figure 7: Customize template settings

Data Network settings are not displayed if you have selected the IPv4 on a Single Interface or IPv6
on a Single Interface configuration.

Note

c) Expand the Deployment Credentials settings. Enter relevant values for the VM Username and Password.

Use a strong VM Password (8 characters long, including upper & lower case letters, numbers, and at
least one special character). Avoid using passwords similar to dictionary words (for example,
"Pa55w0rd!") or relatable words (for example, C!sco123 or Cwork321!). While they satisfy the criteria,
such passwords are weak and will be rejected resulting in failure to setup the VM.

Note

d) Expand theDNS and NTP Servers settings. According to your deployment configuration (IPv4 or IPv6), the fields
that are displayed are different. Provide information in the following three fields:

• DNS IP Address: The IP addresses of the DNS servers you want the Cisco Crosswork server to use. Separate
multiple IP addresses with spaces.

• DNS Search Domain: The name of the DNS search domain.

• NTP Servers: The IP addresses or host names of the NTP servers you want to use. Separate multiple IPs or
host names with spaces.
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The DNS and NTP servers must be reachable using the network interfaces you have mapped on the
host. Otherwise, the configuration of the VM will fail.

Note

e) The default Disk Configuration settings should work for most environments. Change the settings only if you are
instructed to by the Cisco Customer Experience team.

f) Expand Crosswork Configuration and enter your legal disclaimer text (users will see this text if they log into the
CLI).

g) Expand Crosswork Cluster Configuration. Provide relevant values for the following fields:

• VM Type:

• Choose Hybrid if this is one of the 3 Hybrid nodes.

• Choose Worker if this is a Worker node.

• Cluster Seed node:

• Choose True if this is the first VM being built in a new cluster.

• Choose False for all other VMs, or when rebuilding a failed VM.

• Crosswork Management Cluster Virtual IP: Enter the Management Virtual IP address and Management
Virtual IP DNS name.

• Crosswork Data Cluster Virtual IP: Enter the Data Virtual IP address. and the Data Virtual IP DNS name.

• Initial node count: Default value is 3.

• Initial leader node count: Default value is 3.
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• Location of VM: Enter the location of VM.

• Installation type:

• For new cluster installation: Do not select the checkbox.

• Replacing a failed VM: Select the checkbox if this VM is being installed to replace a failed VM. This
parameter becomes important when you deploy the template.

Step 16 Click Next. The Deploy OVF Template window is refreshed, with 10 - Ready to Complete highlighted.
Step 17 Review your settings and then click Finish if you are ready to begin deployment. Wait for the deployment to finish

before continuing. To check the deployment status:
a) Open a VMware vCenter client.
b) In the Recent Tasks tab of the host VM, view the status of the Deploy OVF template and Import OVF package

jobs.

Step 18 To finalize the template creation, select the host and right-click on the newly installed VM and select Template >
Convert to Template. A prompt confirming the action is displayed. Click Yes to confirm. The template is created
under the VMs and Templates tab in the vSphere Client UI.

This is the end of the first part of the manual installation workflow. In the second part, use the newly created template
to build the cluster VMs.
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Deploy the template

Step 1 To build a VM, right-click on the template and select New VM from This Template.

If the template is no longer present ,go back and create the template. For more information, see Build the
OVF template, on page 59.

Note

Step 2 The VMware Deploy From Template window appears, with the first step, 1 - Select a name and folder, highlighted.
Enter a name and select the respective data center for the VM.

If this is a new VM, the name must be unique and cannot be the same name as the template. If this VM is
replacing an existing VM (for example, CW-VM-0) give the VM a unique temporary name (for example,
CW-VM-0-New).

Note

Step 3 Click Next. The Deploy From Template window is refreshed, with 2 - Select a compute resource highlighted. Select
the host for your Cisco Crosswork VM.

Step 4 Click Next. The Deploy From Template window is refreshed, with 3 - Select Storage highlighted. Choose Same
format as source option as the virtual disk format (recommended).

The recommended configuration for the nodes uses a combination of high-speed (typically SSD based) and normal
(typical disks) storage. If you are following the recommended configuration follow the steps for two data stores.
Otherwise, follow the steps for using a single data store.

If you are using two data stores (regular and high speed):

• Enable Configure per disk option.

• Select same data store (regular) as the Storage setting for disks 1 through 5. This data store must have 916 GB of
space.

• Select the host's high speed (ssd) data store as the Storage setting for disk 6. The high speed data store must have
at least 50 GB of space.
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Figure 8: Select Storage - Configure per disk

• Click Next.

If you are using a single data store: Select the data store you wish to use, and click Next.
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Figure 9: Select Storage - single data store

Step 5 The Deploy From Template window is refreshed, with 4 - Select clone options highlighted. Unless you have been
given specific instructions to make modifications, select Next.

Step 6 Click Next. The Deploy From Template window is refreshed, with 5 - Customize vApp properties highlighted. The
vApp properties are prepopulated with the values that were entered during the template creation. Some of the values
will need to be updated with the proper values for each node being deployed.

• It is recommended to change only the fields that are unique to each node. Leave all other fields at the
default values.

• If this VM is being deployed to replace a failed VM, or to migrate the VM to a new host, the IP and
other settings must match the machine being replaced.

Tip

• Set the node type (Hybrid/Worker).

• Management Network settings: Enter correct IP values for each VM in the cluster.

• Data Network settings: Enter correct IP values for each VM in the cluster.

• Deployment Credentials: Enter same deployment credentials for each VM in the cluster.

• DNS and NTP Servers: Enter correct values for the DNS and NTP servers.
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• Disk Configuration: Leave at the default settings unless directed otherwise by the Cisco Customer Experience
team.

• Crosswork Configuration: Enter the disclaimer message.

• Crosswork Cluster Configuration:

• VM Type: Select Hybrid or Worker

• Cluster Seed node:

• Choose True if this is the first VM being built in a new cluster.

• Choose False for all other VMs, or when rebuilding a failed VM.

• Crosswork Management Cluster Virtual IP: The Virtual IP will remain same for each cluster node.

• Crosswork Data Cluster Virtual IP: The Virtual IP will remain same for each cluster node.

Step 7 Click Next. The Deploy From Template window is refreshed, with 6 - Ready to complete highlighted. Review your
settings and then click Finish if you are ready to begin deployment.

Step 8 Repeat from Step 1 to Step 7 to deploy the remaining VMs in the cluster.

When deploying the cluster for the first time, make sure the IP addresses and Seed node settings are correct.
When replacing or migrating a node make sure the settings match the original VM.

Remember

Step 9 Choose the relevant action:

• If you are deploying a new VM, you can now power on Crosswork VMs. The VM selected as the cluster seed
node must be powered on first, followed by the remaining VMs (after a delay of few minutes). To power on,
expand the host’s entry, click the Cisco Crosswork VM, and then choose Actions > Power > Power On.

• If this VM is replacing an existing VM, perform the following:

• Power down the existing VM

• Change the name of the original VM (for example, change to CW-VM-0-Old)

• Change the name of the replacement VM (for example change to CW-VM-0-New) to match the name of the
original VM (for example, CW-VM-0).

• Power on the new VM.

• After confirming that cluster is healthy and running, delete the original VM (now named as CW-VM-0-Old)

Step 10 The time taken to create the cluster can vary based on the size of your deployment profile and the performance
characteristics of your hardware. See Monitor Cluster Activation, on page 69 to know how you can check the status
of the installation.

If you are running this procedure to replace a failed VM, then you can check the status from the Cisco
Crosswork GUI (go to Administration > Crosswork Manager and click on the cluster tile to check the
Crosswork Cluster status.

Note
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If you are using the process to build a new Worker node, the node will automatically register itself with
the existing Kubernetes cluster. For more information on how the resources are allocated to the Worker
node, see the Rebalance Cluster Resources topic in the Cisco Crosswork Network Controller 6.0
Administration Guide.

Note

Step 11 After you login to Crosswork UI, import a cluster inventory file (.tfvars file) to the Crosswork UI. The inventory file
(a sample can be downloaded from the Crosswork UI) will contain information about the VMs in your cluster along
with the data center parameters. Set the parameter OP_Status = 2 to enable manual import of the inventory. Cisco
Crosswork cannot deploy or remove VM nodes in your cluster until you complete this operation.

For more information, see the Import Cluster Inventory topic in the Cisco Crosswork Network Controller 6.0
Administration Guide.

What to do next

Return to the installation workflow: Install Cisco Crosswork Network Controller on VMware vCenter, on
page 11

Monitor Cluster Activation
This section explains how to monitor and verify if the installation has completed successfully. As the installer
builds and configures the cluster it will report progress. The installer will prompt you to accept the license
agreement and then ask if you want to continue the install. After you confirm, the installation will progress
and any possible errors will be logged in either installer.log or installer_tf.log. If the VMs
get built and are able to boot, the errors in applying the operator specified configuration will be logged on the
VM in the /var/log/firstboot.log.

During installation, Cisco Crosswork will create a special administrative ID (virtual machine (VM)
administrator, cw-admin, with the password that you provided in the manifest template. In case the installer
is unable to apply the password, it creates the administrative ID with the default password cw-admin). The
first time you log in using this administrative ID, you will be prompted to change the password.

The administrative username is reserved and cannot be changed. Data center administrators use this ID to log
into and troubleshoot the Crosswork application VM.

Note

The following is a list of critical steps in the process that you can watch for to be certain that things are
progressing as expected:

1. The installer uploads the crosswork image file (.ova file) to the vCenter data center.

On running, the installer will upload the .ova file into the vCenter if it is not already present, and convert it
into a VM template. After the installation is completed successfully, you can delete the template file from the
vCenter UI (located under VMs and Templates) if the image is no longer needed.

Note
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2. The installer creates the VMs, and displays a success message (e.g. "Creation Complete") after each VM
is created.

For VMware deployments, this activity can also be monitored from the vSphere UI.Note

3. After each VM is created, it is powered on (either automatically when the installer completes, or after
you power on the VMs during the manual installation). The parameters specified in the template are
applied to the VM, and it is rebooted. The VMs are then registed by Kubernetes to form the cluster.

4. Once the cluster is created and becomes accessible, a success message (e.g. "Crosswork Installer operation
complete") will be displayed and the installer script will exit and return you to a prompt on the screen.

You can monitor startup progress using the following methods:

• Using browser accessible dashboard:

1. While the cluster is being created, monitor the setup process from a browser accessible dashboard.

2. The URL for this grafana dashboard (in the format
http://{VIP}:30602/d/NK1bwVxGk/crosswork-deployment-readiness?orgId=1&refresh=10s&theme=dark)
is displayed once the installer completes. This URL is temporary and will be available only for a
limited time (around 30 minutes).

3. At the end of the deployment, the grafana dashboard will report a "Ready" status. If the URL is
inaccessible, use the SSH console described in this section to monitor the installation process.

Figure 10: Crosswork Deployment Readiness

• Using the console:

1. Check the progress from the console of one of the hybrid VMs or by using SSH to the Virtual IP
address.

2. In the latter case, login using the cw-admin user name and the password you assigned to that account
in the install template.

3. Switch to super user using sudo su - command.

4. Run kubectl get nodes (to see if the nodes are ready) and kubectl get pods (to see the list of
active running pods) commands.

5. Repeat the kubectl get pods command until you see robot-ui in the list of active pods.
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6. At this point, you can try to access the Cisco Crosswork UI.

After the Cisco Crosswork UI becomes accessible, you can also monitor the status from the UI. For more
information, see Log into the Cisco Crosswork UI, on page 71.

Failure Scenario

In the event of a failue scenario (listed below), contact the Cisco Customer Experience team and provide the
installer.log, installer_tf.log, and firstBoot.log files (there will be one per VM) for
review:

• Installation is incomplete

• Installation is completed, but the VMs are not functional

• Installation is completed, but you are directed to check /var/log/firstBoot.log or
/opt/robot/bin/firstBoot.log file.

What to do next:

Return to the installation workflow: Install Cisco Crosswork Network Controller on VMware vCenter, on
page 11

Log into the Cisco Crosswork UI
Once the cluster activation and startup have been completed, you can check if all the nodes are up and running
in the cluster from the Cisco Crosswork UI.

Supported web browsers are Google Chrome (version 100 or later) andMozilla Firefox (version 100 or later).Note

Perform the following steps to log into the Cisco Crosswork UI and check the cluster health:

If the Cisco Crosswork UI is not accessible, during installation, please access the host's console from the
VMware or AWS UI to confirm if there was any problem in setting up the VM. When logging in, if you are
directed to review the firstboot.log file, please check the file to determine the problem. If you are able
to identify the error, rectify it and restart the node(s). If you require assistance, please contact the Cisco
Customer Experience team.

Note

Step 1 Launch one of the supported browsers.
Step 2 In the browser's address bar, enter:

https://<Crosswork Management Network Virtual IP (IPv4)>:30603/

or
https://[<Crosswork Management Network Virtual IP (IPv6)>]:30603/
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Please note that the IPv6 address in the URL must be enclosed with brackets.Note

You can also log into the Crosswork UI using the Crosswork FQDN name.Note

The Log In window opens.

When you access the Cisco Crosswork for the first time, some browsers display a warning that the site is
untrusted. When this happens, follow the prompts to add a security exception and download the self-signed
certificate from the Cisco Crosswork server. After you add a security exception, the browser accepts the
server as a trusted site in all future login attempts. If you want to use a CA signed certificate, see theManage
Certificates topic in the Cisco Crosswork Network Controller 6.0 Administration Guide.

Note

Step 3 Log into the Cisco Crosswork as follows:
a) Enter the Cisco Crosswork administrator username admin and the default password admin.
b) Click Log In.
c) When prompted to change the administrator's default password, enter the new password in the fields provided and

then click OK.

Use a strong VM Password (minimum 8 characters long, including upper & lower case letters, numbers,
and one special character). Avoid using passwords similar to dictionary words (for example, "Pa55w0rd!")
or relatable words (for example, C!sco123 or Cwork321!).

Note

The Crosswork Manager window is displayed.

Step 4 Click on the Crosswork Health tab, and click the Crosswork Platform Infrastructure tab to view the health status of
the microservices running on Cisco Crosswork.
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Step 5 (Optional) Change the name assigned to the admin account (by default, it is "John Smith") to something more relevant.

What to do next

Return to the installation workflow: Install Cisco Crosswork Network Controller on VMware vCenter, on
page 11

Troubleshoot the Cluster
By default, the installer displays progress data on the command line. The install log is fundamental in identifying
the problems, and it is written into the /data directory.

Table 22: General scenarios

Possible ResolutionScenario

The ESXi hosts that will run the Crosswork application and
Crosswork Data Gateway VM must have NTP configured, or
the initial handshake may fail with "certificate not valid" errors.

Certificate Error

The image upload duration depends on the link and datastore
performance and can be expected to take around 10 minutes or
more. If an upload is interrupted, the user needs to manually
remove the partially uploaded image file from vCenter via the
vSphere UI.

Image upload takes a long time or upload
is interrupted.

The vCenter user needs to have authorization to perform the
actions as described in Installation Prerequisites for VMware
vCenter, on page 19.

vCenter authorization
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Possible ResolutionScenario

The VRRP protocol requires unique router_id advertisements to
be present on the network segment. By default, Crosswork uses
the ID 169 on the management and ID 170 on the data network
segments. A symptom of conflict, if it arises, is that the VIP
address is not reachable. Remove the conflicting VRRP router
machines or use a different network.

Floating VIP address is not reachable

This happens when the password is not complex enough. Create
a strong password, update the configuration manifest and
redeploy.

Use a strong VM Password (8 characters long, including upper
& lower case letters, numbers, and at least one special character).
Avoid using passwords similar to dictionary words (for example,
"Pa55w0rd!") or relatable words (for example, C!sco123 or
Cwork321!). While they satisfy the criteria, such passwords are
weak and will be rejected resulting in failure to setup the VM.

Crosswork VM is not allowing the admin
user to log in

OR

The following error is displayed:
Error: Invalid value for variable on
cluster_vars.tf line 113:

├────────────────

This was checked by the validation
rule at cluster_vars.tf:115,3-13.

Error: expected length of name to be
in the range (1 - 80), got

with
data.vsphere_virtual_machine.template_from_ovf,

on main.tf line 32, in data
"vsphere_virtual_machine"
"template_from_ovf":
32: name

= var.Cw_VM_Image

Mon Aug 21 18:52:47 UTC 2023: ERROR:
Installation failed.
Check installer and the VMs' log by
accessing via console and viewing
/var/log/firstBoot.log

The clusters' seed VM is either unreachable or one or more of
the cluster VMs have failed to get properly configured.

1. Check whether the VM is reachable, and collect logs from
/var/log/firstBoot.log and
/var/log/vm_setup.log

2. Check the status of the other cluster nodes.

Deployment fails with: Failed to validate
Crosswork cluster initialization.
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Possible ResolutionScenario

A successful deployment allows the operator logging in to the
VIP or any cluster IP address to run the following command to
get the status of the cluster:
sudo kubectl get nodes

A healthy output for a 3-node cluster is:
NAME STATUS ROLES AGE VERSION
172-25-87-2-hybrid.cisco.com Ready master 41d
v1.16.4

172-25-87-3-hybrid.cisco.com Ready master 41d
v1.16.4

172-25-87-4-hybrid.cisco.com Ready master 41d
v1.16.4

In case of a different output, collect the following logs:
/var/log/firstBoot.log and
/var/log/vm_setup.log

In addition, for any cluster nodes not displaying the Ready state,
collect:
sudo kubectl describe node <name of node>

The VMs are deployed but the Crosswork
cluster is not being formed.

The Dswitch on the vCenter is misconfigured. Please check
whether it is operational and mapped to the ESXi hosts.

The following error is displayed while
uploading the image:

govc: The provided network mapping
between OVF networks and the system
network is not supported by any host.

Most likely cause would be an issue in the VM parameters
provided or network reachability. Enter the VM host through the
vCenter console. and review and collect the following logs:
/var/log/firstBoot.log and
/var/log/vm_setup.log

VMs deploy but install fails with Error:
timeout waiting for an available IP address

Enable Profile-driven storage. Query permissions for the vCenter
user at the root level (i.e. for all resources) of the vCenter.

When deploying on a vCenter, the
following error is displayed towards the
end of the VM bringup:

Error processing disk changes post-clone:
disk.0: ServerFaultCode: NoPermission:
RESOURCE (vm-14501:2000), ACTION
(queryAssociatedProfile): RESOURCE
(vm-14501), ACTION
(PolicyIDByVirtualDisk)
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Possible ResolutionScenario

The installer uses the tfstate file stored as
/data/crosswork-cluster.tfstate to maintain the
state of the VMs it has operated upon. If a VM is removed outside
of the installer, that is through the vCenter UI, this state is out
of synchronization.

To resolve, remove the
/data/crosswork-cluster.tfstate file.

On running or cleaning, installer reports
Error: cannot locate virtual machine with
UUID "xxxxxxx": virtual machine with
UUID "xxxxxxxx" not found

Table 23: Installer tool scenarios

Possible ResolutionScenario

The installer provides a clue as regards to the issue; however, in
case of errors in the manfiest file HCL syntax, these can be
misguiding. If you see "Type errors", check the formatting of
the configuration manifest.

The manifest file can also be passed as a simple JSON file. Use
the following converter to validate/convert:
https://www.hcl2json.com/

Missing or invalid parameters

These errors are common when re-running the installer after an
initial run is interrupted (Control C, or TCP timeout, etc).
Remediation steps are:

1. Run the clean operation (./cw-installer.sh clean -m

<your manifest here>) OR remove the VM files manually
from the vCenter.

2. Remove the state file (rm
/data/crosswork-cluster.tfstate).

3. Retry the installation (./cw-installer.sh clean -m <your

manifest here>).

Error conditions such as:

Error: Error locking state: Error acquiring
the state lock: resource temporarily
unavailable

Error: error fetching virtual machine: vm
not found

Error: Invalid index

The time needed to clone the VMs during the installation will
be determined by the workload on the disk drives used by the
host machines. Running the install serially (without the [-p] flag)
will lessen this load while increasing the time needed to deploy
the VMs.

The VMs take a long time to deploy

Other than the Crosswork cluster VMs, the installer tracks other
meta-resources. Thus, when doing an installation of, say a 3-VM
cluster, the installer may report a "plan" to add more resources
than the number of VMs.

Installer reports plan to addmore resources
than the current number of VMs
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Possible ResolutionScenario

To resolve, remove the
/data/crosswork-cluster.tfstate file.

The installer uses the tfstate file stored as
/data/crosswork-cluster.tfstate to maintain the
state of the VMs it has operated upon. If a VM is removed outside
of the installer, that is through the vCenter UI, this state is out
of synchronization.

On running or cleaning, installer reports
Error: cannot locate virtual machine with
UUID "xxxxxxx": virtual machine with
UUID "xxxxxxxx" not found

What to do next:

Return to the installation workflow: Install Cisco Crosswork Network Controller on VMware vCenter, on
page 11
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C H A P T E R 6
Install Cisco Crosswork Data Gateway on
VMware vCenter

This chapter contains the following topics:

• Cisco Crosswork Data Gateway Installation Workflow, on page 79
• Log in and Log out of Crosswork Data Gateway VM, on page 110
• Cisco Crosswork Data Gateway Authentication and Enrollment, on page 112
• Crosswork Data Gateway Post-installation Tasks, on page 112
• Troubleshoot Crosswork Data Gateway Installation and Enrollment, on page 114

Cisco Crosswork Data Gateway Installation Workflow
Cisco Crosswork Data Gateway is installed as a base VM that contains only enough software to register itself
with Cisco Crosswork.

If you are redeploying the same Cisco Crosswork Data Gateway with Cisco Crosswork, delete the previous
Crosswork Data Gateway entry from the Virtual Machine table under Data Gateway Management. For
information on how to delete a Crosswork Data Gateway VM, see Delete Crosswork Data Gateway VM from
Cisco Crosswork.

Note

To install Crosswork Data Gateway VM for use with Cisco Crosswork, follow these steps:

1. Choose the deployment profile for the Crosswork Data Gateway VM. See Crosswork Data Gateway VM
Requirements, on page 28.

2. Review the installation parameters at Cisco Crosswork Data Gateway Parameters and Deployment
Scenarios and make sure that you have all the required information to install Crosswork Data Gateway
using your the preferred deployment scenario.

3. Install Cisco Crosswork Data Gateway using yours preferred method:
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Table 24: Crosswork Data Gateway installation options

Install Cisco Crosswork Data Gateway using
vCenter vSphere Client, on page 93

VMware

Install Cisco Crosswork Data Gateway via OVF
Tool, on page 105

If you plan to install multiple Cisco Crosswork Data Gateway VMs due to load or scale requirements or you
wish to leverage Cisco Data Gateway High Availability, we recommend that you install all the Crosswork
Data Gateway VMs first and then proceed with adding them to a Data Gateway pool.

Note

4. Complete the post-installation tasks mentioned in the section Crosswork Data Gateway Post-installation
Tasks, on page 112.

5. Verify that the Crosswork Data Gateway VM has enrolled successfully with Cisco Crosswork. For
information on how to verify the enrollment process, see Cisco Crosswork Data Gateway Authentication
and Enrollment, on page 112.

After verifying that the Crosswork Data Gateway VM has enrolled successfully with Cisco Crosswork, set
up the Crosswork Data Gateway for collection by creating a Crosswork Data Gateway pool. For more
information, see the Create a Crosswork Data Gateway Pool section in Cisco Crosswork Network Controller
6.0 Administration Guide.

Cisco Crosswork Data Gateway Parameters and Deployment Scenarios
Before you begin installing the CrossworkData Gateway, read through this section to understand the deployment
parameters and possible deployment scenarios.

Crosswork Data Gateway supports either IPv4 or IPv6 addresses for all interfaces. Cisco Crosswork does not
support dual-stack configurations. Therefore, plan ALL addresses for the environment as either IPv4 or IPv6.

During installation, Cisco Crosswork Data Gateway creates the following user accounts:

• Cisco Crosswork Data Gateway administrator, with the username, dg-admin, and the password set during
installation. The administrator uses this ID to log in and troubleshoot Cisco Crosswork Data Gateway.

• Cisco Crosswork Data Gateway operator, with the username, dg-oper and the password set during
installation. The dg-oper user has permissions to perform all ‘read’ operations and limited ‘action’
commands.

To know what operations an admin and operator can perform, see the Supported User Roles topic in the
Cisco Crosswork Network Controller 6.0 Administration Guide.

• Cisco Crosswork Data Gateway technical assistance center, with the username, dg-tac. The password
for this user is set when one of the other users of the data gateways enables this account.

The dg-admin, dg-oper, and dg-tac user accounts are reserved user names and cannot be changed. You can
change the password in the console for both the accounts. For more information, see the Change Passphrase
section inCisco Crosswork Network Controller 6.0 Administration Guide. In case of lost or forgotten passwords,
destroy the current VM, you have to create a new VM, and re-enroll the new VM with Cisco Crosswork.
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The following table provides the label and key values of deployment parameters. Labels represent the parameters
that can be configured in the VMware UI and Keys corresponds to field values in the OVF script that match
your configuration.

In the following table:
* Denotes the mandatory parameters. Parameters without this mark are optional. You can choose them based
on your deployment scenario. Deployment scenarios are explained (wherever applicable) in the Additional
Information column.
** Denotes parameters that you can enter during install or address later using additional procedures.

When entering the parameters for deployment, ensure that you add the correct parameters. If the parameter
values are incorrect, you have to destroy the current Crosswork Data Gateway VM, create a new VM, and
re-enroll the new VM with Cisco Crosswork.

Note

Table 25: Cisco Crosswork Data Gateway Deployment Parameters and Scenarios

Additional InformationDescriptionKeyLabel

Host Information

Name of the Cisco
Crosswork Data Gateway
VM specified as a fully
qualified domain name
(FQDN).

In larger systems, you are
likely to have more than
one Cisco Crosswork
Data Gateway VM. The
host namemust, therefore,
be unique and created in
a way that makes
identifying a specific VM
easy.

HostnameHostname*

A detailed description of
the Cisco Crosswork Data
Gateway.

DescriptionDescription*

Label used by Cisco
Crosswork to categorize
and group multiple Cisco
Crosswork Data Gateway
VMs.

LabelCrosswork Data Gateway
Label
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The default value is Yes
to automatically allow
interface addresses in an
RFC 8190 range.

Choose how to validate
interface addresses that
fall in a usable RFC 8190
range. Options are: Yes,
No, or Ask, where the
initial configuration script
prompts for confirmation.

The default value is Yes.

AllowRFC8190Allow Usable RFC 8190
Addresses*

Cisco Crosswork uses
self-signed certificates for
handshake with Cisco
CrossworkDataGateway.
These certificates are
generated at installation.

However, if you want to
use third party or your
own certificate files, then
enter these parameters.

Certificate chains override
any preset or generated
certificates in the Cisco
Crosswork Data Gateway
VM and are given as an
SCP URI
(user:host:/path/to/file).

The host with the URI
files must be reachable on
the network (from the
vNIC0 interface via SCP)
and files must be present
at the time of install.

SCP URI to private key
file for session key
signing. You can retrieve
this using SCP
(user@host:path/to/file).

DGCertKeyCrosswork Data Gateway
Private Key URI

Passphrase of the SCP
user to retrieve the Cisco
Crosswork Data Gateway
PEM formatted certificate
file and private key.

DGCertChainPwdCrosswork Data Gateway
Certificate File and Key
Passphrase

Indicates the size in GB
of a second data disk. The
default value of this
parameter in each profile
is:

• 20 GB for Standard.

• 520 GB for
Extended.

Do not change the default
value without consulting
a Cisco representative.

DGAppdataDiskData Disk Size
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When deploying on
VMware, set the network
to L2.

Indicates the mode for the
HA network.

Options are:

• L2

• L3

The default value is L2.

HANetworkModeHigh Availability
Network Mode*

Passphrase

The password you have
chosen for the dg-admin
user.

Password must be 8-64
characters.

dg-adminPassworddg-admin Passphrase*

The password you have
chosen for the dg-oper
user.

Password must be 8-64
characters.

dg-operPassworddg-oper Passphrase*

Interfaces

In a 3-NIC deployment, you need to provide IP address for Management Traffic (vNIC0) and Control/Data
Traffic (vNIC1) only. IP address for Device Access Traffic (vNIC2) is assigned during Crosswork Data
Gateway pool creation as explained in theCreate a Crosswork Data Gateway Pool section inCisco Crosswork
Network Controller 6.0 Administration Guide.

Selecting None in both IPv4 Method and the IPv6 Method fields of the vNIC results in a
nonfunctional deployment.

Note

vNIC Role Assignment

Role assignment allows you to control the traffic that an interface must handle. If the preassigned roles don’t
meet the specific needs of your organization, you can explicitly assign roles to interfaces. For example, you
can assign the role 'ADMINISTRATION' to an interface to route only the SSH traffic.

Each parameter has a predefined role. The parameter accepts the interface value as eth0, eth1, or eth2.
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For information on the
type of roles that youmust
assign to the vNICs, see
Table 9: Cisco Crosswork
Data Gateway default
vNIC deployment modes,
on page 24.

The interface used as the
Default Gateway for
processing the DNS and
NTP traffic.

Options are eth0, eth1, or
eth2. The default value is
eth0.

NicDefaultGatewayDefault Gateway*

The interface used to
access the VM through
the SSH access.

Options are eth0, eth1, or
eth2. The default value is
eth0.

NicAdministrationAdministration*

The interface used to send
logs to an external logging
server.

Options are eth0, eth1, or
eth2. The default value is
eth0.

NicExternalLoggingExternal Logging*

The interface used to send
the enrollment and other
management traffic.

Options are eth0, eth1, or
eth2. The default value is
eth0.

NicManagementManagement*

The interface used to send
the destination, device,
and collection
configuration.

Options are eth0, eth1, or
eth2. The default value is
eth1.

NicControlControl*

NicNBSystemDataNorthbound SystemData*
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The interface used to send
collection data to the
system destination.

As the system destinations
share the same IP as
interface that allows
connection to the
collection service, the
northbound data for
system destinations uses
the Control role's
interface.

Options are eth0, eth1,
eth2or eth3.

The interface used to send
the collection data to the
external destinations
configured by the user.

Options are eth0, eth1, or
eth2. The default value is
eth1.

NicNBExternalDataNorthbound External
Data*

The interface used to
collect data from the
devices.

If the interface only has
the NicSBData role, it
doesn't need an IP during
the deployment.

Options are eth0, eth1, or
eth2. The default value is
eth2.

NicSBDataSouthbound Data*

vNIC IPv4 Address (vNIC0, vNIC1, and vNIC2 based on the number of interfaces you choose to use)

If you plan on using 1 NIC, you must configure Crosswork Data Gateway to vNIC0 with either
an IPv4 or an IPv6 and set the Method to "Static". When using two or three NICs both vNIC0
and vNIC1 must be assigned static IPV4 or IPv6 addresses.

Dual stack is not supported therefore all addresses must be either IPv4 or IPv6. All unused
vNICs (IPv4 or IPV6) should be left set to Method "None" with the other fields left at the
default.

Important

Cisco Crosswork Network Controller 6.0 Installation Guide
85

Install Cisco Crosswork Network Controller on VMware vCenter
Cisco Crosswork Data Gateway Parameters and Deployment Scenarios



Additional InformationDescriptionKeyLabel

If you have selected
Method as:

• None: Skip the rest
of the fields for the
vNIC IPv4
parameters. Proceed
to enter information
in the vNIC IPv6
Address parameters.

• Static: Enter
information in
Address, Netmask,
Skip Gateway, and
Gateway fields

Method in which the
interface is assigned an
IPv4 address - None or
Static.

The default value is None.

Vnic0IPv4Method

Vnic1IPv4Method

Vnic2IPv4Method

vNIC IPv4 Method*

For example, the
parameter name for
vNIC0 is vNIC0 IPv4
Method.

IPv4 address of the
interface.

Vnic0IPv4Address

Vnic1IPv4Address

Vnic2IPv4Address

vNIC IPv4 Address

IPv4 netmask of the
interface in dotted quad
format.

Vnic0IPv4Netmask

Vnic1IPv4Netmask

Vnic2IPv4Netmask

vNIC IPv4 Netmask

The default value is
False.

Setting this to True skips
configuring a gateway.

Vnic0IPv4SkipGateway

Vnic1IPv4SkipGateway

Vnic2IPv4SkipGateway

vNIC IPv4 Skip Gateway

IPv4 address of the vNIC
gateway.

Vnic0IPv4Gateway

Vnic1IPv4Gateway

Vnic2IPv4Gateway

vNIC IPv4 Gateway

vNIC IPv6 Address (vNIC0, vNIC1, and vNIC2 based on the number of interfaces you choose to use)
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If you have selected
Method as:

• None: Skip the rest
of the fields for the
vNIC IPv6
parameters. Enter
information in the
vNIC IPv4 Address
parameters.

• Static: Enter
information in
Address, Netmask,
Skip Gateway, and
Gateway fields

Do not change the
VnicxIPv6Address default
values.

Method in which the
vNIC interface is assigned
an IPv6 address - None,
Static, or SLAAC.

The default value is None.

Vnic0IPv6Method

Vnic1IPv6Method

Vnic2IPv6Method

vNIC IPv6 Method*

IPv6 address of the
interface.

Vnic0IPv6Address

Vnic1IPv6Address

Vnic2IPv6Address

vNIC IPv6 Address

IPv6 prefix of the
interface.

Vnic0IPv6Netmask

Vnic1IPv6Netmask

Vnic2IPv6Netmask

vNIC IPv6 Netmask

Options are True or
False.

Selecting True skips
configuring a gateway.

Vnic0IPv6SkipGateway

Vnic1IPv6SkipGateway

Vnic2IPv6SkipGateway

vNIC IPv6 Skip Gateway

IPv6 address of the vNIC
gateway.

Vnic0IPv6Gateway

Vnic1IPv6Gateway

Vnic2IPv6Gateway

vNIC IPv6 Gateway

DNS Servers

Space delimited list of
IPv4 or IPv6 addresses of
the DNS servers
accessible from the
management interface.

DNSDNS Address*

DNS search domain. The
default value is
localdomain.

DomainDNS Search Domain*

Options are False, True,
or Allow-Downgrade.

The default value is False

Select True to use DNS
security extensions.

DNSSECDNS Security Extensions
*
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Options are False, True,
and Opportunistic.

The default value is
False.

Select True to use DNS
over TLS.

DNSTLSDNS over TLS*

If you choose Resolve,
only resolution support is
enabled. Responding is
disabled.

Options are False, True,
and Resolve. Select True
to use multicast DNS.

The default value is
False.

mDNSMulticast DNS*

If you choose Resolve,
only resolution support is
enabled. Responding is
disabled.

Select True to use
link-local multicast name
resolution.

Options are False, True,
Opportunistic, or
Resolve.

The default value is
False.

LLMNRLink-Local Multicast
Name Resolution*

NTPv4 Servers

You must enter a value
here, such as pool.ntp.org.
NTP server is critical for
time synchronization
between Crosswork Data
GatewayVM,Crosswork,
and devices. Using a
nonfunctional or dummy
address may cause issues
when Cisco Crosswork
and Crosswork Data
Gateway try to
communicate with each
other. If you are not using
an NTP server, ensure that
time gap between
Crosswork Data Gateway
and Crosswork is not
more than 10 minutes.
Else, Crosswork Data
Gateway fails to connect.

Space-delimited list of
IPv4, IPv6 addresses, or
hostnames of the NTPv4
servers accessible in the
management interface.

NTPNTPv4 Servers*
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Select True to use NTPv4
authentication.

The default value is
False.

NTPAuthNTPv4 Authentication

Key IDs to map to the
server list. Enter
space-delimited list of
Key IDs.

NTPKeyNTPv4 Keys

SCP URI to the chrony
key file.

NTPKeyFileNTPv4 Key File URI

Password of SCP URI to
the chrony key file.

NTPKeyFilePwdNTPv4 Key File
Passphrase

Remote Syslog Server
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Configuring an external
syslog server sends
service events
(CLI/MDT/SNMP/gNMI)
to the external syslog
server. Otherwise, they
are logged only to the
Cisco Crosswork Data
Gateway VM.

If you want to use an
external syslog server,
specify the following
settings:

• Use Remote Syslog
Server

• Syslog Server
Address

• Syslog Server Port

• Syslog Server
Protocol

Options are True and
False. Select True to send
Syslog messages to a
remote host.

The default value is
False.

UseRemoteSyslogRemote Syslog Server*

Hostname, IPv4, or IPv6
address of a syslog server
accessible in the
management interface.

SyslogAddressSyslog Server Addresses

Port number of the syslog
server.

The default port number
is 514.

SyslogPortSyslog Server Port

Options are UDP, RELP, or
TCP to send the syslog.

The default value is UDP.

SyslogProtocolSyslog Server Protocol

Multiple servers in the
failover or simultaneous
mode. This parameter is
applicable only when the
protocol is set to a
non-UDP value. UDP
must use the simultaneous
mode.

Options are Simultaneous
or Failover.

The default value is
Simultaneous.

SyslogMultiserverModeSyslog Multiserver Mode

Select True to use TLS to
encrypt syslog traffic.

The default value is
False.

SyslogTLSSyslog over TLS

Syslog server hostname
exactly as entered in the
server certificate
SubjectAltName or
subject common name.

SyslogPeerNameSyslog TLS Peer Name

SyslogCertChainSyslog Root Certificate
File URI
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PEM formatted root cert
of syslog server retrieved
using SCP.

The host with the URI
files must be reachable on
the network (from vNIC0
interface via SCP) and
files must be present at the
time of install.

Password of SCP user to
retrieve Syslog certificate
chain.

SyslogCertChainPwdSyslog Certificate File
Passphrase

Remote Auditd Server

If desired, you can
configure an external
Auditd server. Cisco
Crosswork Data Gateway
sends audit notifications
to the Auditd server when
configured and present on
the network.

Specify these three
settings to use an external
Auditd server.

Options are True and
False. The default value
is False.Select True to
send auditd messages to a
remote host.

UseRemoteAuditdRemote auditd Server*

Hostname, IPv4, or IPv6
address of an optional
Auditd server.

AuditdAddressAuditd Server Address

Port number of an
optional Auditd server.

The default port is 60.

AuditdPortAuditd Server Port

Controller and Proxy Settings

This is required so that the
Crosswork Data Gateway
can enroll with the
Crosswork server during
the installation and initial
start up. Excluding this
step will require you to
manually ingest the
certificate. For more
information, see Import
Controller Signing
Certificate File, on page
117.

The Virtual IP address or
the host name of Cisco
Crosswork Cluster.

If you are
using an
IPv6
address, it
must be
surrounded
by square
brackets
([1::1]).

Note

ControllerIPCrosswork Controller IP*

Port of the Cisco
Crosswork controller.

The default port is 30607.

ControllerPortCrosswork Controller
Port*
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Crosswork Data Gateway
requires the Controller
Signing Certificate File to
enroll automatically with
Cisco Crosswork.

If you specify these
parameters during the
installation, the certificate
file is imported once
Crosswork Data Gateway
boots up for the first time.

If you do not specify these
parameters during
installation, then import
the certificate file
manually by following the
procedure Import
Controller Signing
Certificate File, on page
117.

PEM formatted root cert
of Cisco Crosswork to
validate signing certs
retrieved using SCP.
Cisco Crosswork
generates the PEM file
and is available at the
following location:
cw-admin@<Crosswork_VM_

Management_VIP_Address>:/home/cw-admin/controller.pem

ControllerSignCertChainController Signing
Certificate File URI*

Cisco Crosswork
Controller PEM formatted
SSL/TLS certificate file
retrieved using SCP.

ControllerTlsCertChainController SSL/TLS
Certificate File URI

Password of SCP user
(cw-admin) to retrieve
Cisco Crosswork
certificate chain.

ControllerCertChainPwdController Certificate File
Passphrase*
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The proxy parameters
apply to the Crosswork
Data Gateway cloud
deployment.

Crosswork Data Gateway
must connect to the
Internet via TLS, and a
proxy server may be
required if it is not present
in your environment.

If you want to use a proxy
server, specify these
parameters.

URL of the HTTP proxy
server.

ProxyURLProxy Server URL

Comma-delimited list of
addresses and hostnames
that will not use the proxy
server.

ProxyBypassProxy Server Bypass List

Username for
authenticated proxy
servers.

ProxyUsernameAuthenticated Proxy
Username

Passphrase for
authenticated proxy
servers.

ProxyPassphraseAuthenticated Proxy
Passphrase

HTTPS proxy PEM
formatted SSL/TLS
certificate file retrieved
using SCP.

ProxyCertChainHTTPS Proxy SSL/TLS
Certificate File URI

Password of SCP user to
retrieve proxy certificate
chain.

ProxyCertChainPwdHTTPS Proxy SSL/TLS
Certificate File Passphrase

Geo Redundancy Settings

The physical location of
Availability Zone 1 and 2.

az_idAvailability Zone ID

The physical location of
the Crosswork Data
Gateway VM.

region_idRegion ID

The location of the
primary and second
Crosswork sites.

During enrollment,
Crosswork sends this
value to cdg-manager to
preset the cluster
affiliation of the instance.

site_locationSite location*

Install Cisco Crosswork Data Gateway using vCenter vSphere Client
Follow these steps to install Cisco Crosswork Data Gateway using vCenter vSphere Client:
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We have included sample images of Cisco Crosswork Data Gateway on-premise Standard deployment in the
procedure.

Values that are not explicitly mentioned in this section but are required to align with your environment should
be retained at their default values.

Note

Before you begin

The default VMware vCenter deployment timeout is 15 minutes. If the time taken to fill the OVF template
exceeds 15 minutes, vCenter times out and you have to start over again. To prevent this, it is recommended
that you plan for the installation by having the necessary parameters and requirements ready. Refer to the
Table 25: Cisco Crosswork Data Gateway Deployment Parameters and Scenarios, on page 81 for list of
mandatory and optional parameters.

Warning

Step 1 Download the Crosswork Data Gateway UEFI OVA (For use with Cisco Crosswork Network Controller deployment)
image file from cisco.com (*.ova).

Step 2 Connect to vCenter vSphere Client and select Actions > Deploy OVF Template.
Step 3 The VMware Deploy OVF Template wizard appears and highlights the first step, 1 Select template.

a) Click Browse to navigate to the location where you downloaded the OVA image file and select it.

Once selected, the file name is displayed in the window.

Cisco Crosswork Network Controller 6.0 Installation Guide
94

Install Cisco Crosswork Network Controller on VMware vCenter
Install Cisco Crosswork Data Gateway using vCenter vSphere Client

https://software.cisco.com/download/home


Figure 11: Deploy OVF Template - Select an OVF Template Window

Step 4 Click Next to go to 2 Select a name and folder, as shown in the following figure.
a) Enter a unique name for the VM that you are creating.
b) In the Select a location for the virtual machine list, choose the data center under which the VM resides.
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Figure 12: Deploy OVF Template - Name and Folder Selection Window

Step 5 Click Next to go to 3 Select a computer resource. Choose the VM’s host or cluster.
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Figure 13: Deploy OVF Template - Select a computer resource Window

Step 6 Click Next. The VMware vCenter Server validates the OVA. Network speed determines how long validation takes.
When the validation is complete, the wizard moves to 4 Review details.

Take a moment to review the OVF template to make sure it matches the version you want to install and click Next.

This information is gathered from the OVF and cannot be modified.Note

Figure 14: Deploy OVF Template - Review details Window
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Step 7 Click Next to go to 5 License agreements. Review the end-user license agreement, and then click Accept if you agree
with the conditions. Contact your Cisco representative, if you do not agree with the conditions.

Step 8 Click Next to go to 6 Configuration, as shown in the following figure. Select Crosswork On-Premise Standard or
Crosswork On-Premise Extended. See Selecting the Crosswork Data Gateway Deployment Type, on page 28 for
more information.

Figure 15: Deploy OVF Template - Configuration Window

Crosswork supports Crosswork On-Premise Standard and Crosswork On-Premise Extended deployment
configuration for on-premises environment.

Step 9 Click Next to go to 7 Select storage, as shown in the following figure.
a) Cisco recommends that you select Thick provision lazy zeroed from the Select virtual disk format drop-down

list.
b) From theDatastores table, choose the data store you want to use and review its properties to ensure there is enough

available storage. For Crosswork On-Premise Standard deployment, the storage requirement is 70 GB and for
Crosswork On-Premise Extended, it is 570 GB.
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Figure 16: Deploy OVF Template - Select storage Window

Step 10 Click Next to go to 8 Select networks, as shown in the following figure. From the drop-down, select the network for
each vNIC you plan to use. Unused vNIC may remain configured with the default value. For example,

• 1 NIC: Select the appropriate Destination Network for vNIC0.

• 2 NIC: Select the appropriate Destination Network for vNIC0 and vNIC1.

• 3 NIC: Select the appropriate Destination Network for vNIC0, vNIC1, and vNIC2.

A single NIC can only be utilized if the Crosswork Cluster uses a single NIC.Note
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Figure 17: Deploy OVF Template - Select networks Window

Crosswork does not support the vNIC3 network. Cisco recommends that you do not change the default network settings.

Step 11 Click Next to go to 9 Customize template, with the Host information already expanded. Enter the information for
the parameters as explained in Table 25: Cisco Crosswork Data Gateway Deployment Parameters and Scenarios, on
page 81.

For larger systems, it is likely that you have more than one Cisco Crosswork Data Gateway VMs. The
Cisco Crosswork Data Gateway hostname should, therefore, be unique and created in a way that makes
identifying a specific VM easy.

Note

Depending on the NIC deployment, note the following:

• For 1 NIC deployment, configure IP, subnet, and gateway values for only vNIC0. After the Crosswork Data
Gateway pool is created, the VIP address is assigned as a secondary address on vNIC0.

• For 2 NIC deployments, configure the IP, subnet, and gateway values for vNIC0 and vNIC1. After the Crosswork
Data Gateway pool is created, the VIP address is assigned as a secondary address on vNIC1.

• For the 3 NIC deployments, configure the IP, subnet, and gateway values for vNIC0 and vNIC1. After the Crosswork
Data Gateway pool is created, the VIP address is assigned to vNIC2 after Crosswork Data Gateway is added to a
pool.
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Values that were not described in detail in Cisco Crosswork Data Gateway Parameters and Deployment
Scenarios, on page 80 which are not further explained in this section should be left at their default value.

Note

Figure 18: Deploy OVF Template - Customize template > Host information Window

For creating pools in the VMware environment, select L2 and specify IP addresses for creating the HA pool.

Figure 19: Deploy OVF Template - Customize template > Host information Window > High Availability Network Mode

a. Configure the vNIC Role Assignment based on the number of NICs that you have decided to use.
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Based on the number of NICs, refer to the following to use the customized template configuration:

The default configuration is for 3 NICs deployment.Note

• See Deploy OVF Template - Customize Template for 1 vNIC deployment.

• See Deploy OVF Template - Customize Template for 2 vNICs deployment.

• See Deploy OVF Template - Customize Template for 3 vNICs deployment.

Figure 20: Deploy OVF Template - Customize Template for 1 vNIC deployment

Figure 21: Deploy OVF Template - Customize Template for 2 vNICs deployment

For 3 vNIC deployments, you can leave the settings with the default values.
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Figure 22: Deploy OVF Template - Customize Template for 3 vNICs deployment

The VMware vCenter Server 6.5 and 6.7 has an issue with expanding the correct parameters. To override
this issue, when deploying the OVF template, in theDeploy OVF Templatewizard >Customize Template
page, configure the following:

• In the 16. Controller Setting > a. Crosswork Controller IP section, enter the IPv4 or IPv6 address
of the cluster or the DNS host name assigned to the cluster in your DNS server configuration.

• In the 16. Controller Setting > b. Crosswork Controller Port section, set the port number to 30607.

Attention

Figure 23: Deploy OVF Template - Customize Template > Controller Settings
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Step 12 Click Next to go to 10 Ready to complete. Review your settings and then click Finish.

Figure 24: Deploy OVF Template - Ready to Complete Window

Step 13 Once the deployment status is 100%, power on the VM to complete the deployment process. Expand the host’s entry
so you can click the VM and then choose Actions > Power > Power On, as shown in the following figure:

Figure 25: Power On Action

Wait for at least 5 minutes for the VM to come up and then log in via vCenter or SSH as explained below.

Changing the VM's network settings in vCenter may have significant unintended consequences, including
but not limited to the loss of static routes and connectivity. The settings have been validated to provide the
best network performance. Make changes to these settings at your own risk.

Warning
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What to do next

After you log in, the Crosswork Data Gateway should present you with the welcome screen and options menu
indicating that the installation completed successfully. For information on how to log in, see Log in and Log
out of Crosswork Data Gateway VM, on page 110.

Log out and proceed with the postinstallation tasks documented in Cisco Crosswork Network Controller 6.0
Administration Guide.

Return to the installation workflow: Install Cisco Crosswork Network Controller on VMware vCenter, on
page 11

Install Cisco Crosswork Data Gateway via OVF Tool
You must modify the list of mandatory and optional parameters in the script as per your requirements and run
the OVF Tool. Refer to Table 25: Cisco Crosswork Data Gateway Deployment Parameters and Scenarios, on
page 81 for the list of installation parameters and their default values.

The file namesmentioned in this topic are sample names andmay differ from the actual file names on cisco.com.Note

Follow these steps to log in to the Cisco Crosswork Data Gateway VM from SSH:

Before you begin

• In your vCenter data center, go to Host > Configure > Networking > Virtual Switches and select the
virtual switch.

• In the virtual switch, select Edit > Security, and ensure that the following DVS port group properties
are as shown:

• Set Promiscuous mode as Reject

• Set MAC address changes as Reject

Confirm the settings and repeat the process for each virtual switch used by Crosswork Data Gateway.

Step 1 On the machine where you have the OVFtool installed, use the following command to confirm that you have OVFtool
version 4.4:
ovftTool --version

Step 2 Download the OVA and the sample script files from cisco.com. For these instructions, we use the file name as
signed-cw-na-dg-6.0.0-114-release-20231211.uefi.ova and signed-cw-na-dg-6.0.0-114-release-20231211.uefi.tar.gz.

Step 3 Use the following command to extract the files from the tar bundle:
tar -xvzf cw-na-dg-6.0.0-sample-install-scripts.tar.gz

The file bundle is extracted. It includes the DG-sample-install-scripts.tar file and scripts for validating the samples
install scripts.

Step 4 Use the following command to extract the install scripts from the tar bundle:
tar -xvzf DG-sample-install-scripts.tar.gz
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Step 5 Review the contents of the README file to understand the components that are in the package and how they are validated.
Step 6 Choose the sample script that corresponds to the deployment you plan to use. Cisco provides sample scripts for 1, 2, and

3 vNIC deployments, which you may optimize to meet your needs.

Sample scripts for 3 vNIC deployments. Customize the script for the type of deployment you have planned. For more
information, see Sample Script for CrossworkData Gateway IPv4Deployment, on page 106 or Sample Script for Crosswork
Data Gateway IPv6 Deployment, on page 108.

Step 7 Use the following command to make the script executable:
chmod +x {filename}

Step 8 Use the following command to execute the script from the directory where the OVA and script files are stored:
./{script name} {path and ova file name}

For example:
./<script name> <Absolute path to signed-cw-na-dg-6.0.0-114-release-20231211.uefi.ova>

Step 9 If the values provided in the script are valid, provide the vCenter user’s password when you are prompted.

If the script fails due to invalid values, a message like the following is displayed:
admin@nso-576-tsdn-410-aio:~/CDG_Install$ ./three-nic
/home/admin/CDG_Install/signed-cw-na-dg-6.0.0-114-release-20231211.uefi.ova
Opening OVA source: /home/admin/CDG_Install/signed-cw-na-dg-6.0.0-114-release-20231211.uefi.ova
The manifest does not validate
Warning:
- Line -1: Unsupported value 'firmware' for attribute 'key' on element 'ExtraConfig'.
- Line -1: Unsupported value 'uefi.secureBoot.enabled' for attribute 'key' on element 'ExtraConfig'.
Enter login information for target vi://rcdn5-spm-vc-01.cisco.com/
Username: johndoe
Password: ******

After entering the password, monitor the screen or the vCenter console to review the installation progress. For example,
Opening VI target: vi://johndoe@rcdn5-spm-vc-01.cisco.com:443/Cisco-sample-sample/host/10.10.100.10
Warning:
- Line 146: Unable to parse 'enableMPTSupport' for attribute 'key' on element 'Config'.
- Line 229: Unable to parse 'vmxnet3.noOprom' for attribute 'key' on element 'Config'.
Deploying to VI: vi://johndoe@rcdn5-spm-vc-01.cisco.com:443/Cisco-sample-sample/host/10.10.100.10
Disk progress: 65%

When the installation is complete, the Crosswork Data Gateway VM is powered on, is automatically configured based
on the settings that you have provided in the script, and registers with the Crosswork cluster.

What to do next

Log in to the VM. For more information, see Log in and Log out of Crosswork Data Gateway VM, on page
110. After you log in, the Crosswork Data Gateway should present you with the welcome screen, and options
menu indicating that the installation is complete. Log out and proceed with the postinstallation tasks explained
in Crosswork Data Gateway Post-installation Tasks, on page 112.

Sample Script for Crosswork Data Gateway IPv4 Deployment
The following example deploys a Crosswork Data Gateway with IPv4 addresses.
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Before running the scripts, ensure that the OVFtool version is 4.4.x.Note

#!/usr/bin/env bash
DM="<thin/thick>"
Disclaimer="<Disclaimer>"
DNSv4="<DNS Server>"
NTP="<NTP Server>"
Domain="<Domain>"
Hostname="<CDG hostname>"

VM_NAME="<VM name on vcenter>"
DeploymentOption="<onpremise-standard/onpremise-extended>"
DS="<Datastore>"
Host="<ESXi host>"
ManagementNetwork="<vSwitch/dvSwitch>"
DataNetwork="<vSwitch/dvSwitch>"
DeviceNetwork="<vSwitch/dvSwitch>"
ManagementIPv4Address="<CDG managment IP>"
ManagementIPv4Netmask="<CDG managment mask>"
ManagementIPv4Gateway="<CDG managment gateway>"
DataIPv4Address="<CDG Data network IP>"
DataIPv4Netmask="<CDG Data network mask>"
DataIPv4Gateway="<CDG Data network gateway>"
dgadminpwd="<CDG password for dg-admin user>"
dgoperpwd="<CDG password for dg-admin user>"
ControllerIP="<CNC Managment VIP>"
ControllerPassword="<CNC Password>"
ControllerPort="30607"

ROBOT_OVA_PATH=$1

VCENTER_LOGIN="Administrator%40vsphere.local@<vCenter-IP>"
VCENTER_PATH="<vCenter-DC-NAME>/host"

ovftool --acceptAllEulas --skipManifestCheck --X:injectOvfEnv -ds=$DS --diskMode=$DM
--overwrite --powerOffTarget --powerOn --noSSLVerify \
--allowExtraConfig \
--name=$VM_NAME \
--deploymentOption=${DeploymentOption} \
--net:"vNIC0=${ManagementNetwork}" \
--prop:"ControllerIP=${ControllerIP}" \
--prop:"ControllerPort=${ControllerPort}" \
--prop:"ControllerSignCertChain=cw-admin@${ControllerIP}:/home/cw-admin/controller.pem" \
--prop:"ControllerCertChainPwd=${ControllerPassword}" \
--prop:"Hostname=${Hostname}" \
--prop:"Description=${Disclaimer}" \
--prop:"DNS=${DNSv4}" \
--prop:"NTP=${NTP}" \
--prop:"Domain=${Domain}" \
--prop:"Vnic0IPv4Method=Static" \
--prop:"Vnic0IPv4Address=${ManagementIPv4Address}" \
--prop:"Vnic0IPv4Gateway=${ManagementIPv4Gateway}" \
--prop:"Vnic0IPv4Netmask=${ManagementIPv4Netmask}" \
--prop:"NicDefaultGateway=eth0" \
--prop:"NicAdministration=eth0" \
--prop:"NicExternalLogging=eth0" \
--prop:"NicManagement=eth0" \
--prop:"NicControl=eth0" \
--prop:"NicNBExternalData=eth0" \
--prop:"NicSBData=eth0" \
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--prop:"dg-adminPassword=${dgadminpwd}" \
--prop:"dg-operPassword=${dgoperpwd}" \
$ROBOT_OVA_PATH \
vi://$VCENTER_LOGIN/$VCENTER_PATH/$Host

#############################################################
Append section below for Two NIC deployment
#############################################################
#--net:"vNIC1=${DataNetwork}" \
#--prop:"Vnic1IPv4Method=Static" \
#--prop:"Vnic1IPv4Address=${DataIPv4Address}" \
#--prop:"Vnic1IPv4Gateway=${DataIPv4Gateway}" \
#--prop:"Vnic1IPv4Netmask=${DataIPv4Netmask}" \
#--prop:"NicDefaultGateway=eth0" \
#--prop:"NicAdministration=eth0" \
#--prop:"NicExternalLogging=eth0" \
#--prop:"NicManagement=eth0" \
#--prop:"NicControl=eth1" \
#--prop:"NicNBExternalData=eth1" \
#--prop:"NicSBData=eth1" \

#############################################################
Append section below for three NIC deployment
#############################################################
#--net:"vNIC1=${DataNetwork}" \
#--net:"vNIC2=${DeviceNetwork}" \
#--prop:"Vnic1IPv4Method=Static" \
#--prop:"Vnic2IPv4Method=Static" \
#--prop:"Vnic1IPv4Address=${DataIPv4Address}" \
#--prop:"Vnic1IPv4Gateway=${DataIPv4Gateway}" \
#--prop:"Vnic1IPv4Netmask=${DataIPv4Netmask}" \
#--prop:"NicDefaultGateway=eth0" \
#--prop:"NicAdministration=eth0" \
#--prop:"NicExternalLogging=eth0" \
#--prop:"NicManagement=eth0" \
#--prop:"NicControl=eth1" \
#--prop:"NicNBExternalData=eth1" \
#--prop:"NicSBData=eth2" \

Sample Script for Crosswork Data Gateway IPv6 Deployment
The following example deploys a Crosswork Data Gateway with IPv6 addresses.

Before running the scripts, ensure that the OVFtool version is 4.4.x.Note

#!/usr/bin/env bash
DM="<thin/thick>"
Disclaimer="<Disclaimer>"
DNSv4="<DNS Server>"
NTP="<NTP Server>"
Domain="<Domain>"
Hostname="<CDG hostname>"

VM_NAME="<VM name on vcenter>"
DeploymentOption="<onpremise-standard/onpremise-extended>"
DS="<Datastore>"
Host="<ESXi host>"
ManagementNetwork="<vSwitch/dvSwitch>"
DataNetwork="<vSwitch/dvSwitch>"
DeviceNetwork="<vSwitch/dvSwitch>"
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ManagementIPv6Address="<CDG managment IP>"
ManagementIPv6Netmask="<CDG managment mask>"
ManagementIPv6Gateway="<CDG managment gateway>"
DataIPv6Address="<CDG Data network IP>"
DataIPv6Netmask="<CDG Data network mask>"
DataIPv6Gateway="<CDG Data network gateway>"
dgadminpwd="<CDG password for dg-admin user>"
dgoperpwd="<CDG password for dg-admin user>"
ControllerIP="<CNC Managment VIP>"
ControllerPassword="<CNC Password>"
ControllerPort="30607"

ROBOT_OVA_PATH=$1

VCENTER_LOGIN="Administrator%40vsphere.local@<vCenter-IP>"
VCENTER_PATH="<vCenter-DC-NAME>/host"

ovftool --acceptAllEulas --skipManifestCheck --X:injectOvfEnv -ds=$DS --diskMode=$DM
--overwrite --powerOffTarget --powerOn --noSSLVerify \
--allowExtraConfig \
--name=$VM_NAME \
--deploymentOption=${DeploymentOption} \
--net:"vNIC0=${ManagementNetwork}" \
--prop:"ControllerIP=${ControllerIP}" \
--prop:"ControllerPort=${ControllerPort}" \
--prop:"ControllerSignCertChain=cw-admin@${ControllerIP}:/home/cw-admin/controller.pem" \
--prop:"ControllerCertChainPwd=${ControllerPassword}" \
--prop:"Hostname=${Hostname}" \
--prop:"Description=${Disclaimer}" \
--prop:"DNS=${DNSv4}" \
--prop:"NTP=${NTP}" \
--prop:"Domain=${Domain}" \
--prop:"Vnic0IPv6Method=Static" \
--prop:"Vnic0IPv6Address=${ManagementIPv6Address}" \
--prop:"Vnic0IPv6Gateway=${ManagementIPv6Gateway}" \
--prop:"Vnic0IPv6Netmask=${ManagementIPv6Netmask}" \
--prop:"NicDefaultGateway=eth0" \
--prop:"NicAdministration=eth0" \
--prop:"NicExternalLogging=eth0" \
--prop:"NicManagement=eth0" \
--prop:"NicControl=eth0" \
--prop:"NicNBExternalData=eth0" \
--prop:"NicSBData=eth0" \
--prop:"dg-adminPassword=${dgadminpwd}" \
--prop:"dg-operPassword=${dgoperpwd}" \
$ROBOT_OVA_PATH \
vi://$VCENTER_LOGIN/$VCENTER_PATH/$Host

#############################################################
Append section below for Two NIC deployment
#############################################################
#--net:"vNIC1=${DataNetwork}" \
#--prop:"Vnic1IPv6Method=Static" \
#--prop:"Vnic1IPv6Address=${DataIPv6Address}" \
#--prop:"Vnic1IPv6Gateway=${DataIPv6Gateway}" \
#--prop:"Vnic1IPv6Netmask=${DataIPv6Netmask}" \
#--prop:"NicDefaultGateway=eth0" \
#--prop:"NicAdministration=eth0" \
#--prop:"NicExternalLogging=eth0" \
#--prop:"NicManagement=eth0" \
#--prop:"NicControl=eth1" \
#--prop:"NicNBExternalData=eth1" \
#--prop:"NicSBData=eth1" \
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#############################################################
Append section below for three NIC deployment
#############################################################
#--net:"vNIC1=${DataNetwork}" \
#--net:"vNIC2=${DeviceNetwork}" \
#--prop:"Vnic1IPv6Method=Static" \
#--prop:"Vnic1IPv6Address=${DataIPv6Address}" \
#--prop:"Vnic1IPv6Gateway=${DataIPv6Gateway}" \
#--prop:"Vnic1IPv6Netmask=${DataIPv6Netmask}" \
#--prop:"NicDefaultGateway=eth0" \
#--prop:"NicAdministration=eth0" \
#--prop:"NicExternalLogging=eth0" \
#--prop:"NicManagement=eth0" \
#--prop:"NicControl=eth1" \
#--prop:"NicNBExternalData=eth1" \
#--prop:"NicSBData=eth2" \

Log in and Log out of Crosswork Data Gateway VM
You can log in to the Crosswork Data Gateway VM in one of the following ways:

• Access Crosswork Data Gateway VM from SSH, on page 110

• Access Crosswork Data Gateway through vCenter, on page 111

To log out of the Crosswork Data Gateway VM, see Log Out of Crosswork Data Gateway VM, on page 111.

Access Crosswork Data Gateway VM from SSH
The SSH process is protected from brute force attacks by blocking the client IP after a number of login failures.
Failures such as incorrect username or password, connection disconnect, or algorithm mismatch are counted
against the IP. Up to 4 failures within a 20 minute window causes the client IP to be blocked for at least 7
minutes. Continuing to accumulate failures cause the blocked time to be increased. Each client IP is tracked
separately.

Follow these steps to log in to the Cisco Crosswork Data Gateway VM from SSH:

Step 1 From your work station with network access to the Cisco Crosswork Data Gateway management IP, run the following
command:

ssh <username>@<ManagementNetworkIP>

where ManagementNetworkIP is the management network IP address.

For example,

To login as administrator user: ssh dg-admin@<ManagementNetworkIP>

To login as operator user: ssh dg-oper@<ManagementNetworkIP>

Step 2 Provide the corresponding password, which was created during installation process, and press Enter.

The Crosswork Data Gateway flash screen opens prompting for password.
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Figure 26: Crosswork screen

If you are unable to access the Cisco Crosswork Data Gateway VM, there is an issue with your network
configuration settings. From the console, check the network settings. If they are incorrect, it is best to delete
the Cisco Crosswork Data Gateway VM and reinstall with the correct network settings.

Access Crosswork Data Gateway through vCenter
Follow these steps to log in via vCenter:

Step 1 Locate the VM in vCenter and then right-click and select Open Console.

The Crosswork Data Gateway console comes up.

Step 2 Enter username (dg-admin or dg-oper as per the role assigned to you) and the corresponding password (the one that you
created during the installation process) and press Enter.

The Crosswork Data Gateway flash screen opens prompting for password.

Figure 27: Crosswork screen

Log Out of Crosswork Data Gateway VM
To log out, select option l Logout from the Main Menu and press Enter or click OK.
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Cisco Crosswork Data Gateway Authentication and Enrollment
Once the Crosswork Data Gateway is installed, it identifies itself and enrolls with Cisco Crosswork
automatically. Cisco Crosswork then instantiates a new Crosswork Data Gateway instance in its database and
waits for a "first-sign-of-life" from the Crosswork Data Gateway VM.

After the connectivity is established, the Crosswork Data Gateway instance confirms the identity of the
controller application (Cisco Crosswork) and offers its own proof of identity via signed certificates. Cisco
Crosswork Data Gateway then downloads the configuration files and functional images (collection profiles)
from Cisco Crosswork.

To verify if the Crosswork Data Gateway VM has enrolled successfully with Cisco Crosswork:

1. Log in to the Cisco Crosswork UI. See Log into the Cisco Crosswork UI, on page 71.

2. Navigate to Administration > Data Gateway Management.

3. Click on the Data Gateway Instances tab.

All the Cisco Crosswork Data Gateway VMs that have successfully enrolled with Cisco Crosswork are
displayed here.

The initial Operational State of Crosswork Data Gateway VMs is Unknown. During the handshake and
image download, the status is Degraded. After the handshake is complete, the status is Not Ready. While it
depends on the bandwidth between the Crosswork Data Gateway VMs and Cisco Crosswork, this operation
typically takes between 5 to 10 minutes. If it takes longer than the stipulated duration, contact Cisco Customer
Experience team for assistance.

For information about the different operational states of the VMs, see the Overview of Cisco Crosswork Data
Gateway section in Cisco Crosswork Network Controller 6.0 Administration Guide.

Crosswork Data Gateway VMs that have the Role as Unassigned must be assigned to a pool before they can
be used. A Cisco Crosswork Data Gateway VM is your physical Crosswork Data Gateway. You cannot attach
or detach devices to it. Devices can be attached only to a Cisco Crosswork Data Gateway pool.

Note

What to do next:

Return to the installation workflow: Install Cisco Crosswork Network Controller on VMware vCenter, on
page 11

Crosswork Data Gateway Post-installation Tasks
After installing Cisco Crosswork Data Gateway, configure the timezone of the Crosswork Data Gateway VM.

• Configure Timezone of the Crosswork Data Gateway VM, on page 113

What to do next:

Return to the installation workflow: Install Cisco Crosswork Network Controller on VMware vCenter, on
page 11
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Configure Timezone of the Crosswork Data Gateway VM
The Crosswork Data Gateway VM first launches with default timezone as UTC. Update the timezone with
your geographical area so that all Crosswork Data Gateway processes (including the showtech logs) reflect
the timestamp corresponding to the location you have chosen.

Step 1 Log in to the Crosswork Data Gateway VM.
Step 2 In the Crosswork Data Gateway VM interactive menu, select 3 Change Current System Settings.
Step 3 From the menu, select 9 Timezone.
Step 4 Select the geographic area in which you live.

Figure 28: Timezone Settings - Geographic Area Selection

Step 5 Select the city or region corresponding to your timezone.
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Figure 29: Timezone Settings - Region Selection

Step 6 Select OK to save the settings.
Step 7 Reboot the Crosswork Data Gateway VM so that all processes pick up the new timezone. See Reboot Crosswork Data

Gateway VM section in Cisco Crosswork Network Controller 6.0 Administration Guide.
Step 8 Log out of the Crosswork Data Gateway VM.

Troubleshoot Crosswork Data Gateway Installation and
Enrollment

If Crosswork Data Gateway fails to auto-enroll with Cisco Crosswork, you can collect Crosswork Data
Gateway show-tech (Main menu > 5 Troubleshooting > 2 Run show-tech) and check for the reason in
controller-gateway logs.

For more information on how to collect show-tech logs, see the Collect show-tech logs from the Interactive
Console section in Cisco Crosswork Network Controller 6.0 Administration Guide. If there are session
establishment or certificate-related issues, ensure that the controller.pem certificate is uploaded using the
Interactive Console.

When using an IPv6 address, it must be surrounded by square brackets ([1::1]).Important

The following table lists common problems that might be experienced while installing or enrolling Crosswork
Data Gateway, and provides approaches to identifying the source of the problem and solving it.
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Table 26: Troubleshooting the Installation/Enrollment

ActionIssue

1. Log in to the Crosswork Data Gateway VM.

2. From the main menu, select 5 Troubleshooting >
2 Run show-tech.

Enter the destination to save the tarball containing
logs and vitals and click OK.

The show-tech is now encrypted with a file extension
ending with .tar.xz.

3. Run the following command to decrypt the
show-tech file.

openssl enc -d -AES-256-CBC -pbkdf2 -md

sha512 -iter 100000 -in <showtech file> -out

<decrypted filename> -pass pass:<encrypt

string>

In the show-tech logs (in file session.log at location
/opt/dg/log/controller-gateway/session.log),
if you see the error UNAUTHENTICATED:invalid
certificate. reason: x509: certificate has

expired or is not yet valid, then there is a
clock-drift between Crosswork Data Gateway and
Cisco Crosswork.

3. From the main menu, go to 3 Change Current
System Settings > 1 Configure NTP.

Configure NTP to sync with the clock time on the
Cisco Crosswork server and try reenrolling Crosswork
Data Gateway.

Crosswork Data Gateway cannot be enrolled with
Cisco Crosswork due to an NTP issue, i.e., there
is a clock-drift between the two.

The clock-drift might be with either Crosswork
Data Gateway or Cisco Crosswork.

Also, on the NTP servers for Cisco Crosswork and
Crosswork Data Gateway, the initial time is set to
the ESXi server. For this reason, the ESXi server
must also have NTP configured.

Sync the clock time on the host and retry.
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ActionIssue

1. Log in to the Crosswork Data Gateway VM.

2. From the main menu, select 5 Troubleshooting >
2 Run show-tech.

Enter the destination to save the tarball containing
logs and vitals and click OK.

The show-tech is now encrypted with a file extension
ending with .tar.xz.

3. Run the following command to decrypt the
show-tech file.

openssl enc -d -AES-256-CBC -pbkdf2 -md

sha512 -iter 100000 -in <showtech file> -out

<decrypted filename> -pass pass:<encrypt

string>

In the show-tech logs (in file gateway.log at location
/opt/dg/log/controller-gateway/gateway.log),
if you see certificate errors, then reupload the
Controller Signing Certificate, as explained in the
steps below:

1. From the main menu, select 3 Change Current
System Settings > 7 Import Certificate.

2. From the Import Certificates menu, select 1
Controller Signing Certificate File and click OK.

3. Enter the SCP URI for the certificate file and click
OK.

Crosswork Data Gateway remains in degraded
state for more than 10 minutes with reason stated
as "Could not collect vitals" due to certificate
errors.

1. Reupload the certificate file using the following
steps:

a. From the main menu, select 3 Change Current
System Settings > 7 Import Certificate.

b. From the Import Certificates menu, select 1
Controller Signing Certificate File and click OK.

c. Enter the SCP URI for the certificate file and click
OK.

2. Reboot the CrossworkData GatewayVM following
the steps below:

a. From the main menu, select 5 Troubleshooting
and click OK.

b. From the Troubleshooting menu, select 4 Reboot
VM and click OK.

c. Once the reboot is complete, check if the Crosswork
Data Gateway's operational status is Up.

Crosswork Data Gateway remains in degraded
state for more than 10 minutes with reason stated
as "gRPC connection cannot be established" due
to certificate errors.
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ActionIssue

Check the vNIC values in the OVF template in case
of vCenter.

Crosswork Data Gateway goes into Error state

Check the vNIC values in the OVF template in case
of vCenter. If ActiveVnics property is missing for 1
NIC and 2 NIC, Crosswork Data Gateway tries to
deploy 3 NICs by default.

Due to this, Crosswork Data Gateway enrollment with
1 NIC Cisco Crosswork fails post deployment with
error in gateway.log that Crosswork Data Gateway
expected 1 NIC, but it is not 1 NIC.

Crosswork Data Gateway enrollment with 1 NIC
Cisco Crosswork fails

Check the Deployment parameter in the OVF template
in case of vCenter. If Deployment parameter
mismatches or does not exist for an Extended profile,
then Crosswork Data Gateway deploys the Standard
profile by default.

Crosswork Data Gateway deploys Standard profile
instead of Extended profile

Reenroll or redeploy the Crosswork Data Gateways.
For more information, see the Redeploy a Crosswork
Data Gateway Instance and Reenroll Crosswork Data
Gateway sections in Cisco Crosswork Network
Controller 6.0 Administration Guide.

During a Crosswork upgrade, some of the
Crosswork Data Gateways may not get upgraded
or reenrolled leading to logging multiple error
messages in the dg-manager logs.

1. Log in to the Crosswork UI from the SSH.

2. Run the Docker executive commands to access the
robot-astack-influxdb pod.

3. In the pod, navigate to the following directory and
delete it:

/mnt/datafs/influxdb

4. Restart the service using the following command:

supervisorctl restart all

If a Crosswork Data Gateway instance that was
previously attached to Crosswork is now
reattached to a different Crosswork version 4.x or
5.0, the operational state of the instance may be
Degraded with the robot-astack-influxdb error.

Move the Data Gateway to the Maintenance mode
or manually reenroll the gateway. For more
information, see the Reenroll Crosswork Data
Gateway section in Cisco Crosswork Network
Controller 6.0 Administration Guide.

If Data Gateway is redeployed without moving the
gateway to the Maintenance mode, Crosswork
enrollment will be unsuccessful and errors will be
logged in the dg-manager and controller-gateway
logs.

Import Controller Signing Certificate File
The Controller Certificate file is automatically imported after the VM boots. If there is an import failure, the
Crosswork Data Gateway VM makes several attempts to import the certificate while giving you the option
to manually import it.

• You have not specified the Controller Signing Certificate File URI under the Controller Settings
during installation.
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• Cisco Crosswork was upgraded or reinstalled and you need to authenticate and enroll Crosswork Data
Gateway with Cisco Crosswork.

• Cisco Crosswork configuration is in-progress when Crosswork Data Gateway tries to import the Controller
Certificate file.

• The Cisco Crosswork Controller IP address in unreachable or incorrect.

• The Cisco Crosswork username or password is incorrect.

Follow these steps to import the controller signing certificate file:

Step 1 From the Cisco Crosswork Data Gateway VM's Interactive Menu, select 3 Change Current System Settings.

The Change System Settings menu opens.

Step 2 Select 7 Import Certificate.
Step 3 From the Import Certificates menu, select 1 Controller Signing Certificate File.
Step 4 Enter the SCP URI for the certificate file.

An example URI is given below:

cw-admin@{server ip}:/home/cw-admin/controller.pem

Step 5 Enter the SCP passphrase (the SCP user password).

The certificate file is imported.

Step 6 Verify that the certificate was installed successfully. See View the Controller Signing Certificate File, on page 118.

View the Controller Signing Certificate File
Follow these steps to view the signing certificate:

Step 1 From the Crosswork Data Gateway VM's interactive menu, select 2 Show System Settings.
Step 2 From the Show Current System Settings menu, select 7 Certificates.
Step 3 Select 2 Controller Signing Certificate File.

Crosswork Data Gateway displays the default certificate if no new certificate has been imported. Otherwise, it displays
the new certificate if it was successfully imported.
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P A R T III
Install Cisco Crosswork Network Controller on
AWS EC2

• Installation Prerequisites for AWS EC2, on page 121
• Install Cisco Crosswork Network Controller on AWS EC2, on page 135





C H A P T E R 7
Installation Prerequisites for AWS EC2

This chapter contains the following topics:

• Overview, on page 121
• Amazon EC2 Settings, on page 121
• Host VM Requirements, on page 124
• Crosswork TCP/UDP Port requirements, on page 129
• IP Address Restrictions, on page 133

Overview
This chapter explains the general (such as VM requirements, port requirements, application requirements,
etc.) and platform-specific prerequisites to install each Crosswork component.

The data center resources needed to operate other integrated components or applications (such as WAE,
DHCP, and TFTP servers) are not addressed in this document. Refer to the respective installation documentation
of those components for more details.

Amazon EC2 Settings
This section describes the settings that must be configured to install Crosswork Network Controller on Amazon
EC2.

Crosswork can be deployed in Amazon Elastic Compute Cloud (EC2). Amazon EC2 is a web service that
provides compute resources in the cloud to host your Crosswork applications.

Crosswork is deployed in Amazon EC2 using CloudFormation (CF) templates. The CloudFormation process
is faster and less error-prone than the manual procedure to build the cluster, however you must have the
necessary skills to prepare a CloudFormation template with details of the cluster deployment.

Installing Crosswork and its components in the AWS environment requires you to review and meet the
following prerequisites:

Most of the requirements discussed in this section are AWS concepts and not imposed exclusively by
Crosswork.

Attention
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Table 27: AWS Prerequisites and Settings

DescriptionRequirement

Virtual Private Cloud (VPC) is created and configured with dedicated subnets for
Crosswork interfaces (Management and Data) and Crosswork Data Gateway
(Management, Data, and Device) interfaces.

Direct IP connectivity is required between all subnets.

VPC and Subnets

An endpoint is created in your VPC with the following parameters:

• Service name: EC2 service for the region (availability zone) where you are
deploying.

• Private DNS names: Enabled

• Endpoint type: Interface

• Under Subnets, specify the management subnet that you intend to use for the
installation. If you are using different management subnets for the Crosswork
VM and the Crosswork Data Gateway VM, ensure that you specify both the
management subnets so that the endpoint has access to both the subnets.

The interface subnet should not conflict with the Network Load
Balancer (NLB).

Important

For information on how to configure the endpoints, refer to the AWS documentation.

Endpoints

A role is created in Identity and Access Management (IAM) with relevant permission
policies. An IAM role is an identity that has specific permissions with credentials that
are valid for short durations. Roles can be assumed by entities that you trust.

Note • The minimum permissions required for a Crosswork role are
ec2:DescribeNetworkInterfaces, ec2:AssignPrivateIpAddresses
and ec2:UnassignPrivateIpAddresses.

• The trust policy for your role must have the "Action":
"sts:AssumeRole" condition.

IAM role

Key pairs (private keys used to log into the VMs) are created and configured.Key pairs

A placement group of Cluster strategy is created.

In a cluster placement group, instances are logically grouped in a single availability
zone that benefit from low network latency and high network throughput.

This requirement is required only for launching the Crosswork cluster instances.

Placement Groups
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DescriptionRequirement

Crosswork cluster: When using single NIC, you require one IP address (IPv4 or IPv6)
for each node being deployed (Hybrid or Worker) and one additional IP address to be
used as the Virtual IP (VIP) address. When using dual NICs (one for the Management
network and one for the Data network), you require a management and data IP address
(IPv4 or IPv6) for each node being deployed (Hybrid or Worker) and two additional
IP addresses to be used as the management and data Virtual IP (VIP) address.

For example, in the case of a 3 VM cluster with a single NIC, you need 4 IP addresses,
and in the case of a 3 VM cluster with dual NIC, you need 8 IP addresses (4 for
management network and 4 for data network).

Crosswork Data Gateway: IP addresses for Management Traffic and Data Traffic
only. IP address for Device Access Traffic is assigned during Crosswork Data Gateway
pool creation as explained in the Section: Create a Crosswork Data Gateway Pool in
the Cisco Crosswork Network Controller 6.0 Administration Guide.

• The IP addresses must be able to reach the gateway address for the network where
Cisco Crosswork Data Gateway will be installed, or the installation fails.

• At this time, your IP allocation is permanent and cannot be changed without
redeployment. For more information, contact the Cisco Customer Experience
team.

IP addresses

A security group must be created and configured to specify which ports or traffic are
allowed.

Security group

The resource profile for your instance deployment. The AWS Instance type should be
selected to conform with the VM resource and network requirements listed in Plan
Your Deployment, on page 5.

• Crosswork Cluster:

• Select m5.4xlarge for demos or lab deployments.

• Select m5.8xlarge for production deployments.

• Crosswork Data Gateway (production and lab deployments):

• Standard - Select m5.4xlarge

• Extended - Select m5.8xlarge

Instance type

The CF template (.yaml) files for the Crosswork components that must be uploaded
during the installation. For more information, see Extract CF Template Image, on page
135.

CloudFormation
(CF) template

Domain name configured for Route53 DNS hosted zone.Route53DomainName

The VM-specific parameters script that must be specified during the manual installation
procedure.

User data
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DescriptionRequirement

TheHosted Zone IDmust be providedwith the domain name (Route53DomainName).

The Network Load Balancer (NLB) deployments require a predefined Route53 hosted
zone.

Hosted Zone ID

Host VM Requirements
This section explains the resource requirements per VM to deploy the Crosswork Cluster and Crosswork Data
Gateway.

• Crosswork Cluster VM Requirements, on page 27

• Crosswork Data Gateway VM Requirements, on page 28

Crosswork Cluster VM Requirements
The Crosswork cluster consists of three VMs or nodes operating in a hybrid configuration. This is the minimum
configuration necessary to support the applications in a standard network. Additional VMs or nodes (maximum
up to 2 worker nodes) in a worker configuration can be added later to scale your deployment, as needed, to
match the requirements of your network, or as other applications are introduced (see Table 2: Crosswork
Network Controller packages, on page 6 for more information on VM count for each Crosswork Network
Controller package). Please consult with the Cisco Customer Experience team for guidance on your deployment
to best meet your needs.

The table below explains the network requirements per VM host:

Table 28: Network Requirements (per VM)

DescriptionRequirement

For production deployments, we recommend that you use dual interfaces, one
for the Management network and one for the Data network.

For optimal performance, the Management and Data networks should use links
configured at a minimum of 10 Gbps.

Network Connections

The IPv4 or IPv6 addresses or host names of the NTP servers you plan to use. If
you want to enter multiple NTP servers, separate themwith spaces. These should
be the same NTP servers you use to synchronize the Crosswork application VM
clock, devices, clients, and servers across your network.

Ensure that the NTP servers are reachable on the network before attempting
installation. The installation will fail if the servers cannot be reached.

NTP Servers

The IPv4 or IPv6 addresses of the DNS servers you plan to use. These should be
the same DNS servers you use to resolve host names across your network.

Ensure that the DNS servers are reachable on the network before attempting
installation. The installation will fail if the servers cannot be reached.

DNS Servers
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DescriptionRequirement

The search domain you want to use with the DNS servers, for example, cisco.com.
You can have only one search domain.

DNS Search Domain

Cisco Crosswork will back up the configuration of the system to an external
server using SCP. The SCP server storage requirements will vary slightly but
you must have at least 50 GB of storage.

Backup Server

• Cisco Crosswork Infrastructure and applications are built to run as a distributed collection of containers
managed by Kubernetes. The number of containers varies as applications are added or deleted.

• Dual stack configuration is not supported in Crosswork Platform Infrastructure. Therefore, all addresses
for the environment must be either IPv4 or IPv6.

Crosswork Data Gateway VM Requirements
This section provides information about the general guidelines and minimum requirements for installing
Crosswork Data Gateway.

• Selecting the Crosswork Data Gateway Deployment Type, on page 125

• Crosswork Data Gateway VM Requirements, on page 126

Selecting the Crosswork Data Gateway Deployment Type

The following table lists the deployment profile that must be used for installing Crosswork Data Gateway in
each Crosswork product:

The VM resource requirements for Crosswork Data Gateway are different for each type and cannot bemodified.
Therefore, if your requirements change, you must re-deploy the Crosswork Data Gateway to move from one
type to another. For more information, see the Redeploy a Crosswork Data Gateway VM section in Cisco
Crosswork Network Controller 6.0 Administration Guide.

Note

Table 29: Crosswork Data Gateway deployment types

Crosswork Data Gateway DeploymentCisco Crosswork Product

On-Premise StandardCrosswork Network Controller (combination of
Crosswork Active Topology & Crosswork
Optimization Engine)

On-Premise StandardCrosswork Optimization Engine

On-Premise StandardCrosswork Zero Touch Provisioning

On-Premise ExtendedCrosswork Change Automation

On-Premise ExtendedCrosswork Health Insights
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Crosswork Data Gateway DeploymentCisco Crosswork Product

On-Premise ExtendedCrosswork Service Health

Crosswork Data Gateway VM Requirements

The VM requirements for Crosswork Data Gateway are listed in the following table.

Table 30: Crosswork Data Gateway Requirements for on-premise applications

DescriptionRequirement

VMware. See Installation Prerequisites for VMware vCenter, on page 19.Data Center
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DescriptionRequirement

Minimum: 1

Maximum: 3

Cisco Crosswork Data Gateway can be deployed with either 1, 2, and 3 interfaces as
per the combinations below:

If you use one interface on your Crosswork cluster, you must use only
one interface on the Crosswork Data Gateway. If you use two interfaces
on your Crosswork Cluster, then you can use two, or three interfaces on
the Crosswork Data Gateway as per your network requirements.

Note

Interfaces

vNIC2vNIC1vNIC0No. of
NICs

——• Management Traffic

• Control/Data Traffic

• Device Access Traffic

1

—• Control/Data
Traffic

• Device Access
Traffic

Management Traffic2

Device Access
Traffic

Control/Data TrafficManagement Traffic3

• Management traffic: for accessing the Interactive Console and passing the
Control/Data information between servers (for example, a Crosswork application
to Crosswork Data Gateway).

• Control/Data traffic: for data and configuration transfer between Cisco Crosswork
Data Gateway and Crosswork applications and other external data destinations.

• Device access traffic: for device access and data collection.

Due to security policies, traffic from subnets of a vNIC received on other
vNICs is dropped. For example, in a 3 vNIC model setup, all device
traffic (incoming and outgoing) must be routed through default vNIC2.
Crosswork Data Gateway drops device traffic received over vNIC0 and
vNIC1.

Note
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DescriptionRequirement

1 or 2 IPv4 or IPv6 addresses based on the number of interfaces you choose to use.

An additional IP address to be used as the Virtual IP (VIP) address. For each active
data gateway, a unique VIP is required.

For more information, refer to the Interfaces section in the Table 25: Cisco Crosswork
Data Gateway Deployment Parameters and Scenarios, on page 81.

Crosswork does not support dual stack configurations. Therefore, all
addresses for the environment must be either IPv4 or IPv6.

In a 3-NIC deployment, you need to provide an IP address for
Management interface (vNIC0) and Control/Data interface (vNIC1)
during installation. A virtual IP address for Device Access Traffic (vNIC2)
is assigned when you create a Crosswork Data Gateway to a pool as
explained in theCreate a Crosswork Data Gateway Pool section inCisco
Crosswork Network Controller 6.0 Administration Guide.

Note

IP Addresses

The IPv4 or IPv6 addresses or host names of the NTP servers you plan to use. If you
want to enter multiple NTP servers, separate them with spaces. These should be the
same NTP servers you use to synchronize devices, clients, and servers across your
network. Verify that the NTP IP address or host name is reachable on the network else
the installation fails.

Also, the ESXi hosts that run the Crosswork application and Cisco Crosswork Data
Gateway VM must have NTP configured, or the initial handshake may fail with
"certificate not valid" errors.

NTP Servers

The IPv4 or IPv6 addresses of the DNS servers you plan to use. These should be the
same DNS servers you use to resolve host names across your network. Confirm that
the DNS servers are reachable on the network before attempting installation. The
installation fails if the servers cannot be reached.

DNS Servers

The search domain you want to use with the DNS servers, for example, cisco.com.
You can have only one search domain.

DNS Search
Domain

Crosswork does not support dual stack configurations. Therefore, all FQDN addresses
configured for the deployment environment must be either IPv4 or IPv6.

The FQDN addresses are configured for Amazon EC2 deployments.

FQDN

The Crosswork uses ICMP in the communications with Crosswork Data Gateway.
Ensure that the firewall between Crosswork and the Crosswork Data Gateway passes
this traffic.

Internet Control
Message Protocol
(ICMP)
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Crosswork TCP/UDP Port requirements
Crosswork Cluster Port Requirements

The following TCP/UDP port numbers need to be allowed through any external firewall or access-list rules
deployed by the data center administrator. Depending on the NIC deployment, these ports may be applicable
to only one or both NICs.

Crosswork cluster ports allow bidirectional flow of information.Note

Table 31: External Ports used by Crosswork Cluster

Used forProtocolPort

Remote SSH trafficTCP22

GlusterFS (port mapper)TCP/UDP111

Calico BGP (Kubernetes)TCP179

Accessing the EC2 API.TCP80, 443

IPSecUDP500

Kubernetes etcdTCP2379/2380

IPSecUDP4500

kube-apiserver (Kubernetes)TCP6443

Kubernetes metamonitoringTCP9100

kubelet (Kubernetes)TCP10250

GlusterFSTCP24007

User interface (NGINX server listens for secure connections
on port 443)

TCP30603

Docker RegistryTCP30606

For FTP (available on data interface only). The additional
ports used for file transfer are 31121 (TCP), 31122 (TCP),
and 31123 (TCP).

This port is available only when the supported application
is installed on Cisco Crosswork and the FTP settings are
enabled.

TCP30621
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Used forProtocolPort

For SFTP (available on data interface only)

This port is available only when the supported application
is installed on Cisco Crosswork and the SFTP settings are
enabled.

TCP30622

GlusterFSTCP49152:49370

Table 32: Ports used by other Crosswork components

Used forProtocolPort

to monitor the installation (Crosswork Network Controller)TCP30602

CrossworkNetwork ControllerWebUser interface (NGINX
server listens for secure connections on port 443)

TCP30603

Used for Classic Zero Touch Provisioning (Classic ZTP)
on the NGINX server.

TCP30604

Crosswork Data Gateway vitals collectionTCP30607

Data Gateway gRPC channel with Data Gateway VMsTCP30608

Used by the Expression Orchestrator (Crosswork Service
Health)

TCP30609

Used by the Metric Scheduler (Crosswork Service Health)TCP30610

Used by the Expression Tracker component (Crosswork
Service Health)

TCP30611

Used for Secure Zero Touch Provisioning (Secure ZTP) on
the ZTP server.

TCP30617

Used to receive plug-and-play HTTP traffic on the ZTP
server.

TCP30620

To set up and monitor Crosswork Data Gateway collection
status.

TCP30649

astack gRPC channel with astack-client running on Data
Gateway VMs

TCP30650

Crosswork Data Gateway sending the collected data to
Crosswork Kafka destination.

TCP30993, 30994, 30995

Table 33: Destination Ports used by Crosswork Cluster

Used forProtocolPort

Discover endpoints using ICMPTCP/UDP7
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Used forProtocolPort

Initiate SSH connections with managed devicesTCP22

Connect to DNSTCP/UDP53

Network Time Protocol (NTP)UDP123

Initiate NETCONFTCP830

Used for communication between Crosswork and Cisco
NSO (for NETCONF).

TCP2022

REST API to SR-PCETCP8080

Used for communication between Crosswork and Cisco
NSO (for HTTPS).

TCP8888

Used by the DLM Function Pack for communication
between DLM and Cisco NSO

TCP20243

Used to internally manage the DLM Function Pack listener
during a Reload Packages scenario on Cisco NSO

TCP20244

Crosswork Data Gateway Port Requirements

The following tables show the minimum set of ports required for Crosswork Data Gateway to operate correctly.

Inbound: Crosswork Data Gateway listens on the specified ports.

Outbound: Crosswork Data Gateway connects to external destination IP on the specified ports.

Table 34: Ports to be Opened for Management Traffic

DirectionUsed forProtocolPort

InboundSSH serverTCP22

OutboundSCP clientTCP22

OutboundNTP ClientUDP123

OutboundDNS ClientUDP53

OutboundCrosswork ControllerTCP30607

SCP port can be tuned.Note

Table 35: Ports to be Opened for Device Access Traffic

DirectionUsed forProtocolPort

OutboundSNMP CollectorUDP161
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DirectionUsed forProtocolPort

InboundSNMP Trap Collector

This is the
default
value. You
can change
this value
after
installation
from the
Cisco
Crosswork
UI. See
Configure
Crosswork
Data
Gateway
Global
Parameters
for more
information.

Note

UDP1062

InboundMDT CollectorTCP9010

OutboundCLI CollectorTCP22

InboundSyslog Collector

This is the default value.
You can change this value
after installation from the
Cisco Crosswork UI. See
Configure Crosswork
Data Gateway Global
Parameters for more
information.

TLS6514

TCP9898

UDP9514

OutboundgNMI CollectorTCPSite Specific

Default ports differ from
XR, XE to vendor. Check
platform-specific
documentation.

Table 36: Ports to be Opened for Control/Data Traffic

DirectionUsed forProtocolPort

OutboundCrosswork ControllerTCP30649
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DirectionUsed forProtocolPort

OutboundCrosswork KafkaTCP30993

30994

30995

OutboundKafka and gRPC
Destination

Site SpecificSite Specific

IP Address Restrictions
Crosswork cluster uses the following IP ranges for internal communications. This cannot be changed. As a
result, these subnets cannot be used for devices or other purposes within your network.

You are recommended to isolate your Crosswork cluster to ensure all the communications stay within the
cluster. Please also ensure that address spaces do not overlap for any of the external integration points (e.g.
connections to devices, connections to external servers that Crosswork is sending data to, connections to the
NSO server, etc.).

This is applicable for cluster installation and for adding a static route.Note

The default values for the K8sServiceNetwork (10.96.0.0) and K8sPodNetwork (10.244.0.0) parameters can
be changed.

Note

Table 37: Protected IP Subnets

RemarksSubnetIP Type
6

Docker Subnet (Infrastructure)172.17.0.0/16IPv4

Link local address block169.254.0.0/16

Loopback address127.0.0.0/8

Reserved, previously used for relay servers to do IPv6 over IPv4192.88.99.0/24

Reserved for future use (previously class E block)240.0.0.0/4

MCAST-TEST-NET224.0.0.0/4

Current network, valid as source address only0.0.0.0/8
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RemarksSubnetIP Type
6

Docker Subnet (Infrastructure)2001:db8:1::/64IPv6

Pod Subnet (Infrastructure)fdfb:85ef:26ff::/48

Service Subnet (Infrastructure)fd08:2eef:c2ee::/110

Loopback address::1/128

Link localfe80::/10

IPv6 Multicastff00::/8

Reserved, previously used for relay servers to do IPv6 over IPv42002::/16

Terredo tunnel and relay2001:0000::/32

Used by ORCHID and not IPv6 routable2001:20::/28

Discard prefix, used in specific use-cases not applicable to
Crosswork Zero Touch Provisioning

100::/64

Unspecified address, cannot be assigned to hosts::/128

IPv4 mapped addresses::ffff:0:0/96

IPv4 translated addresses::ffff:0:0:0/96

6 Dual stack configuration is not supported in Crosswork Platform Infrastructure. Therefore, all addresses
for the environment must be either IPv4 or IPv6.
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C H A P T E R 8
Install Cisco Crosswork Network Controller on
AWS EC2

This chapter contains the following topics:

• Installation Overview, on page 135
• Extract CF Template Image, on page 135
• Roles and Policy Permissions , on page 137
• Configure the CloudFormation (CF) Template Parameters, on page 137
• Install Using Module Deployment Method, on page 150
• Manage CF Template Deployment, on page 157
• Accessing the Crosswork UI, on page 159
• Crosswork Data Gateway Post-installation Tasks, on page 160

Installation Overview
This section provides an overview of how Cisco Crosswork is installed on Amazon EC2.

Cisco Crosswork uses the CloudFormation (CF) templates to deploy the cluster stacks. The CF process is
faster and less error-prone than the manual procedure to build the cluster, however you must have the necessary
skills to prepare a CF template with details of the cluster deployment.

The terms 'stack' and 'instance' refers to cluster and VM respectively.Note

The CF templates (.yaml file) provided are samples that must be customized according to your production
preferences and executed as per the steps mentioned in this chapter.

Important

Extract CF Template Image
This section explains the procedure to extract and validate the Cisco Crosswork CF template image.
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The file names mentioned in this topic are sample names and may differ from the actual file names in release
version.

Attention

Step 1 Download the Crosswork CF template package (signed-CFT-6.0.0_release_12.tar.gz) from cisco.com.
Step 2 Use the following command to unzip the package:

tar -xzvf signed-CFT-6.0.0_release_12.tar.gz

The contents of the package is unzipped to a new directory. This new directory contains the CF template image and files
necessary to validate the image.

For example:
tar -xzvf signed-CFT-6.0.0_release_12.tar.gz
x CFT-6.0.0_release_12.tar.gz
x CFT-6.0.0_release_12.tar.gz.signature
x README
x CW-CCO_RELEASE.cer
x cisco_x509_verify_release.py3
x cisco_x509_verify_release.py

Step 3 Review the contents of the README file in order to understand everything that is in the package and how it will be
validated in the following steps.

Step 4 Navigate to the directory created in the previous step and use the following command to verify the signature of the installer
image:

Use python --version to find out the version of Python on your machine.Note

If you are using Python 2.x, use the following command to validate the file:
python cisco_x509_verify_release.py -e <.cer file> -i <.tar.gz file> -s <.tar.gz.signature file>
-v dgst -sha512

If you are using Python 3.x, use the following command to validate the file:
python cisco_x509_verify_release.py3 -e <.cer file> -i <.tar.gz file> -s <.tar.gz.signature file>
-v dgst -sha512

For example:
python cisco_x509_verify_release.py3 -e CW-CCO_RELEASE.cer -i CFT-6.0.0_release_12.tar.gz -s
CFT-6.0.0_release_12.tar.gz.signature -v dgst -sha512
Retrieving CA certificate from http://www.cisco.com/security/pki/certs/crcam2.cer ...
Successfully retrieved and verified crcam2.cer.
Retrieving SubCA certificate from http://www.cisco.com/security/pki/certs/innerspace.cer ...
Successfully retrieved and verified innerspace.cer.
Successfully verified root, subca and end-entity certificate chain.
Successfully fetched a public key from CW-CCO_RELEASE.cer.
Successfully verified the signature of CFT-6.0.0_release_12.tar.gz using CW-CCO_RELEASE.cer

The contents of the package is extracted and validated successfully.

Step 5 In the directory, locate the install-cnc-templates file and follow the instructions provided within its Description section.

Customize the CF templates in the directory to install Cisco Crosswork on Amazon EC2.
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What to do next

Return to the installation workflow: Install Cisco Crosswork Network Controller on AWS EC2, on page 13

Roles and Policy Permissions
This section describes the roles and the policy permissions that you must have when deploying the CF template
on Amazon. For information on how to create and manage the roles, refer to the Amazon documentation.

Table 38: Amazon EC2 Roles and Actions Assigned to the Roles

ActionsRole

DescribeInternetGateways, DescribeNetworkInterfaces, DescribeImages,
DeleteLaunchTemplate, DescribeSubnets, DescribeAccountAttributes,
DescribeSecurityGroups, RunInstances, DescribeVpcs, DescribeInstances,
CreateNetworkInterface, CreateTags, DescribeKeyPairs,
CreateLaunchTemplate, DeleteNetworkInterface, TerminateInstances

EC2

DescribeLoadBalancers, CreateLoadBalancer,
ModifyLoadBalancerAttributes, AddTags, DeleteLoadBalancer

ELB

DescribeLoadBalancers, CreateLoadBalancer, AddTags,
DeleteLoadBalancer, CreateTargetGroup, CreateListener, DeleteListener,
DescribeTargetGroups,ModifyLoadBalancerAttributes,DescribeListeners,
RegisterTargets, DeleteTargetGroup, ModifyTargetGroupAttributes,
DescribeTargetHealth

ELB v2

CreateNodegroup, DescribeNodegroup, DeleteNodegroupIAM

Configure the CloudFormation (CF) Template Parameters
This section explains the important parameters that must be specified for module deployments.

• CF Template Parameters for Installing Cisco Crosswork Cluster VMs, on page 138

• CF Template Parameters for Installing Crosswork Data Gateway, on page 144

• CF Template Parameters for Installing NSO, on page 147

• CF Template Parameters for Installing Single Hybrid Cluster or Worker Node, on page 148

• The parameters that are mandatory for creating the templates are indicated explicitly. Parameters without
this indication are optional and are populated with the default values, which you can alter based on your
deployment requirement.

• All IP addresses you enter as parameters should be available.

Important
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CF Template Parameters for Installing Cisco Crosswork Cluster VMs
This section describes the parameters that are required for deploying Cisco Crosswork Cluster VMs with 3
hybrid VMs on Amazon EC2. It also describes the Management and Data NLB parameters.

Once you have determined the subnet for your cluster nodes and any other virtual machines you are going to
deploy, confirm that there are enough available IP addresses to support the number of VMs (and virtual IP
addresses) needed.

Table 39: Cisco Crosswork Cluster VMs Deployment Parameters

DescriptionParameter

The virtual private cloud (VPC) ID of your existing VPC. For example,
vpc-0f83aac74690101a3.

VpcId

Precreated security group that must be applied to the stack. For example,
sg-096ff4bc355af16a0. The group must allow ingress access to ports 22,
30160:31560.

SecGroup

The SSH password of the Crosswork Network Controller.

We recommend using an external secret store for the
password.

Important

CwSSHPassword

The Crosswork AMI ID.

This is a mandatory parameter.

CwAmiId

Management subnet for Crosswork VM 1.

This is a mandatory parameter.

CwMgmtSubnet1Id

Management subnet for Crosswork VM 2.

This is a mandatory parameter.

CwMgmtSubnet2Id

Management subnet for Crosswork VM 3.

This is a mandatory parameter.

CwMgmtSubnet3Id

The first management subnet netmask in the dotted-decimal form. For
example, 255.255.255.0. This parameter is ignored when deploying on a
single interface.

This is a mandatory parameter.

CwMgmtSubnet1Netmask

The second management subnet netmask in the dotted-decimal form. For
example, 255.255.255.0. This parameter is ignored when deploying on a
single interface.

This is a mandatory parameter.

CwMgmtSubnet2Netmask
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DescriptionParameter

The third management subnet netmask in the dotted-decimal form. For
example, 255.255.255.0. This parameter is ignored when deploying on a
single interface.

This is a mandatory parameter.

CwMgmtSubnet3Netmask

The management default gateway on the selected data subnet. Typically,
the first address on the subnet. This parameter is ignored when deployed
on single interface mode.

This is a mandatory parameter.

CwMgmtSubnet1Gateway

The management default gateway on the selected data subnet. Typically,
the first address on the subnet. This parameter is ignored when deployed
on single interface mode.

This is a mandatory parameter.

CwMgmtSubnet2Gateway

The management default gateway on the selected data subnet. Typically,
the first address on the subnet. This parameter is ignored when deployed
on single interface mode.

This is a mandatory parameter.

CwMgmtSubnet3Gateway

Crosswork Management VIP name. For example, dev1-cwmgnt.

This will be the host name to access the Crosswork cluster.

ManagementVIPName

Crosswork Data VIP name. For example, dev1-cwdata.DataVIPName

Domain name used for all Route53 objects.

This is the DNS domain name for the Crosswork cluster.

This is a mandatory parameter.

Route53DomainName

The Hosted Zone ID provided with the domain name
(Route53DomainName). TheNetwork LoadBalancer (NLB) deployments
require a predefined Route53 hosted zone.

This is a mandatory parameter.

HostedZoneId

Determines whether to use an external NLB for the Crosswork cluster
(multi-AZ or subnet) or a Crosswork VIP (only single AZ or subnet).
Options are True or False.

This is a mandatory parameter.

UseExternalNLB

The EC2 instance placement strategy that is valid for single availability
zone. Default 'cluster' ensures maximum throughput. Options are:

• cluster

• partition

• spread

CwClusterPlacementStrategy
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DescriptionParameter

The Crosswork Node Type for deployment. Options are Hybrid or Worker.

A replacement Hybrid node must reuse the same IP addresses as the
Hybrid node it is replacing.

Default value is Worker.

This is a mandatory parameter.

CwNodeType

The deployment mode.

Options are 1 to deploy the Management interface or 2 to deploy the
Management and Data interface.

InterfaceDeploymentMode

Data subnet of Crosswork VM 1.

In a single interface, the deployments happen on the subnet where the
Management interface is deployed.

This is a mandatory parameter.

CwDataSubnet1Id

Data subnet of Crosswork VM 2.

In a single interface, the deployments happen on the subnet where the
Management interface is deployed.

This is a mandatory parameter.

CwDataSubnet2Id

Data subnet of Crosswork VM 3.

In a single interface, the deployments happen on the subnet where the
Management interface is deployed.

This is a mandatory parameter.

CwDataSubnet3Id

The first data subnet netmask in the dotted-decimal form. For example,
255.255.255.0. This parameter is ignored when deploying in a single
interface mode.

This is a mandatory parameter.

CwDataSubnet1Netmask

The first default data gateway on the selected data subnet. Typically, the
value is the first address on the subnet. This parameter is ignored when
deploying in a single interface mode.

This is a mandatory parameter.

CwDataSubnet1Gateway

The second data subnet netmask in the dotted-decimal form. For example,
255.255.255.0. This parameter is ignored when deploying in a single
interface mode.

This is a mandatory parameter.

CwDataSubnet2Netmask

The second data subnet netmask in the dotted-decimal form. This
parameter is ignored when deploying in a single interface mode.

This is a mandatory parameter.

CwDataSubnet2Gateway
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DescriptionParameter

The third data subnet netmask in the dotted-decimal form. For example,
255.255.255.0. This parameter is ignored when deploying in a single
interface mode.

This is a mandatory parameter.

CwDataSubnet3Netmask

The third data subnet netmask in the dotted-decimal form. This parameter
is ignored when deploying in a single interface mode.

This is a mandatory parameter.

CwDataSubnet3Gateway

The current Crosswork Management VIP address.CwMgmtVIP

The current Crosswork Data VIP address. When using an external NLB,
you can leave this parameter empty.

CwDataVIP

A free address on the management subnet. If not specified, an address is
automatically assigned.

Cw1MgmtIP

A free address on the data subnet. If not specified, an address is
automatically assigned.

Cw1DataIP

A free address on the management subnet. If not specified, an address is
automatically assigned .

Cw2MgmtIP

A free address on the data subnet. If not specified, an address is
automatically assigned.

Cw2DataIP

A free address on the management subnet. If not specified, an address is
automatically assigned.

Cw3MgmtIP

A free address on the data subnet. If not specified, an address is
automatically assigned .

Cw3DataIP

The Management IP address \#1 of the existing Crosswork node. This is
used when the deployment happens with an external load balancer.

OtherCwMgmtIP1

The Management IP address \#2 of the existing Crosswork node. This
parameter is used when the deployment happens with an external load
balancer.

OtherCwMgmtIP2

The Data IP address \#1 of the existing Crosswork node. This parameter
is used when the deployment happens with an external load balancer.

OtherCwDataIP1

The Data IP address \#2 of the existing Crosswork node. This parameter
is used when the deployment happens with an external load balancer.

OtherCwDataIP2

Cisco Crosswork Network Controller 6.0 Installation Guide
141

Install Cisco Crosswork Network Controller on AWS EC2
CF Template Parameters for Installing Cisco Crosswork Cluster VMs



Table 40: Crosswork VM Customization

DescriptionParameter

The EC2 instance type for the node instances.

This is a mandatory parameter.

InstanceType

A spot instance.

Options are:

• True: to enable the feature

• False: to disable the feature

Default value is False.

This is a mandatory parameter.

RunAsSpotInstance

Crosswork data disk size. The default is 450 GB and should be fine for most
deployments. Enter the default unless otherwise directed by Cisco Customer
Experience team.

This is a mandatory parameter.

DataDiskSize

The network address for the Kubernetes service network. The CIDR range
is fixed to '/16'. If not provided, the default will be taken, that is, 10.96.0.0.

This is a mandatory parameter.

K8sServiceNetwork

The network address for the Kubernetes pod network. The CIDR range is
fixed to '/16'."

This is a mandatory parameter.

K8sPodNetwork

Configures the Skip Auto Install feature. Options are:

• True: to enable the feature

• False: to disable the feature

Default value is False.

This is a mandatory parameter.

SkipAutoInstall

Table 41: Cisco Crosswork Cluster Management NLB Deployment Parameters

DescriptionParameter

The virtual private cloud (VPC) ID of your existing VPC. For example,
vpc-0f83aac74690101a3.

VpcId

This is a list of the Crosswork management subnets.

This is a mandatory parameter.

CwTargetSubnetIdList

This is a Crosswork VM management IP. In this template, this is a
mandatory parameter.

CwTargetIP1
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DescriptionParameter

This is a Crosswork VM management IP. In this template, this is a
mandatory parameter.

CwTargetIP2

This is a Crosswork VM management IP. In this template, this is a
mandatory parameter.

CwTargetIP3

Domain name used for all Route53 objects.

This is a mandatory parameter.

Route53DomainName

The domain name used for all Route53 objects.

This is a mandatory parameter.

HostName

The hosted zone ID.

This is a mandatory parameter.

HostedZoneId

Table 42: Data NLB Deployment Parameters

DescriptionParameter

The virtual private cloud (VPC) ID of your existing VPC. For example,
vpc-0f83aac74690101a3.

VpcId

The first management subnet for the Crosswork VMs.

This is a mandatory parameter.

CwTargetSubnetIdList

A free address on the management subnet. If not specified, an address
is automatically assigned.

CwTargetIP1

A free address on the management subnet. If not specified, an address
is automatically assigned.

CwTargetIP2

A free address on the management subnet. If not specified, an address
is automatically assigned.

CwTargetIP3

Domain name used for all Route53 objects.

This is a mandatory parameter.

Route53DomainName

The domain name used for all Route53 objects.

This is a mandatory parameter.

HostName

The hosted zone ID.

This is a mandatory parameter.

HostedZoneId
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CF Template Parameters for Installing Crosswork Data Gateway
This section describes the parameters that are required when creating the Crosswork Data Gateway control
plane, node, pool, and other important containers. It also has parameters that are required for creating EC2
Crosswork Data Gateway NLB stack.

Table 43: Crosswork Data Gateway Deployment Parameters

DescriptionParameter

The Amazon Web Services IAM role name for the EC2 VIP update.AwsIamRole

The virtual private cloud (VPC) ID of your existing VPC. For example,
vpc-0f83aac74690101a3.

VpcId

Precreated security group that must be applied to the stack. For example,
sg-096ff4bc355af16a0. The group must allow ingress access to all ports
that Crosswork, NSO, Crosswork Data Gateway, and IOS-XR uses.

SecGroup

The SSH password to be configured on the Crosswork Data Gateway
node.

CDGSSHPassword

The password to be configured on the Crosswork Data Gateway for
Dg-Oper user.

CDGOperPassword

The Crosswork Data Gateway AMI ID.CDGAmiId

The EC2 instance type for the node instances.

This is a mandatory parameter.

InstanceType

Host address or name of the Crosswork Data Gateway controller. In a
multi-AZ deployment, this value must be the name.

This is a mandatory parameter.

CNCControllerIP

The cw-admin user password used to access Crosswork or CNCController.CNCControllerPassword

Crosswork Data Gateway deployment mode.

The options are:

• 1: to deploy all the interfaces.

• 2: to deploy the Management and Data interfaces.

• 3: to deploy the Management, Data, and Control interfaces.

InterfaceDeploymentMode

A free IP address on the subnet. If set to 0.0.0.0, the IP address is
automatically allocated.

This is a mandatory parameter.

CDGInterface0IPAddress

The first interface subnet for the Crosswork Data Gateway VM.CDGInterface0SubnetId

The default gateway on the selected subnet. Typically, the first address
on the subnet.

CDGInterface0Gateway
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DescriptionParameter

The first interface subnet netmask in the dotted-decimal form. For
example, 255.255.255.0.

This is a mandatory parameter.

CDGInterface0SubnetNetmask

A free IP address on the first subnet. If set to 0.0.0.0, the IP address is
automatically allocated.

This is a mandatory parameter.

CDGInterface1IPAddress

The second interface subnet for the Crosswork Data Gateway. The subnet
must be in the same availability zone as the CDGInterface0SubnetId.

CDGInterface1SubnetId

The second interface default gateway on the selected subnet. Typically,
the first address on the subnet.

This is a mandatory parameter.

CDGInterface1Gateway

The second interface subnet netmask in the dotted-decimal form. For
example, 255.255.255.0. This parameter is ignored when dual interface
mode is not used.

This is a mandatory parameter.

CDGInterface1SubnetNetmask

A free IP address on the second subnet. If set to 0.0.0.0, the IP address is
automatically allocated.

This is a mandatory parameter.

CDGInterface2IPAddress

The third interface subnet for the Crosswork Data Gateway VM. The
subnet must be in the same availability zone as the
CDGInterface0SubnetId.

CDGInterface2SubnetId

The third interface default gateway on the selected subnet. Typically, the
first address on the subnet.

This is a mandatory parameter.

CDGInterface2Gateway

The third interface subnet netmask in the dotted-decimal form. For
example, 255.255.255.0. This parameter is ignored when triple interface
mode is not used.

This is a mandatory parameter.

CDGInterface2SubnetNetmask

Host address of the Crosswork Data Gateway controller.CNCControllerIP
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DescriptionParameter

The Crosswork Data Gateway HA mode.

The pool mode options are:

• L2: Use this option when you specify IP addresses for creating the
HA pool.

• L3: Use this option when you specify FQDN for creating the HA
pool and for multisubnet deployment.

For information on the pool types, refer to the Create a Cisco Crosswork
Data Gateway Pool section in Cisco Crosswork Network Controller 6.0
Administration Guide.

This is a mandatory parameter.

HANetworkMode

Size of the Crosswork data disk. The minimum size is 20. Default size is
50.

This is a mandatory parameter.

DataDiskSize

The deployment profile of Crosswork Data Gateway.

• Standard

• Extended

This is a mandatory parameter.

CDGProfile

The Crosswork Data Gateway instance name, for example CDG-01.CdgInstanceHostname

The physical location of Availability Zone 1 and 2.az_id

The physical location of the Crosswork Data Gateway VM.region_id

The location of the primary and second Crosswork sites.

During enrollment, Crosswork sends this value to cdg-manager to preset
the cluster affiliation of the instance.

site_location

Table 44: Crosswork Data Gateway and Network Load Balancer (NLB) Stack Parameters

DescriptionParameter

The VPC ID of the worker instances.

This is a mandatory parameter.

VpcId

The management ID of subnet 1.

This is a mandatory parameter.

SubnetId1

The management ID of subnet 2.

This is a mandatory parameter.

SubnetId2
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DescriptionParameter

The domain name.

This is a mandatory parameter.

DomainName

The hosted zone ID.

This is a mandatory parameter.

HostedZoneId

Name of the Route53 record.

This is a mandatory parameter.

CdgPoolHostname

The IP address 1 of the Management node.

In the event of a single Crosswork Data Gateway, one target IP must
be configured.

CdgTargetIP1

The IP address 2 of the Management node.CdgTargetIP2

The first LB IP address on subnet.

This is a mandatory parameter.

LBIPaddress1

The second LB IP address on subnet.

This is a mandatory parameter.

LBIPaddress2

CF Template Parameters for Installing NSO
This section describes the parameters that are required for deploying NSO on Amazon EC2.

Table 45: NSO Deployment Parameters

DescriptionParameter

The virtual private cloud (VPC) ID of your existing VPC. For example,
vpc-0f83aac74690101a3.

VpcId

Precreated security group that must be applied to the stack. For example,
sg-096ff4bc355af16a0. The group must allow ingress access to ports 22,
30160:31560.

SecGroup

The subnet for the NSO VM.NSOSubnetId

Name of an existing EC2 KeyPair to enable SSH access to the instance.KeyName

The NSO AMI ID.

This is a mandatory parameter.

NSOAmiId

A free IP address on the second subnet. If set to 0.0.0.0, the IP address is
automatically allocated.

This is a mandatory parameter.

NSOInterface0IPAddress
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DescriptionParameter

The EC2 instance type for the node instances.

This is a mandatory parameter.

InstanceType

CF Template Parameters for Installing Single Hybrid Cluster or Worker Node
This section describes the parameters that are required for deploying a single cluster node (Hybrid orWorker).

• A replacement hybrid node must reuse the same IP addresses as the hybrid VM it is replacing.

• As you will be adding another node (worker or hybrid) to the existing cluster determine the subnet that
is being used and find an additional available IP on that subnet.

Attention

Table 46: Single Hybrid Cluster or Worker Cisco Crosswork Nodes Deployment Parameters

DescriptionParameter

The virtual private cloud (VPC) ID of your existing VPC. For example,
vpc-0f83aac74690101a3.

VpcId

Precreated security group that must be applied to the stack. For example,
sg-096ff4bc355af16a0. The group must allow ingress access to ports 22,
30160:31560.

SecGroup

Existing role name for the Crosswork cluster. The role must permit EC2
access.

EC2ENIRole

The Crosswork AMI ID.

This is a mandatory parameter.

CwAmiId

The SSH password of the Crosswork Network Controller.

We recommend using an external secret store for the
password.

Important

CwSSHPassword

The EC2 instance type for the node instances.

This is a mandatory parameter.

InstanceType

Crosswork Management VIP name. For example, dev1-cwmgnt.ManagementVIPName

Crosswork Data VIP name. For example, dev1-cwdata.DataVIPName

Domain name used for all Route53 objects.

This is a mandatory parameter.

Route53DomainName
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DescriptionParameter

Determines whether to use an external NLB for the Crosswork cluster
(multi-AZ or subnet) or a Crosswork VIP (only single AZ or subnet).
Options are True or False.

This is a mandatory parameter.

UseExternalNLB

The management subnet for the Crosswork VMs.CwMgmtSubnetId

The management subnet netmask in dotted decimal form. For example,
255.255.255.0. This parameter is ignored when deploying in a single
interface mode.

This is a mandatory parameter.

CwMgmtSubnetNetmask

The management default gateway on the selected data subnet. Typically,
the first address on the subnet. This parameter is ignored when deployed
on single interface mode.

This is a mandatory parameter.

CwDataSubnetGateway

The data subnet for the Crosswork VMs.CwDataSubnetId

The data subnet netmask in dotted decimal form. For example,
255.255.255.0. This parameter is ignored when deploying in a single
interface mode.

This is a mandatory parameter.

CwDataSubnetNetmask

The data default gateway on the selected data subnet. Typically, the first
address on the subnet. This parameter is ignored when deployed on single
interface mode.

This is a mandatory parameter.

CwDataSubnetGateway

The Crosswork Node Type for deployment. Options are Hybrid or Worker.

A replacement Hybrid node must reuse the same IP addresses as the
Hybrid node it is replacing.

This is a mandatory parameter.

CwNodeType

Crosswork data disk size. The default is 450 (in GB) and should be fine
for most deployments. Enter the default unless otherwise directed by
Cisco Customer Experience team.

This is a mandatory parameter.

DataDiskSize

The network address for the Kubernetes service network. The CIDR range
is fixed to '/16'. If not provided, the default (10.96.0.0) is taken.

K8sServiceNetwork

The network address for the Kubernetes pod network. The CIDR range
is fixed to '/16'. If not provided, the default (10.244.0.0) is taken.

K8sPodNetwork
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Table 47: Optional VM parameters

DescriptionParameters

The current Crosswork Management VIP address.CwMgmtVIP

The current Crosswork Data VIP address. When using an external NLB,
you can leave this parameter empty.

CwDataVIP

A free address on the management subnet. If not specified, an address is
automatically assigned.

Cw1MgmtIP

A free address on the data subnet. If not specified, an address is
automatically assigned.

Cw1DataIP

The first Management IP address of the existing Crosswork node. This is
used when the deployment happens with an external load balancer.

OtherCwMgmtIP1

The second Management IP address of the existing Crosswork node. This
parameter is used when the deployment happens with an external load
balancer.

OtherCwMgmtIP2

The first Data IP address of the existing Crosswork node. This parameter
is used when the deployment happens with an external load balancer.

OtherCwDataIP1

The second Data IP address of the existing Crosswork node. This parameter
is used when the deployment happens with an external load balancer.

OtherCwDataIP2

Install Using Module Deployment Method
The module-based deployment procedures involve deploying each resource separately. Each resource has its
own template file, which can be used to deploy them individually. For more information, see the following
topics:

• Install Cisco Crosswork Cluster on Amazon EC2, on page 150

• Install Crosswork Data Gateway on Amazon EC2, on page 151

• Install Cisco NSO on Amazon EC2, on page 156

• Deploy an Additional Crosswork Cluster Node, on page 157

Install Cisco Crosswork Cluster on Amazon EC2
This section provides an overview of how Cisco Crosswork cluster is installed on Amazon EC2.

Cisco Crosswork uses a set of CF templates to deploy Crosswork cluster.

Crosswork Cluster Deployment Workflow

The Crosswork cluster deployment procedure involves deploying various Crosswork resources using the
corresponding YAML files.
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Table 48: Resources Deployed During Crosswork Cluster Deployment

DescriptionResource

Themain stack (cw-cluster.yaml) which will deploy other nested stacks
for creating EC2 CW NLBs.

EC2 Cluster

The cw-mgmt-nlb.yaml file creates Network Load Balancer, Target
Groups, Listeners and Route53Record for EC2CWManagement Nodes.

Management NLB

The cw-data-nlb.yaml file creates Network Load Balancer, Target
Groups, Listeners and Route53Record for EC2 CW Data Nodes

Data NLB

Installation Parameters

For list of important parameters that you must specify in the CF templates that are used to deploy Crosswork
cluster, see CF Template Parameters for Installing Cisco Crosswork Cluster VMs, on page 138. Crosswork
cluster is deployed on Amazon EC2 based on the parameters specified in the templates.

Once you have determined the subnet for your cluster nodes and any other virtual machines you are going to
deploy, confirm that there are enough available IP addresses to support the number of VMs (and virtual IP
addresses) needed.

Note

Deploy the CF Templates

You can install the Crosswork cluster on Amazon EC2 by customizing the CF templates. For the list of CF
templates that are used for Crosswork cluster deployment, see Crosswork Cluster Deployment Workflow, on
page 150.

For instructions on how to deploy the CF templates on Amazon EC2, see Deploy a CF Template, on page
158.

Verify the Installation

Verify that the Crosswork cluster installation is successful by following the steps in Monitor the Installation,
on page 159.

Deploy an Additional Crosswork Cluster Node

For instructions on how to deploy an additional worker/hybrid node on the Crosswork cluster, see Deploy an
Additional Crosswork Cluster Node, on page 157.

What to do next

Return to the installation workflow: Install Cisco Crosswork Network Controller on AWS EC2, on page 13

Install Crosswork Data Gateway on Amazon EC2
This section provides an overview of how Crosswork Data Gateway is installed on Amazon EC2.
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Crosswork Data Gateway Deployment Workflow

The Crosswork Data Gateway deployment procedure involves deploying various Crosswork resources using
the corresponding YAML files.

The main file cdg-stack-ec2.yaml deploys the stacks for one CDG NLB (cdg-nlb.yaml) and two CDG
(cdg.yaml).

• An additional Crosswork Data Gateway VM to the Crosswork Data Gateway high availability pool is
deployed using the cdg.yaml file. For each additional VM deployment, you must repeat the deployment
procedure.

• An additional NLB andCrossworkDataGateway high availability pool is deployed using the cdg-nlb.yaml
file.

The following table provides information about the components are installed:

Table 49: Resources Deployed During Crosswork Data Gateway Deployment

DescriptionResource

The resources related to EC2 node are created by deploying
the cdg.yaml file.

EC2 Crosswork Data Gateway

The EC2 NLB components (target groups, network load
balancer, data listeners, and NLB route 53 record) are created
by deploying the cdg-nlb.yaml file.

Crosswork Data Gateway Network Load
Balancer

Installation Parameters

For list of important parameters in the Crosswork Data Gateway CF templates, see CF Template Parameters
for Installing Crosswork Data Gateway, on page 144.

Crosswork Data Gateway is deployed on Amazon EC2 based on the parameters specified in the CF templates.
For list of CF templates that are used for Crosswork Data Gateway deployment, see Crosswork Data Gateway
Deployment Workflow, on page 152.

Deploy the CF Templates

For instructions on how to deploy the CF templates on Amazon EC2, see Deploy a CF Template, on page
158.

Amazon EC2 mandates entering an IP address for the vNIC2 interface when Crosswork Data Gateway is
deployed using 3 NICs. This is an AWS EC2 requirement and not imposed by Crosswork.

Note

Verify the Installation

Verify that the Crosswork Data Gateway installation is successful by following the steps in Monitor the
Installation, on page 159.

Cisco Crosswork Network Controller 6.0 Installation Guide
152

Install Cisco Crosswork Network Controller on AWS EC2
Install Crosswork Data Gateway on Amazon EC2



What to do next

Return to the installation workflow: Install Cisco Crosswork Network Controller on AWS EC2, on page 13

Auto-Configuration for Deploying Crosswork Data Gateway
The auto-configuration procedure discovers the configuration parameters that are missing, and it automatically
defines the mandatory parameters to install Base VM. The configuration parameters are passed using the
Dynamic Host Configuration Protocol (DHCP) framework. In the Day 0 configuration, the auto-configuration
mechanism defines only the essential parameters with the default values.

A default password is provided during the auto-configuration to comply with the security policies. On the
initial log in, the dg-admin and dg-oper users must change the default password. The Crosswork Data Gateway
services are inactive until the default password is changed.

The auto-configuration process supports the default 3 NIC deployment. In particular, only eth0 is configured
for the Management network.

The DHCP interaction takes place over the eth0 interface. The auto-configuration procedure uses the default
values stored on the DHCP server. After Base VM is deployed, you can configure or modify the default values
using the Interactive Console. For more information about the console, seeCisco Crosswork Network Controller
6.0 Administration Guide.

The auto-configuration mechanism is not supported for deploying Crosswork Data Gateway on the VMware
platform.

Important

Parameters used during Auto-Configuration

The auto-configuration utility configures the following parameters with the default values. For more information
about these parameters, see Cisco Crosswork Data Gateway Parameters and Deployment Scenarios, on page
80.

Table 50: Cisco Crosswork Data Gateway Mandatory Deployment Parameters

Default ValueParameterName

The default value is Yes.AllowRFC8190AllowRFC8190

The default port is 60.AuditdPortAuditd Server Port

The default port is 30607.ControllerPortCrosswork Controller
Port

The default value is CDG auto configure.DescriptionDescription

The default password is changeme.

Reset the default value with the password that you have
chosen for the dg-admin user.

Password must be 8-64 characters.

dg-adminPassworddg-admin Passphrase
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Default ValueParameterName

The default password is changeme.

Reset the default value with the password you have
chosen for the dg-oper user.

Password must be 8-64 characters.

dg-operPassworddg-oper Passphrase

The default value of this parameter is 5.DGAppdataDiskData Disk Size

The default values of this parameter are

208.67.222.222

208.67.220.220

DNSDNS Address

The default value of this parameter is False.DNSSECDNS Security Extensions

The default value of this parameter is False.DNSTLSDNS over TLS

The default value of this parameter is localdomain.DomainDNS Search Domain

The default value of this parameter is L2.HANetworkModeCrossworkDataGateway
HA mode

The default value of this parameter is dg-<eth0
address>.

Where <eth0-address> is the address of vNIC0.

HostnameHostname

The default value of this parameter is False.LLMNRLink-Local Multicast
Name Resolution

The default value of this parameter is False.mDNSMulticast DNS

The default value of this parameter is eth0.NicAdministrationNicAdministration

The default value of this parameter is eth1.NicControlNicControl

The default value of this parameter is eth0.NicDefaultGatewayNicDefaultGateway

The default value of this parameter is eth0.NicExternalLoggingNicExternalLogging

The default value of this parameter is eth0.NicManagementNicManagement

The default value of this parameter is eth1.NicNBExternalDataNicNBExternalData

The default value of this parameter is eth1.NicNBSystemDataNicNBSystemData

The default value of this parameter is the last active
interface such as eth0 for 1-NIC deployment, eth1 for
2-NIC.

NicSBDataNicSBData
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Default ValueParameterName

The default values of this parameter are

162.159.200.1

65.100.46.164

40.76.132.147

104.131.139.195

NTPNTPv4 Servers

The default value of this parameter is False.NTPAuthUse NTPv4
Authentication

The default value of this parameter is Standard.ProfileProfile

The default value of this parameter is Simultaneous.SyslogMultiserverModeSyslogMultiserverMode

The default value of this parameter is 514.SyslogPortSyslog Server Port

The default value of this parameter is UDP.SyslogProtocolSyslog Server Protocol

The default value of this parameter is False.SyslogTLSUse Syslog over TLS

The default value of this parameter is False.UseRemoteAuditdUse Remote Auditd
Server

The default value of this parameter is False.UseRemoteSyslogUse Remote Syslog
Server

The default value of this parameter is DHCP.Vnic0IPv4MethodvNIC IPv4 Method

The default value of this parameter is False.Vnic0IPv4SkipGatewayvNIC IPv4 Skip Gateway

The default value is None.Vnic0IPv6MethodvNIC IPv6 Method

The default value is False.Vnic0IPv6SkipGatewayvNIC IPv6 Skip Gateway

The default value is DHCP.Vnic1IPv4MethodvNIC IPv4 Method

The default value is False.Vnic1IPv4SkipGatewayvNIC IPv4 Skip Gateway

The default value is None.Vnic1IPv6MethodvNIC IPv6 Method

The default value is False.Vnic1IPv6SkipGatewayvNIC IPv6 Skip Gateway

The default value is DHCP.Vnic2IPv4MethodvNIC IPv4 Method

The default value is False.Vnic2IPv4SkipGatewayvNIC IPv4 Skip Gateway

The default value is None.Vnic2IPv6MethodvNIC IPv6 Method

The default vale is False.Vnic2IPv6SkipGatewayvNIC IPv6 Skip Gateway
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Install Cisco NSO on Amazon EC2
This section provides an overview of how Cisco NSO is installed on Amazon EC2.

Cisco Crosswork uses a set of CF templates to deploy NSO.

NSO Deployment Workflow

The NSO deployment procedure involves deploying various Crosswork resources using the corresponding
YAML files.

The nso-stack-ec2.yaml file deploys stacks for one NSONLB (nso-nlb-ec2.yaml) and twoNSOs (nso.yaml).
See below table for more information.

Table 51: Resources Deployed During NSO Deployment

DescriptionResource

The nso.yaml file is deployed to create the EC2 node resources (network interface
and an instance) in the stack.

EC2 NSO

The nso-nlb-ec2.yaml file is deployed to create the EC2 NLB resources (target
groups, network load balancer, data listeners, and NLB route 53 record) in the
stack.

NSO NLB

Installation Parameters

For list of important parameters that you must specify in the CF templates that are used to deploy NSO, see
CF Template Parameters for Installing NSO, on page 147. NSO is deployed on Amazon EC2 based on the
parameters specified in the templates.

While deleting the NSO setup, delete the NSO Route53 Record (NsoRoute53RecordName) manually.Note

Deploy the CF Templates

You can install NSO on Amazon EC2 by customizing the CF templates. For list of CF templates that are used
for NSO deployment, see NSO Deployment Workflow, on page 156.

For instructions on how to deploy the CF templates on Amazon EC2, see Deploy a CF Template, on page
158.

Verify the Installation

Verify that the NSO installation is successful by following the steps in Monitor the Installation, on page 159.

What to do next

Return to the installation workflow: Install Cisco Crosswork Network Controller on AWS EC2, on page 13

Cisco Crosswork Network Controller 6.0 Installation Guide
156

Install Cisco Crosswork Network Controller on AWS EC2
Install Cisco NSO on Amazon EC2



Deploy an Additional Crosswork Cluster Node
This section explains how to deploy an additional worker/hybrid node on the Crosswork cluster.

Deploying an additional node on the Crosswork cluster involves deploying the Crosswork network configuration
and VM customization resources using the cw-add-vm.yaml file.

Before deploying an additional worker node, ensure that the Crosswork cluster and Crosswork application
have been created.

Important

A new hybrid node MUST reuse the same IP addresses as the hybrid VM it is replacing, and a maximum of
3 hybrid nodes are allowed.

Note

Installation Parameters

For list of important parameters that you must specify in the CF template that is used to deploy an additional
node on the Crosswork cluster, see CF Template Parameters for Installing Single Hybrid Cluster or Worker
Node, on page 148. Additional nodes are deployed on the Crosswork cluster based on the parameters specified
in the templates.

Deploy the CF Templates

You can install an additional worker/hybrid node on the Crosswork cluster by customizing the CF template.

For instructions on how to deploy the CF templates on Amazon EC2, see Deploy a CF Template, on page
158.

Verify the Installation

Verify that the nodes are attached to the Crosswork cluster. On the EC2 console, select the Crosswork cluster
and make sure that the nodes that you added appear under the Compute section. For more information, see
Monitor the Installation, on page 159.

What to do next

Return to the installation workflow: Install Cisco Crosswork Network Controller on AWS EC2, on page 13

Manage CF Template Deployment
The following sections explain how to deploy a CF template on Amazon EC2 and verify its installation:

• Deploy a CF Template, on page 158

• Monitor the Installation, on page 159
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Deploy a CF Template
You can install Crosswork on Amazon EC2 with custom resources. Depending on the configured parameters,
the needed components with the capabilities are also installed.

Before you begin

• Make sure that you have met the Table 27: AWS Prerequisites and Settings and Amazon EC2 Settings
prescribed for installing Crosswork on Amazon EC2.

• Ensure that you have access to the CloudFormation templates that are stored in the S3 bucket or on your
local machine. If the template is in Amazon S3, keep the URL of the template file copied.

Step 1 Log in to the AWS account and navigate to the S3 bucket. If the CF template is on your local computer, you can upload
the template.

Step 2 In the AWS CloudFormation console, navigate to the Stacks page and choose Create stack > With new resources
(standard). The Create stack page opens.

Step 3 Enter the following details:

a. Under Prerequisite - Prepare template, select Template is ready.

b. Under Specify template > Template source, select one of the following options:

• If you have the YAML or JSON file URL directing to the S3 bucket where the CF template is located, select
Amazon S3 URL. In the Amazon S3 URL field, enter the URL and click Next.

• If the CF template is saved on your local computer, select Upload a template file and click Choose File to
select the file that you want to upload. After you have selected the template, Amazon uploads the file and displays
the S3 URL. Click Next.

(Optional) ClickView in Designer to view a visual representation of the execution flow in your CF template.Note

Step 4 In the Specify stack details page, enter the relevant values for the stack name and parameter values. Click Next.

The parameter field names visible in this window are defined by the parameters in the CF template.Note

Step 5 Review the parameter values that you have configured.
Step 6 Under the Capabilities, select the check boxes next to:

• I acknowledge that AWS CloudFormation might create IAM resources with custom names.

• I acknowledge that AWS CloudFormation might require the following capability:
CAPABILITY_AUTO_EXPAND.

Step 7 Click Submit.
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What to do next

The time taken to create the cluster can vary based on the size of your deployment profile and the performance
characteristics of your hardware. See Monitor the Installation, on page 159 to know how you can check the
status of the installation.

Monitor the Installation
This section describes how to verify if the deployment is complete without errors.

Step 1 In the CloudFormation console, from the left-hand side Stacks pane, select the stack that you have deployed.
Step 2 The stack details are displayed on the right. Click on each tab in this window to view details of the stack. If the stack

creation is in progress, the status of the stack in the Events tab is CREATE_IN_PROGRESS.
Step 3 After the stack is created:

• The status of the stack changes to CREATE_COMPLETE and the Logical ID displays the stack name.

• The Resources tab displays details of the all the resources that the CF template has created, including the physical
IDs.

• The Outputs tab has details of the VM's interface IP addresses.

What to do next

After the stack creation is complete, you can access the Crosswork UI and monitor the health of your cluster.
For more information on how to log in to the Crosswork UI, see Accessing the Crosswork UI, on page 159.

Accessing the Crosswork UI
After the stacks are created, you can check if all the nodes are up and running in the cluster from the Cisco
Crosswork UI.

Before you begin

• Ensure that you have a spare Network Load Balancer (NLB). To access Crosswork UI, use an external
NLB that routes requests to its targets using the protocol DNS and port number that you specify.

• Verify that the Crosswork cluster and pods are in the running state. For information on how to view the
status of the cluster, see Monitor the Installation, on page 159.

• Make sure to keep the IP address of the Management node copied. This IP address is used to access the
Crosswork UI. You can copy the IP address from the Outputs tab of the CloudFormation console. For
information on accessing the Outputs tab, see Monitor the Installation, on page 159.

Step 1 Log in to the AWS console and navigate to Target Groups to register the targets.
Step 2 Under Targets, click Register targets. The Register targets page opens.
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Step 3 In the IPv4 address, specify the Management IP address that you copied from the CloudFormation console.
Step 4 Specify the port as 30603. Click Include as pending below

Step 5 Click Register pending targets.

To deregister the targets that are no longer in use, select the target and click Deregister.

Step 6 After the target is in the healthy state, click on the load balancer name under Details. The Load balancer page opens.
Step 7 Copy the DNS name from the DNS name column.
Step 8 Launch a supported browser and enter the following in the address bar: https://<DNS_name>:30603/

When you access Cisco Crosswork for the first time, some browsers display a warning that the site is
untrusted.When this happens, follow the prompts to add a security exception and download the self-signed
certificate from Cisco Crosswork server. After you add a security exception, the browser accepts the server
as a trusted site in all future login attempts. If you want to use a CA signed certificate, see the Manage
Certificates section in Crosswork Network Controller 6.0 Administration Guide.

Note

Step 9 Log in to Cisco Crosswork as follows:

a. Enter the Cisco Crosswork administrator username admin and the default password admin.

b. Click Log In.

c. When prompted to change the administrator's default password, enter the new password in the fields provided, and
then click OK.

Use a strong VMPassword (minimum 8 characters long, including upper & lower case letters, numbers,
and one special character). Avoid using passwords similar to dictionary words (for example,
"Pa55w0rd!") or relatable words (for example, C!sco123 or Cwork321!).

Note

Step 10 (Optional) Click on the Crosswork Health tab, and click on the Crosswork Infrastructure tile to view the health status
of the microservices running on Cisco Crosswork.

What to do next

Return to the installation workflow: Install Cisco Crosswork Network Controller on AWS EC2, on page 13

Crosswork Data Gateway Post-installation Tasks
This section lists the steps that you can complete after you have deployed Crosswork Data Gateway.

Configure Timezone of the Crosswork Data Gateway VM
In general, the Crosswork Data Gateway VM launches with the default timezone as UTC. Cisco recommends
that you configure the timezone to match your geographical area. With this configuration, all the Crosswork
Data Gateway processes including the Showtech logs use the same configured timezone.

Step 1 In Crosswork Data Gateway VM interactive menu, select Change Current System Settings.
Step 2 Select 9 Timezone.
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Step 3 Select the geographic area in which you live.

Figure 30: Timezone Settings - Geographic Area Selection

Step 4 Select the city or region corresponding to your timezone.

Figure 31: Timezone Settings - Region Selection

Step 5 Select OK to save the settings.
Step 6 Reboot the Crosswork Data Gateway VM so that all processes pick up the new timezone.

Cisco Crosswork Network Controller 6.0 Installation Guide
161

Install Cisco Crosswork Network Controller on AWS EC2
Configure Timezone of the Crosswork Data Gateway VM



Step 7 Log out of the Crosswork Data Gateway VM.

Log in and Log out of Crosswork Data Gateway VM
This section describes how to log in and out to the Crosswork Data Gateway VM.

Follow these steps to access and log out of the Crosswork Data Gateway VM:

• Access Crosswork Data Gateway VM from SSH, on page 162

• Log out of Crosswork Data Gateway VM, on page 162

Access Crosswork Data Gateway VM from SSH
Secure Shell (SSH) offers a protection from brute force attacks by blocking the client IP after several login
failures. Failures such as incorrect username or password, connection disconnect, or algorithm mismatch are
counted against the IP. Up to 4 failures within a 20 minute window causes the client IP to be blocked for at
least 7 minutes. Continuing to accumulate failures cause the blocked time to be increased. Each client IP is
tracked separately.

Follow these steps to log in to the Cisco Crosswork Data Gateway VM from SSH.

Step 1 From your work station with network access to the Cisco Crosswork Data Gateway management IP, run the following
command:

ssh <username>@<ManagementNetworkIP>

where ManagementNetworkIP is the management network IP address.

For example,

To login as administrator user: ssh dg-admin@<ManagementNetworkIP>

To log in as operator user: ssh dg-oper@<ManagementNetworkIP>

The Crosswork Data Gateway flash screen opens prompting for password.

Step 2 Input the corresponding password (the one that you created during installation process) and press Enter.

If you are unable to access the Cisco Crosswork Data Gateway VM, there is an issue with your network
configuration settings. From the console, check the network settings. If they are incorrect, it is best to delete
the Cisco Crosswork Data Gateway VM and reinstall with the correct network settings.

Log out of Crosswork Data Gateway VM
To log out of the VM, from the Main Menu, select l Logout and press Enter or click OK.

Troubleshoot Crosswork Data Gateway Installation and Enrollment
If Crosswork Data Gateway fails to auto-enroll with Cisco Crosswork, you can collect Crosswork Data
Gateway show-tech (Main menu > 5 Troubleshooting > 2 Run show-tech) and check for the reason in
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controller-gateway logs. For more information on how to collect show-tech logs, see the Collect show-tech
logs from the Interactive Console section in Cisco Crosswork Network Controller 6.0 Administration Guide.
If there are session establishment or certificate-related issues, ensure that the controller.pem certificate is
uploaded using the Interactive Console.

When using an IPv6 address, it must be surrounded by square brackets ([1::1]).Important

The following table lists common problems that might be experienced while installing or enrolling Crosswork
Data Gateway, and provides approaches to identifying the source of the problem and solving it.

Table 52: Troubleshooting the Installation/Enrollment

ActionIssue

1. Log in to the Crosswork Data Gateway VM.

2. From the main menu, select 5 Troubleshooting >
2 Run show-tech.

Enter the destination to save the tarball containing
logs and vitals and click OK.

The show-tech is now encrypted with a file extension
ending with .tar.xz.

3. Run the following command to decrypt the
show-tech file.

openssl enc -d -AES-256-CBC -pbkdf2 -md

sha512 -iter 100000 -in <showtech file> -out

<decrypted filename> -pass pass:<encrypt

string>

In the show-tech logs (in file session.log at location
/opt/dg/log/controller-gateway/session.log),
if you see the error UNAUTHENTICATED:invalid
certificate. reason: x509: certificate has

expired or is not yet valid, then there is a
clock-drift between Crosswork Data Gateway and
Cisco Crosswork.

3. From the main menu, go to 3 Change Current
System Settings > 1 Configure NTP.

Configure NTP to sync with the clock time on the
Cisco Crosswork server and try reenrolling Crosswork
Data Gateway.

Crosswork Data Gateway cannot be enrolled with
Cisco Crosswork due to an NTP issue, i.e., there
is a clock-drift between the two.

The clock-drift might be with either Crosswork
Data Gateway or Cisco Crosswork.

Also, on the NTP servers for Cisco Crosswork and
Crosswork Data Gateway, the initial time is set to
the ESXi server. For this reason, the ESXi server
must also have NTP configured.

Sync the clock time on the host and retry.
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ActionIssue

1. Log in to the Crosswork Data Gateway VM.

2. From the main menu, select 5 Troubleshooting >
2 Run show-tech.

Enter the destination to save the tarball containing
logs and vitals and click OK.

The show-tech is now encrypted with a file extension
ending with .tar.xz.

3. Run the following command to decrypt the
show-tech file.

openssl enc -d -AES-256-CBC -pbkdf2 -md

sha512 -iter 100000 -in <showtech file> -out

<decrypted filename> -pass pass:<encrypt

string>

In the show-tech logs (in file gateway.log at location
/opt/dg/log/controller-gateway/gateway.log),
if you see certificate errors, then reupload the
Controller Signing Certificate, as explained in the
steps below:

1. From the main menu, select 3 Change Current
System Settings > 7 Import Certificate.

2. From the Import Certificates menu, select 1
Controller Signing Certificate File and click OK.

3. Enter the SCP URI for the certificate file and click
OK.

Crosswork Data Gateway remains in degraded
state for more than 10 minutes with reason stated
as "Could not collect vitals" due to certificate
errors.

1. Reupload the certificate file using the following
steps:

a. From the main menu, select 3 Change Current
System Settings > 7 Import Certificate.

b. From the Import Certificates menu, select 1
Controller Signing Certificate File and click OK.

c. Enter the SCP URI for the certificate file and click
OK.

2. Reboot the CrossworkData GatewayVM following
the steps below:

a. From the main menu, select 5 Troubleshooting
and click OK.

b. From the Troubleshooting menu, select 4 Reboot
VM and click OK.

c. Once the reboot is complete, check if the Crosswork
Data Gateway's operational status is Up.

Crosswork Data Gateway remains in degraded
state for more than 10 minutes with reason stated
as "gRPC connection cannot be established" due
to certificate errors.
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ActionIssue

Reenroll or redeploy the Crosswork Data Gateways.
For more information, see the Redeploy a Crosswork
Data Gateway Instance and Reenroll Crosswork Data
Gateway sections in Cisco Crosswork Network
Controller 6.0 Administration Guide.

During a Crosswork upgrade, some of the
Crosswork Data Gateways may not get upgraded
or reenrolled leading to logging multiple error
messages in the dg-manager logs.

1. Log in to the Crosswork UI from the SSH.

2. Run the Docker executive commands to access the
robot-astack-influxdb pod.

3. In the pod, navigate to the following directory and
delete it:

/mnt/datafs/influxdb

4. Restart the service using the following command:

supervisorctl restart all

If a Crosswork Data Gateway instance that was
previously attached to Crosswork is now
reattached to a different Crosswork version 4.x or
5.0, the operational state of the instance may be
Degraded with the robot-astack-influxdb error.

Move the Data Gateway to the Maintenance mode
or manually reenroll the gateway. For more
information, see the Reenroll Crosswork Data
Gateway section in Cisco Crosswork Network
Controller 6.0 Administration Guide.

If Data Gateway is redeployed without moving the
gateway to the Maintenance mode, Crosswork
enrollment will be unsuccessful and errors will be
logged in the dg-manager and controller-gateway
logs.

Import Controller Signing Certificate File
The Controller Certificate file is automatically imported after the VM boots. If there is an import failure, the
Crosswork Data Gateway VM makes several attempts to import the certificate while giving you the option
to manually import it.

• You have not specified the Controller Signing Certificate File URI under the Controller Settings
during installation.

• Cisco Crosswork was upgraded or reinstalled and you need to authenticate and enroll Crosswork Data
Gateway with Cisco Crosswork.

• Cisco Crosswork configuration is in-progress when Crosswork Data Gateway tries to import the Controller
Certificate file.

• The Cisco Crosswork Controller IP address in unreachable or incorrect.

• The Cisco Crosswork username or password is incorrect.

Follow these steps to import the controller signing certificate file:

Step 1 From the Cisco Crosswork Data Gateway VM's Interactive Menu, select 3 Change Current System Settings.

The Change System Settings menu opens.

Step 2 Select 7 Import Certificate.
Step 3 From the Import Certificates menu, select 1 Controller Signing Certificate File.
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Step 4 Enter the SCP URI for the certificate file.

An example URI is given below:

cw-admin@{server ip}:/home/cw-admin/controller.pem

Step 5 Enter the SCP passphrase (the SCP user password).

The certificate file is imported.

Step 6 Verify that the certificate was installed successfully. See View the Controller Signing Certificate File, on page 118.

View the Controller Signing Certificate File
Follow these steps to view the signing certificate:

Step 1 From the Crosswork Data Gateway VM's interactive menu, select 2 Show System Settings.
Step 2 From the Show Current System Settings menu, select 7 Certificates.
Step 3 Select 2 Controller Signing Certificate File.

Crosswork Data Gateway displays the default certificate if no new certificate has been imported. Otherwise, it displays
the new certificate if it was successfully imported.
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P A R T IV
Install Crosswork Applications

• Install Crosswork Applications, on page 169





C H A P T E R 9
Install Crosswork Applications

This chapter contains the following topics:

• Install Crosswork Applications, on page 169

Install Crosswork Applications
This section explains how to install Crosswork applications on the Cisco Crosswork UI.

The Crosswork Network Controller applications are bundled asEssentials,Advantage, andAdd-on packages
(see Crosswork Applications, on page 2 for more information). Every package contains crosswork applications
in a particular format unique to Crosswork known as CAPP (Crosswork APPlication). As a first step, the
packages containing the application CAPP files (*.tar.gz) must be downloaded from cisco.com to a machine
reachable from the Cisco Crosswork server. The package is then added to the Crosswork UI where the
applications within can be installed.

You must first download the relevant Crosswork Netwok Contoller package (Essential or Advantage or
Add-on) from cisco.com and then proceed to install the applications which are part of the package.

Before you begin

Ensure that all requirements of your application are met.

Step 1 Download and validate the CAPP files:

a) Navigate to cisco.com and download the signed Crosswork Network Controller package that you require to a directory
in your machine. For the purpose of these instructions, we will use the file name
"signed-cw-na-cncessential-6.0.0-85-release-231211.tar.gz".

b) Decompress the signed Crosswork Network Controller package.
tar -xvf <signature file>

Example:
cd <folder where tar was download>
tar -xvf signed-cw-na-cncessential-6.0.0-85-release-231211.tar.gz
README
cw-na-cncessential-6.0.0-85-release-231211.tar.gz
cw-na-cncessential-6.0.0-85-release-231211.tar.gz.signature
CW-CCO_RELEASE.cer
cisco_x509_verify_release.py3
cisco_x509_verify_release.py
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c) Use python script to validate the signature of each file you plan to use.

Use python --version to find out the version of Python on your machine.Note

If you are using Python 2.x, use the following command to validate the file:
python cisco_x509_verify_release.py -e <.cer file> -i <.tar.gz file> -s <.tar.gz.signature file>
-v dgst -sha512

If you are using Python 3.x, use the following command to validate the file:
python cisco_x509_verify_release.py3 -e <.cer file> -i <.tar.gz file> -s <.tar.gz.signature file>
-v dgst -sha512

Example:
python cisco_x509_verify_release.py3 -s cw-na-cncessential-6.0.0-85-release-231211.tar.gz.signature
-i cw-na-cncessential-6.0.0-85-release-231211.tar.gz -e CW-CCO_RELEASE.cer
Retrieving CA certificate from http://www.cisco.com/security/pki/certs/crcam2.cer ...
Successfully retrieved and verified crcam2.cer.
Retrieving SubCA certificate from http://www.cisco.com/security/pki/certs/innerspace.cer ...
Successfully retrieved and verified innerspace.cer.
Successfully verified root, subca and end-entity certificate chain.
Successfully fetched a public key from CW-CCO_RELEASE.cer.
Successfully verified the signature of cw-na-cncessential-6.0.0-85-release-231211.tar.gz using
CW-CCO_RELEASE.cer

If you do not have python installed, go to python.org and download the version of python that is
appropriate for your work station.

Note

Step 2 Add the downloaded CAPP file to Crosswork:

a) Log into Cisco Crosswork and in the homepage, click on Administration > Crosswork Manager. The Crosswork
Summary page is displayed with Crosswork Cluster and Crosswork Platform Infrastructure tiles.

You can click on the tiles to get more information.

b) Click on Application Management and select the Applications tab.

c) Click on the Add File (.tar.gz) option to add the package that contains the CAPP files.

When installing a Crosswork Network Controller package, there is no need to untar the package. You
can add the package tarball as-is to the Crosswork UI and the applications within are automatically added.
You can then install the individual applications as needed.

Note

d) In the Add File dialog box, enter the relevant information and click Add.

The add operation progress is displayed on the Applications screen. You can also view the installation progress in
the Job History tab.

When loading a Crosswork Network Controller package, the loading process may stop at 50% for a while
depending on the resources your host platform has available.

Note

The newly added application files are displayed as tiles on the Applications screen.

Step 3 Install the Application CAPP file:

a) Click on the Install prompt on the application tile. You can also click on the tile, and select the Install option
from the drop down list.
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After you install Crosswork Cluster and Crosswork Data Gateway, the applications in the Crosswork
Network Controller package (Essential or Advantage) need to be installed in the following sequence:

1. Crosswork Optimization Engine

2. Crosswork Active Topology

3. Crosswork Service Health (only available in Advantage package)

4. Element Management Functions (EMF)

Crosswork Change Automation, Crosswork Health Insights, and Crosswork Zero Touch Provisioning
can be installed independently in any order and do not require any other application to be installed prior.

Important

The application is now installed. You can observe the change in the application tile icon. Once an application is
installed, all the related-resources, UI screens and menu options are dynamically loaded in the Crosswork UI.

Once an application is installed, the 90-day evaluation period will automatically start. You can register
the application with your Cisco Smart Account in the the Smart License tab.

Note

b) After an application is installed, it must be activated to become functional. The first-time installation also activates
a CAPP file. However, if the activation fails after a successful installation, you can manually activate the application.

To manually activate an application, click the on the application tile, and select Activate.

Step 4 Repeat step 3 for installing any remaining applications.

Step 5 (Optional) Click on the application tile, and select theView Details option to view details of the installed application.
Step 6 Once an application (or all applications) have been installed, check the health of the environment to make sure all the

applications are healthy. It can take up to an hour for all the processes that make launch and for the applications to report
as healthy. If after an hour a newly installed application is not healthy after an hour, contact the Cisco Customer Experience
team.

What to do next

Return to the installation workflow:

• VMware: Install Cisco Crosswork Network Controller on VMware vCenter, on page 11

• AWS EC2: Install Cisco Crosswork Network Controller on AWS EC2, on page 13
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• Integrate Cisco NSO, on page 175
• Integrate SR-PCE, on page 189





C H A P T E R 10
Integrate Cisco NSO

This chapter contains the following topics:

• NSO Integration Workflow, on page 175
• Install Cisco NSO Function Pack Bundles from Crosswork UI, on page 176
• Install Cisco NSO Function Packs Manually, on page 185
• Add Cisco NSO Providers, on page 185
• (Optional) Set up Cisco NSO Layered Service Architecture, on page 187

NSO Integration Workflow
This section explains the steps in integrating Cisco NSO with Crosswork Network Controller.

1. Install the compatible version of Cisco NSO

Ensure that you have installed the compatible version of Cisco NSO:

• If you are a VMware user, follow the instructions in NSO documentation.

• If you are a AWS EC2 user, follow the instructions in Install Cisco NSO on Amazon EC2, on page 156.

Additionally, for Cisco NSO LSA setup, see (Optional) Set up Cisco NSO Layered Service Architecture, on
page 187.

See the Compatibility Information section in the Crosswork Network Controller 6.0 Release Notes for
information on the compatible versions of NSO/NED.

2. Install the mandatory NSO core function packs

Depending on the Cisco Crosswork application or solution that you are using, there are mandatory Core
Function Packs (CFPs) that must be installed on Cisco NSO to make the products compatible.

The NSO core function packs are bundled in cisco.com as follows:
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Table 53: NSO Core Function Packs

ContentsPackage Name

• Cisco NSO Transport SDN Function Pack
Bundle

• Cisco NSO DLM Service Pack

• Cisco NSO Telemetry Traffic Collector Function
Pack

Cisco Crosswork Network Controller Essential
Function Pack

File name: signed-cw-cnc-essential-fp-6.0.0.tar.gz

• Cisco Crosswork Change Automation NSO
Function Pack

Cisco Crosswork Change Automation Function Pack

File name: nca-6.0.0-nso-6.1.4.signed.bin

You can install the CFPs using either of the following methods:

• Install Cisco NSO Function Pack Bundles from Crosswork UI, on page 176 (Recommended)

• Install Cisco NSO Function Packs Manually, on page 185

The Cisco Crosswork Network Controller Function Pack SDK Application
(cw-na-platform-6.0.0-signed-tsdn-sdk.tar.gz) is also available for download on cisco.com. The SDK provides
tools and source-code examples you can use to develop, build, package and deploy the TSDN function pack
on Crosswork Network Controller.

Note

3. Add the NSO provider and verify connectivity

Follow the instructions in Add Cisco NSO Providers, on page 185.

Install Cisco NSO Function Pack Bundles from Crosswork UI
In the Cisco NSO function pack bundles, the NSO function pack files are bundled as tar.gz files. To ensure
interoperability with Crosswork, Cisco NSO requires the installation of the essential function packs.

In the Crosswork UI, the NSO Deployment Manager tab lets you manage the function pack bundles using
the following tabs:

• Installed NSO Function Packs: Provides the list of NSO function packs deployed on the configured
NSO server. See View NSO Function Pack Bundles, on page 177 for more information.

• NSO Function Pack Bundles: Allows you to add and deploy the function pack bundles. Use this tab,
to view the artifacts in the function pack bundle, download, and delete the function pack bundles. See
Manage NSO Function Pack Bundles, on page 178 for more information.

• Job History: Displays the status of the function pack jobs since they were submitted. The Job History
tab displays a summary of the jobs, job ID, time when the job is started and completed, job description,
and target. See View NSO Function Pack Job History, on page 184 for more information.
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Figure 32: NSO Deployment Manager Window

View NSO Function Pack Bundles
The Crosswork UI provides the list of function pack bundles installed on each available NSO server. The
bundles include the default and the custom functions pack bundles that you have uploaded to the Crosswork
UI.

If any of the NSO service providers is unreachable, you cannot view the installed NSO function packs. An
error "Server is temporarily unavailable, try to relogin" is displayed.

Attention

Follow the steps below to view the installed NSO function pack bundles through the UI.

Step 1 From the main menu, choose Administration > Crosswork Manager, click the NSO Deployment Manager tab.
Step 2 Click the Installed NSO Function Packs tab.
Step 3 Expand the bundles to view the number of function packs within each bundle, the function pack name, operational state

as Up or Down, description, and version.

Figure 33: Installed NSO Function Packs Window
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Manage NSO Function Pack Bundles
You can add and deploy customNSO function packs in addition to the function packs that are added by default
to the Crosswork UI. The preinstalled bundles include the following packs:

Table 54: Default NSO Core Function Packs Bundles

ContentsPackage Name

Cisco NSO DLM Service PackDLM NSO FP

Cisco Crosswork Change Automation NSO Function
Pack

Device Auth NSO FP

CiscoNSOTelemetry Traffic Collector Function PackTMTC NSO FP

Crosswork Network Controller NSO Function Packs
for VPN, TE, and Slice services. It also contains the
sample function packs.

CNC NSO FPs Plus Sample FPs

Crosswork Network Controller NSO function packs
for VPN, TE, and Slice services.

CNC NSO FPs

Before you begin

Each function pack bundle includes a metadata.yaml file detailing the prerequisites for installing the bundle
on NSO. The following is a comprehensive list of the prerequisites for the supplied function packs:

• Java version 11.0.0

• Python version 3.8.0

• NSO configured to allow 64,000 openFileDescriptors

Follow the steps below to manage the function pack bundles.

Step 1 Ensure that your NSO setup meets all of the prerequisites.

Check the python and java versions using the --version command.
python --version

Python 3.8.10

java --version

openjdk 17.0.9 2023-10-17
OpenJDK Runtime Environment (build 17.0.9+9-Ubuntu-120.04)
OpenJDK 64-Bit Server VM (build 17.0.9+9-Ubuntu-120.04, mixed mode, sharing)

Step 2 Click Test SSH Connectivity to validate if Crosswork is able to establish an SSH-based connection. The connectivity
test might take some time and must not be interrupted.

Step 3 From the main menu, choose Administration > Crosswork Manager, click the NSO Deployment Manager tab.
Step 4 Click the NSO Function Pack Bundles tab.
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All the installed NSO function pack bundles get displayed with the bundle name, version, and description information.

To manage the bundles, select one or more bundles and click the Action menu to perform the following:

• View FP Bundle Artifacts: View the hierarchy of the artifacts that are bundled in the selected package.

• Download FP Bundle: Download the function pack bundle.

• Delete FP Bundle: Delete the function pack bundle.

Figure 34: Action Menu

Step 5 Click Add New to install the new function pack bundle.
In the Add New NSO Function Pack Bundle page, enter the following:

• Host Name/IP address: Enter the IP address and subnet mask of the Cisco NSO server.

• Port: For HTTPS, enter the port that corresponds with what is configured on the NSO VM in etc/ncs/ncs.conf to
access NSO using HTTPS. NSO uses 8888 as the default port.

• User Name: The username used to log in to the NSO server.

• Password: The password credentials to authenticate into the NSO server.

• Server Path/Location: The server path of the NSO server.

Cisco Crosswork Network Controller 6.0 Installation Guide
179

Integrate Cisco NSO and SR-PCE with Cisco Crosswork Network Controller
Manage NSO Function Pack Bundles



Figure 35: Add New NSO Function Packs Bundle Window

Step 6 Click Test SSH Connectivity again to validate SSH-based connectivity. If the connection is successful, a confirmation
message indicating that the NSO bundle upload is in-progress appears. Click View Progress in Job History to view the
upload status.

Step 7 Click Add.

What to do next

After the function pack is added, deploy the function pack on NSO. See Deploy NSO Function Pack Bundles,
on page 180.

Deploy NSO Function Pack Bundles
This topic explains the process to deploy the NSO function pack bundles.

The Cisco NSO sample function packs are provided as a starting point for VPN service provisioning
functionality in Cisco Crosswork Network Controller. While the samples can be used “as is” in some limited
network configurations, they are intended to demonstrate the extensible design of Cisco Crosswork Network
Controller. Answers to common questions can be found on Cisco Devnet and Cisco Customer Experience
representatives can provide answers to general questions about the samples. Support for customization of the
samples for your specific use cases can be arranged through your Cisco account team.

Note
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Before you begin

• Ensure that the NSO function pack bundle is uploaded to the Crosswork UI. See Manage NSO Function
Pack Bundles, on page 178 for more information.

• If you plan to deploy the function pack bundle in an HA environment, you must have the primary and
secondary server details readily available.

• If your primary and secondary NSO servers and Crosswork servers are in different subnets, you must
configure either an IP static route or an IP rule policy to enable connectivity between the servers.

Static routes can only be configured when ZTP application is installed.Note

• Static routes configuration

From the Crosswork UI's main menu, select Administration > Settings > Static Routes. Click the

icon, enter the destination subnet IP address and mask (in slash notation), then click Add.

• IP rule configuration

Log in to the Crosswork server and execute the following command:

ip rule add from all to 10.19.0.4 lookup cw_data

Step 1 From the main menu, choose Administration > Crosswork Manager, click the NSO Deployment Manager tab.
Step 2 Click the NSO Function Pack Bundles tab.
Step 3 Select the NSO function pack bundle and click Deploy .

You can only select up to 3 Function Packs to be installed at a time. To install more, install the 3 function
packs first and then repeat this process until you have installed all the Function Packs you will use.

Note

Figure 36: NSO Function Pack Bundles Window

Step 4 In the Deploy Crosswork NSO FP Bundle page, enter the following SSH connection details:

• User Name: The SSH username for server access.

• Password: The SSH password for server access.

• Sudo Password: The SSH sudo password.
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Figure 37: SSH Connection Details Page

Step 5 Click Next.
Step 6 In the Deployment Target section, review the target details:

• Provider Name: Displays the name of the provider.

• Reachability: Displays the reachability status of the provider.

• CFS Role Selection: This column appears when a role is not assigned to a provider. Select the check box that
corresponds to the provider row to assign the customer-facing service (CFS) role. The resource-facing service
(RFS) role is automatically assigned to the other providers. For more information about CFS, RFS, and Cisco
NSO Layered Service Architecture (LSA) deployment concepts, see the Prepare Infrastructure for Device
Management chapter in the Cisco Crosswork Network Controller 6.0 Administration Guide.

• High Availability: Depending on your deployment preferences for the function packs bundle on an NSO node,
select either non-HA or HA. If you have selected HA, enter the server details in the Primary Server and Secondary
Server fields.

Figure 38: Deployment Target Page

Step 7 Click Next.
Step 8 In the Review & Deploy page, review the NSO bundle and deployment target details that you have configured. If you

want to modify your selection, click Previous to view the earlier pages and modify it as required.

If the provider is deployed on a standalone NSO node, the role is displayed as STANDALONE.Note
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Figure 39: Review Selection Page

Step 9 Click Deploy.
Step 10 Repeat the process for any additional Function Packs that you need to install.

Troubleshoot the NSO Function Pack Installation
The following table lists common problems that might be experienced while installing or deploying a Cisco
NSO function pack.
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Table 55: Troubleshooting the Function Pack Installation Issues

ActionIssue

In an HA configuration, the NSO engine assumes that
the NSO primary and secondary servers, and the
Crosswork server reside in the same subnet.

If the servers have different subnets, you must
configure an IP route or an IP rule policy to ensure
connectivity between the servers.When the routes are
not configured, the engine cannot locate the subnet,
and the function pack deployment fails.

Static routes can only be configured
when ZTP application is installed.

Note

Use one of the following steps to resolve the issue:

• To configure the static routes, from the main
menu, selectAdministration > Settings > Static

Routes. Click the icon, enter the destination
subnet IP address and mask (in slash notation),
then click Add.

• To configure the IP rule, log in to the Crosswork
server and use the following command:

ip rule add from all to 10.19.0.4 lookup

cw_data

The function pack deployment failed with the
following error:

Failed to open SSH connection to host

coffee-nso1.cisco.com

View NSO Function Pack Job History
The Job History tab shows the historical information of when jobs were started and ended, job ID, status,
and other vital information.

Follow the steps below to view the details of the jobs.

Step 1 From the main menu, choose Administration > Crosswork Manager, click the NSO Deployment Manager tab.
Step 2 Click the Job History tab.

In the Job History tab, the Job Sets pane displays the state of the job, job ID, and the job description. You can show or
hide the columns based on the job creation time, status, and description.

Step 3 In the Job Sets pane, select the job sets to view the associated job information in the Job Details pane. You can view
the summary of the job tasks based on job task ID, task status, the task start and end time, and description.

To view the job configuration information in JSON format, click the icon next to Job Config. A config window opens
that lets you view the configuration in the following modes:

• View Mode

• Text Mode
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Figure 40: Job History Window

Install Cisco NSO Function Packs Manually
If you need to install individual function packs manually, follow the relevant procedure from the below table:

Table 56: List of Mandatory Function Packs

Required Function Pack documentationCrosswork Product

• Cisco NSO Transport SDN Function Pack Bundle 6.0.0 User Guide

• Cisco NSO Transport SDN Function Pack Bundle 6.0.0 Installation
Guide

• Cisco Network Services Orchestrator DLM Service Pack 6.0.0
Installation Guide

• Cisco Crosswork NSO Telemetry Traffic Collector Function Pack
6.0.0 Installation Guide

• Cisco Crosswork Change Automation NSO Function Pack 6.0.0
Installation Guide

Crosswork Network Controller
Essentials

OR

Crosswork Network Controller
Advantage

• Cisco Network Services Orchestrator DLM Service Pack 6.0.0
Installation Guide

• Cisco Crosswork NSO Telemetry Traffic Collector Function Pack
6.0.0 Installation Guide

Crosswork Optimization Engine
(Standalone)

Add Cisco NSO Providers
The Cisco Network Services Orchestrator (Cisco NSO) provider supplies the following functionality:
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• Network services and device configuration services to Cisco Crosswork applications.

• Device management and configuration maintenance services.

Crosswork supports Cisco NSO Layered Service Architecture (LSA) deployment. The LSA deployment is
constructed frommultiple NSO providers, that function as the customer-facing service (CFS) NSO containing
all the services, and the resource-facing service (RFS), which contains the devices. Crosswork automatically
identifies the NSO provider as CFS or RFS. Only one CFS is allowed. On the Manager Provider Access
page, the Type column identifies the NSO provider as CFS.

Note

Before you begin

You will need to:

• Create a credential profile for the Cisco NSO provider.

• Know the name you want to assign to the Cisco NSO provider.

• Know the Cisco NSO version using the version command, as shown in the below example:
admin@ncs# show ncs-state version
ncs-state version 6.1.4

• Know the Cisco NSO NED device models and driver versions used in your topology.

• Know the Cisco NSO server IP address and hostname. When NSO is configured with HA, the IP address
would be management VIP address.

• Confirm Cisco NSO device configurations.

Follow the steps below to add a Cisco NSO provider through the UI. Note that you can import several providers
at the same time by preparing a CSV file with the details of all the providers and importing it into Crosswork.

Step 1 From the main menu, choose Administration > Manage Provider Access.

Step 2 Click .
Step 3 Enter the following values for the Cisco NSO provider fields:

a) Required fields:

• Provider Name: Enter a name for the provider.

• Credential Profile: Select the previously created Cisco NSO credential profile.

• Family: Select NSO.

• Under Connection Type(s), Protocol: Select the protocol that Cisco Crosswork applications will use to connect
to the provider. HTTPS is usually preferred.

• IP Address/Subnet Mask: Enter the IP address and subnet mask of the Cisco NSO server.

When you modify or update the NSO provider IP address or FQDN, you need to detach devices
from corresponding virtual data gateway, and reattach them. If you fail to do this, the provider
changes will not be reflected in MDT collection jobs.

Important
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• Port: For HTTPS, enter the port that corresponds with what is configured on the NSO VM in etc/ncs/ncs.conf
to access NSO using HTTPS. NSO uses 8888 as default port.

• Model: Select the model (Cisco-IOS-XR, Cisco-NX-OS, or Cisco-IOS-XE) from the drop-down list and enter
its associated NED driver version. Add a model for each type of device that will be used in the topology. If you
have more than one, add another supported model.

• Version: Enter the NED software version installed for the device model in NSO.

b) Optional values:

• Timeout: The amount of time (in seconds) to wait before timing out the connection to the Cisco NSO server.
The default is 30 seconds.

Step 4 Under Provider Properties, enter a Property Key of forward and a Property Value of true. This property is necessary
when using the Cisco Crosswork Network Controller solution to allow provisioning operations within the UI and to
enable the northbound interface to NSO via the Crosswork API gateway.

Cisco Crosswork provides the option to cross launch the NSO application from the Crosswork UI (this feature
is not available for user roles with read-only permissions). To enable the cross launch feature, add Cisco
NSO as a provider with one of the following settings:

• The Property Key nso_crosslaunch_url has a valid URL entered in the Property Key field.

• Protocol is HTTP or HTTPS, and the provider is reachable.

If any of the above settings are present, the cross launch icon ( ) is displayed in the Provider Name
column. Alternately, you can cross launch the NSO application using the launch icon located at the top right
corner of the window.

Note

Step 5 When you have completed entries in all of the required fields, click Save to add Cisco NSO as a provider.
Step 6 In the Providers window, select the NSO provider you created and click Actions > Edit Policy Details.

The Edit Policy Details window for the selected NSO provider is displayed.

Step 7 Edit the configuration fields to match the requirements of your environment. Click Save to save your changes.

What to do next

Return to the installation workflow:

• VMware: Install Cisco Crosswork Network Controller on VMware vCenter, on page 11

• AWS EC2: Install Cisco Crosswork Network Controller on AWS EC2, on page 13

(Optional) Set up Cisco NSO Layered Service Architecture
This section is applicable only when you have opted for Cisco NSO Layered Service Architecture (LSA)
deployment.
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Cisco NSO LSA allows you to add arbitrarily many device nodes for improved memory and provisioning
throughput. Large service providers or enterprises use Cisco NSO tomanage services for millions of subscribers
or users, ranging over several hundred thousand managed devices. To achieve this, you can design your
services in the layered fashion called LSA.

To position Cisco Crosswork Network Controller for large customers, the solution is made compatible with
the existing Cisco NSO LSA architecture.

Follow these steps to decide when to use Cisco NSO LSA:

1. Check if the deployment is stand-alone or Cisco NSO LSA.

2. If the deployment is stand-alone, check the maximum memory that may be utilised. If the maximum
memory that may be utilised is more than the current memory state, Cisco NSO LSA needs to be deployed.

Migration from stand-alone deployment to Cisco NSO LSA deployment is not currently supported.Note

To get a detailed information on Cisco NSO LSA and to set up Cisco NSO LSA, see NSO Layered Service
Architecture.
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C H A P T E R 11
Integrate SR-PCE

This chapter contains the following topics:

• SR-PCE Integration Workflow, on page 189
• Configure SR-PCE, on page 189
• Add Cisco SR-PCE Providers, on page 192

SR-PCE Integration Workflow
This section explains the steps in integrating Cisco SR-PCE with Crosswork Network Controller.

The compatible versions of SR-PCE are Cisco IOS XR 7.11.1.

1. Install the compatible version of Cisco SR-PCE

Select the type of SR-PCE (for VMware ESXi or AWS) and follow the relevant install instructions in the
Cisco IOS XRv 9000 Router Installation Guide.

2. Configure SR-PCE

Follow the instructions in Configure SR-PCE, on page 189.

3. Add SR-PCE provider and verify connectivity

Follow the instructions in Add Cisco SR-PCE Providers, on page 192.

Configure SR-PCE
This section explains how to configure SR-PCE after you have installed it.

The Cisco IOS XRv 9000 is the recommended platform to act as the SR-PCE.Note
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Table 57: Configure SR-PCE

DescriptionCommand or ActionStep

Enters mode.configure

Example:
RP/0/RP0/CPU0:router# configure

1

Enables PCE and enters PCE configurationmode.pce

Example:
RP/0/RP0/CPU0:router(config)# pce

2

Configures a PCE IPv4 address.address ipv4 address

Example:
RP/0/RP0/CPU0:router(config-pce)# address
ipv4 192.168.0.1

3

Configures the remote peer for state
synchronization.

state-sync ipv4 address

Example:
RP/0/RP0/CPU0:router(config-pce)#
state-sync ipv4 192.168.0.3

4

Configures the transmit and receive TCP buffer
size for each PCEP session, in bytes. The default
buffer size is 256000. The valid range is from
204800 to 1024000.

tcp-buffer size size

Example:
RP/0/RP0/CPU0:router(config-pce)#
tcp-buffer size 1024000

5

Enables TCP MD5 authentication for all PCEP
peers. Any TCP segment coming from the PCC
that does not contain a MAC matching the
configured password will be rejected. Specify if
the password is encrypted or clear text.

TCP-AO and TCP MD5 are never
permitted to be used simultaneously.

Note

password {clear | encrypted} password

Example:
RP/0/RP0/CPU0:router(config-pce)# password
encrypted pwd1

6
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DescriptionCommand or ActionStep

Enables TCP Authentication Option (TCP-AO)
authentication for all PCEP peers. Any TCP
segment coming from the PCC that does not
contain aMACmatching the configured key chain
will be rejected.

• include-tcp-options—Includes other TCP
options in the header for MAC calculation.

• accept-ao-mismatch-connection—Accepts
connection even if there is a mismatch of AO
options between peers.

TCP-AO and TCP MD5 are never
permitted to be used simultaneously.

Note

tcp-ao key-chain [include-tcp-options]

[accept-ao-mismatch-connection]

Example:
RP/0/RP0/CPU0:router(config-pce)# tcp-ao
pce_tcp_ao include-tcp-options

7

Configures the segment routing algorithm to use
strict SID or TE latency.

This setting is global and applies to
all LSPs that request a path from this
controller.

Note

segment-routing {strict-sid-only |

te-latency}

Example:
RP/0/RP0/CPU0:router(config-pce)#
segment-routing strict-sid-only

8

Enters timer configuration mode.timers

Example:
RP/0/RP0/CPU0:router(config-pce)# timers

9

Configures the timer value for locally generated
keep-alive messages. The default time is 30
seconds.

keepalive time

Example:
RP/0/RP0/CPU0:router(config-pce-timers)#
keepalive 60

10

Configures the minimum acceptable keep-alive
timer that the remote peer may propose in the
PCEP OPEN message during session
establishment. The default time is 20 seconds.

minimum-peer-keepalive time

Example:
RP/0/RP0/CPU0:router(config-pce-timers)#
minimum-peer-keepalive 30

11

Configures the re-optimization timer. The default
timer is 1800 seconds.

reoptimization time

Example:
RP/0/RP0/CPU0:router(config-pce-timers)#
reoptimization 600

12

Exits timer configurationmode and returns to PCE
configuration mode.

exit

Example:
RP/0/RP0/CPU0:router(config-pce-timers)#
exit

13
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What to do next:

Return to the installation workflow:

• VMware: Install Cisco Crosswork Network Controller on VMware vCenter, on page 11

• AWS EC2: Install Cisco Crosswork Network Controller on AWS EC2, on page 13

Sample SR-PCE config
This is a sample SR-PCE configuration:
pce
address ipv4 1.1.1.98
api
user cisco {This is the username and password that the

credential profile used for the PCE will need to have for HTTP}
password encrypted 032752180500701E1D48

!

Add Cisco SR-PCE Providers
Cisco Segment Routing Path Computation Elements (Cisco SR-PCE) providers supply device discovery,
management, configuration-maintenance and route-calculation services to the Cisco Crosswork applications.
At least one SR-PCE provider is required in order to learn and discover SR policies, Layer 3 links, and devices.
You have the option to configure a second SR-PCE as a backup. Both SR-PCE devices must be connected to
the same network as Crosswork Network Controller does not support managing more than one domain.

To enable Cisco Crosswork application access to an SR-PCE as an SDN controller on the management domain,
SR-PCE needs to be added as a provider.

Note

Follow the steps below to add (through the UI) one or more instances of Cisco SR-PCE as providers.

Before you begin

You will need to:

• Configure a device to act as the SR-PCE. See SR configuration documentation for your specific device
platform to enable SR (for IS-IS or OSPF protocols) and configure an SR-PCE (for example: Segment
Routing Configuration Guide for Cisco NCS 540 Series Routers).

• Create a credential profile for the Cisco SR-PCE provider. This should be a basic HTTP text-authentication
credential (currently, MD5 authentication is not supported). If the Cisco SR-PCE server you are adding
does not require authentication, you must still supply a credential profile for the provider, but it can be
any profile that does not use the HTTP protocol.

• Know the name you want to assign to the Cisco SR-PCE provider. This is usually the DNS hostname of
the Cisco SR-PCE server.

• Know the Cisco SR-PCE server IP address.
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• Know the interface you want to use to communicate between Cisco SR-PCE and the Cisco Crosswork
application server.

• Determine whether you want to auto-onboard the devices that Cisco SR-PCE discovers and, if so, whether
you want the new devices to have their management status set to off, managed or unmanaged when
added.

• If you plan to auto-onboard devices that the Cisco SR-PCE provider discovers, and set them to a managed
state when they are added to the database:

• Assign an existing credential profile for communication with the new managed devices.

• The credential profile must be configured with an SNMP protocol.

• For high availability, ensure that you set up two separate Cisco SR-PCE providers with unique names
and IP addresses, but with matching configurations.

Step 1 From the main menu, choose Administration > Manage Provider Access.

Step 2 Click .
Step 3 Enter the following values for the SR-PCE provider fields:

a) Required fields:

• Provider Name: Name of the SR-PCE provider.

• Credential Profile: Select the previously created Cisco SR-PCE credential profile.

• Family: Select SR_PCE. All other options should be ignored.

• Protocol: Select HTTP.

• IP Address/ Subnet Mask: Enter the IP address (IPv4 or IPv6) and subnet mask of the server.

• Port: Enter 8080 for the port number.

• Provider Properties: Enter one of the following key/value pairs in the first set of fields:

ValueProperty Key

off

Use this option if you plan to manually (via UI or CSV import) enter
all of your network devices.

Note

When devices are discovered, the device data is recorded in the Cisco SR-PCE
database, but is not registered in Cisco Crosswork InventoryManagement database.

auto-onboard
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ValueProperty Key

unmanaged

If this option is enabled, all devices that Cisco Crosswork discovers will be
registered in the Cisco Crosswork Inventory Management database, with their
configured state set to unmanaged. SNMP polling will be disabled for these
devices, and no management IP information will be included. To get these devices
into the managed state later, you will need to either edit them via the UI or export
them to a CSV make modifications and then import the updated CSV. You can
also assign credential profiles by adding them to the device CSV file before import
(the credential profiles must already exist).

auto-onboard

managed

If this option is enabled, all devices that Cisco SR-PCE discovers will be registered
in the Cisco Crosswork Inventory Management database, with their configured
state set to managed. SNMP polling will be enabled for these devices, and Cisco
SR-PCE will also report the management IP address (TE Router ID for IPv4, or
IPv6 Router ID for IPv6 deployment). The devices will be added with the credential
profile associated with the device-profile key in the SR-PCE provider configuration.

auto-onboard

The name of a credential profile that contains SNMP credentials for all the new
devices.

This field is necessary only if auto-onboard is set to managed
or unmanaged.

Note

device-profile

eth1

You have to set this only if you want to enable Cisco Crosswork
application access to SR-PCE via the data network interface when
using the two NIC configuration.

Note

outgoing-interface

off or on.

This is an optional property. If not specified, the default value is on.

If value is specified as off, it means that L3 topology is not accessible for the
SR-PCE provider.

topology

off or on.

This is an optional property. If not specified, the default value is on.

If value is specified as off, it means that LSPs and policies are not accessible for
the SR-PCE provider.

pce
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Figure 41: Provider Property Key and Value Example

If managed or unmanaged options are set and you want to delete a device later, you must do one
of the following:.

• Reconfigure and remove the devices from the network before deleting the device from Cisco
Crosswork. This avoids Cisco Crosswork from rediscovering and adding the device back.

• Set auto-onboard to off, and then delete the device from Cisco Crosswork. However, doing so
will not allow Cisco Crosswork to detect or auto-onboard any new devices in the network.

Note

b) Optional values:

• Timeout: The amount of time (in seconds) to wait before timing out the connection to the SR-PCE server. The
default is 30 seconds.

Step 4 When you have completed entries in all of the required fields, click Save to add the SR-PCE provider.
Step 5 Confirm that the SR-PCE provider shows a green Reachability status without any errors. You can also view the Events

window (Administration > Events) to see if the provider has been configured correctly.
Step 6 Repeat this process for each SR-PCE provider.

It is not recommended to modify auto-onboard options once set. If you need to modify them, do the following:

1. Delete the provider and wait until deletion confirmation is displayed in the Events window.

2. Re-add the provider with the updated auto-onboard option.

3. Confirm the provider has been added with the correct auto-onboard option in the Events window.

Note

What to do next

• If you entered the auto-onboard/off pair, navigate to Device Management > Network Devices to
add a devices.

• If you opted to automatically onboard devices, navigate to Device Management > Network Devices to
view the device list. To add more node information such as geographical location details, export the
device list (.csv), update it, and import it back. If geographical location data is missing, you will only be
able to see device topology using the logical map.

Return to the installation workflow:

• VMware: Install Cisco Crosswork Network Controller on VMware vCenter, on page 11
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• AWS EC2: Install Cisco Crosswork Network Controller on AWS EC2, on page 13
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P A R T VI
Upgrade Cisco Crosswork Network Controller

• Upgrade Cisco Crosswork, on page 199





C H A P T E R 12
Upgrade Cisco Crosswork

This chapter contains the following topics:

• Upgrade Overview, on page 199
• Upgrade Requirements, on page 200
• Upgrade Using Existing Hardware, on page 202
• Upgrade Using Parallel Hardware, on page 212
• Update a Crosswork Application (standalone activity) , on page 219

Upgrade Overview
This section provides the high-level overview for upgrading Cisco Crosswork Network Controller to the latest
version. This includes upgrading Cisco Crosswork cluster, Cisco Crosswork Data Gateway and Crosswork
Applications within a single maintenance window.

You can upgrade Cisco Crosswork in the following methods:

1. Upgrade Using Existing Hardware, on page 202

2. Upgrade Using Parallel Hardware, on page 212

The time taken for the entire upgrade window can vary based on size of your deployment profile and the
performance characteristics of your hardware.
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Migration of Cisco Crosswork from an earlier version has the following limitations:

• License tags are not auto-registered as part of the upgrade operation. You must register them manually
after the upgrade.

• Third-party device configuration in Device LifecycleManagement (DLM) and CiscoNSO is not migrated,
and needs to be re-applied on the new Cisco Crosswork version post migration.

• Custom user roles (Read-Write/Read) created in earlier version of Cisco Crosswork are not migrated,
and need to be updated manually on the new version post migration.

• Any user roles with administrative privileges in the earlier version of Cisco Crosswork must be assigned
new permissions after the upgrade to continue being administrative users.

• Crosswork Health Insights KPI alert history is not retrieved as part of the migration.

• After a successful migration, youmust perform a hard refresh or browser cache deletion before proceeding
to use the system. Failing to do this step can result in data discrepency.

• Any LDAP users in 5.0 will not be allowed to log in to Crosswork 6.0 as a mandatory Device Access
Group Attribute is not migrated in the upgrade fromCrosswork 5.0 to 6.0. This occurs because Crosswork
is unable to identify the correct DAG attribute available in the LDAP server after the upgrade. To resolve
this, post upgrade you must set the mandatory DAG attribute in the Crosswork 6.0 LDAP server settings
and create the corresponding DAGs for the users. After this, the remote login will work.

Warning

Crosswork applications can be independently updated from the Cisco Crosswork UI in case of minor updates
or patch releases. For more information, see Update a Crosswork Application (standalone activity) , on page
219.

Upgrade Requirements
This section explains the requirements for upgrading the Cisco Crosswork if you are using the Crosswork
Optimization Engine.

If you have enabled feature packs (Local Congestion Mitigation, SR Circuit Style Manager, or Bandwidth on
Demand) in an earlier version of Crosswork and want to upgrade to the latest version, you must perform the
following tasks prior to upgrading:

LCM

• From the LCM Configuration page:

1. Set the Delete Tactical SR Policies when Disabled option to False. This task must be done prior
to disabling LCM so that tactical polices deployed by LCM remain in the network after the upgrade.

2. Set the Enable option to False. If LCM remains enabled, there is a chance that tactical policies may
be deleted after the upgrade.

3. Note all options (Basic and Advanced) in the LCM Configuration page so that you can confirm the
same configuration has been migrated after the upgrade.
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• Export the current list of interfaces managed by LCM (Traffic Engineering > Local Congestion
Mitigation > Export icon). Confirm the interfaces are valid by reimporting the CSV file without errors.
For more information, see "Add Individual Interface Thresholds".

• After the upgrade, wait until theTraffic Engineering page shows all the nodes and links before enabling
LCM

Note:

After the system is stable and before enabling domains for LCM, confirm that the migration of previously
monitored interfaces has completed and that each domain has the expected configuration options.

1. Navigate to Administration > Alarms > All > Events and enter LCM to filter the Source column.

2. Look for the following event: "Migration complete. All migrated LCM interfaces and policies are mapped
to their IGP domains". If this message does not appear wait for the Congestion Check Interval period
(set in the LCM Configuration page), then restart LCM (Administration > Crosswork Manager >
Optimization Engine > optima-lcm > ... > Restart).

3. Wait until the optima-lcm service changes from Degraded to Healthy state.

4. For each domain, navigate to the Configuration page and verify the options have been migrated
successfully. If the domain configurations are incorrect, restart LCM (Administration > Crosswork
Manager > Optimization Engine > optima-lcm > ... > Restart).

5. Check the Events page for the event mentioned above and the Configuration page to verify the options.

• If the confirmation message does not appear or domain configuration options are incorrect, then contact
Cisco Technical support and provide themwith showtech information and the exported LinkManagement
CSV file.

• You can also manually add missing interfaces that were previously monitored or update domain
configuration options after the system is stable.

Note

CSM

• Set the Enable option to False.

• Note all options (Basic and Advanced) in the CSM Configuration page so that you can confirm the
same configuration has been migrated after the upgrade.

• After the upgrade, wait until theTraffic Engineering page shows all the nodes and links before enabling
CSM.

• Circuit Style SR-TE policies will go to operation down (Oper Down) state if CSM is not enabled within
8 hours after disabling.

BWoD

• Set the Enable option to False. If BWoD remains enabled, there is a chance that tactical policies may
be deleted after the upgrade
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• Note all options (Basic and Advanced) in the BWoD Configuration page so that you can confirm the
same configuration has been migrated after the upgrade.

• After the upgrade, wait until theTraffic Engineering page shows all the nodes and links before enabling
BWoD.

Upgrade Using Existing Hardware
This section explains how to migrate to the latest version of Crosswork Network Controller using the existing
cluster.

Each stage in this upgrade workflow must be executed in sequence, and is explained in detail in later sections
of this chapter. The stages are:

1. Shut Down Cisco Crosswork Data Gateway VMs, on page 202

2. Create Backup and Shut Down Cisco Crosswork, on page 203

3. Install the latest version of the Cisco Crosswork Cluster, on page 205

While the cluster installation is in progress, you must upgrade NSO to version 6.1.4. The process to upgrade
NSO is not covered in this document. For more information, see the relevant Cisco NSO documentation. You
must also upgrade your SR-PCE to version 7.11.1. For install instructions, see the Cisco IOS XRv 9000 Router
Installation Guide..

Note

4. Install the Cisco Crosswork Applications, on page 206

You are recommended to download and validate the application CAPP files before starting the actual upgrade
process. This will reduce your system downtime as opposed to downloading the CAPP files midway through
the upgrade process.

Note

5. Migrate Cisco Crosswork Backup, on page 206

6. Upgrade Crosswork Data Gateway, on page 208

7. Post-upgrade Checklist, on page 210

Shut Down Cisco Crosswork Data Gateway VMs
This is the first stage of the upgrade workflow.

When Crosswork Data Gateway VMs are shut down, data will not be forwarded to data destinations. Check
with the application providers to determine if any steps are needed to avoid alarms or other problems.

Note
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Before you begin

Take screenshots of all the tabs in the Data Gateway Management page to keep a record of the list of
Crosswork Data Gateways, Attached Device Count in the Cisco Crosswork UI. In the Pools tab, for each
pool listed here, take a screenshot to make a note of the active, spare, and unassigned VMs in the pool. This
information is useful during Upgrade Crosswork Data Gateway, on page 208.

Step 1 Check and confirm that all the VMs are healthy and running in your cluster.
Step 2 Shut down the Crosswork Data Gateway VMs.

a) Log in to the Crosswork Data Gateway VM. See Access Crosswork Data Gateway VM from SSH, on page 110.

Crosswork Data Gateway launches an Interactive Console after you log in successfully.

b) Choose 5 Troubleshooting.
c) From the Troubleshooting menu, choose 5 Shutdown VM to shut down the VM.

Create Backup and Shut Down Cisco Crosswork
This is the second stage of the upgrade workflow. Creating a backup is a prerequisite when upgrading your
current version of Cisco Crosswork to a new version.

We recommend that you create a backup only during a scheduled upgrade window. Users should not attempt
to access Cisco Crosswork while the backup operation is running.

Note

Before you begin

Follow these guidelines whenever you create a backup:

• Cisco Crosswork will back up the configuration of the system to an external server using SCP. Before
you begin you need to have the following configuration in place and information about the SCP server
available:

• The hostname or IP address and the port number of a secure SCP server.

• A preconfigured path on the SCP server where the backup will be stored.

• User credentials with file read and write permissions to the directory.

• The SCP server storage requirements will vary slightly but you must have at least 25 GB of storage.

• Ensure that you have configured a destination SCP server to store the backup files. This configuration
is a one-time activity.

• After the backup operation is completed, navigate to the destination SCP server directory and ensure that
the backup file is created. You will require this backup file in the later stages of the upgrade process.

• Both the Cisco Crosswork cluster and the SCP server must be in the same IP environment. For example:
If Cisco Crosswork is communicating over IPv6, so must the backup server.
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• Keep a record of the list of Crosswork applications you have installed in the current version of Cisco
Crosswork, as you can only install those applications after migrating to the new version of Cisco
Crosswork.

• If you have onboarded a custom MIB package in the current version of Cisco Crosswork, download a
copy of the package to your system. You will need to upload the package after you complete migrating
to new version of Cisco Crosswork. See Post-upgrade Checklist, on page 210 for more infomation.

• If you have modified the current version of Cisco Crosswork to include third-party device types, you
must download the third-party device configuration file, and re-apply it to the new version of Cisco
Crosswork. The device configuration file is located on the cluster node (at
/mnt/cw_glusterfs/bricks/brick3/sys-oids.yaml) and on the pod (at
/mnt/backup/sys-oids.yaml).

• If Local Congestion Mitigation (LCM), SR Circuit Style Manager (CSM), and Bandwidth on Demand
(BWoD) are enabled, you must disable them before proceeding. You must also, if available, export the
current list of interfaces managed by LCM (Traffic Engineering > Local Congestion Mitigation >
Domain Identifier <domain_id> > Interface Thresholds > Export). Follow the steps documented in
Upgrade Requirements, on page 200.

Step 1 Check and confirm that all the VMs are healthy and running in your cluster.
Step 2 Configure an SCP backup server:

a) From the Cisco Crosswork main menu, choose Administration > Backup and Restore.
b) Click Destination to display the Edit Destination dialog box. Make the relevant entries in the fields provided.
c) Click Save to confirm the backup server details.

Step 3 Create a backup:

a) From the Cisco Crosswork main menu, choose Administration > Backup and Restore.
b) Click Actions > Data Backup to display the Data Backup dialog box with the destination server details prefilled.
c) Provide a relevant name for the backup in the Job Name field.
d) If any of the VMs or applications are not in Healthy state, but you want to create the backup, check the Force check

box.

The Force option must be used only after consultation with the Cisco Customer Experience team.Note

e) Uncheck the Backup NSO checkbox if you don't want to include Cisco NSO data in the backup.

If you do want to include Cisco NSO data in the Cisco Crosswork backup process, follow the instructions given in
Backup Cisco Crosswork with Cisco NSO section in the Cisco Crosswork Network Controller 6.0 Administration
Guide instead of the instructions here.

f) Complete the remaining fields as needed.
If you want to specify a different remote server upload destination: Edit the pre-filled Host Name, Port, Username,
Password and Remote Path fields to specify a different destination.

g) (Optional) Click Verify Backup Readiness to verify that Cisco Crosswork has enough free resources to complete
the backup. If the verifications are successful, Cisco Crosswork displays a warning about the time-consuming nature
of the operation. Click OK.

If the verification is unsuccessful, please contact the Cisco Customer Experience team for assistance.
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h) Click Start Backup to start the backup operation. Cisco Crosswork creates the corresponding backup job set and
adds it to the job list. The Job Details panel reports the status of each backup step as it is completed.

i) To view the progress of a backup job: Enter the job details (such as Status or Job Type) in the search fields in the
Backup and Restore Job Sets table. Then click on the job set you want.

The Job Details panel displays information about the selected job set, such as the job Status, Job Type, and Start
Time. If there’s a failed job, hover the mouse pointer over the icon near the Status column to view the error details.

After the backup operation is completed, navigate to the destination SCP server directory and ensure
that the backup file is created. You will require this backup file in the later stages of the upgrade process.

Note

If you do not see your backup job in the list, refresh the Backup and Restore Job Sets table.Note

j) If the backup fails during upload to the remote server: In the Job Details panel, just under the Status icon, click the
Upload backup button to retry the upload.

Upload can fail due to connectivity problems with the SCP backup server (for example, incorrect
credentials, missing directory or directory permissions, missing path and so on). This is indicated by
failure of the task uploadBackupToRemote). If this happens, check the SCP server details, correct
any mistakes and try again. Alternatively, you can use the Destination button to specify a different SCP
server and path before clicking Upload backup.

Note

Step 4 After a successful backup, shut down the Cisco Crosswork cluster by powering down the VMs hosting each node (start
with the Hybrid VMs):
a) Log into the VMware vSphere Web Client.
b) In the Navigator pane, right-click the VM that you want to shut down.
c) Choose Power > Power Off.
d) Wait for the VM status to change to Off.
e) Wait for 30 seconds and repeat steps 4a to 4d for each of the remaining VMs.

Step 5 Move Cisco NSO into read-only mode to avoid any unintended updates to Cisco NSO during the upgrade.
Use the following command to move NSO to read-only mode:
ncs_cmd -c maapi_read_only

Install the latest version of the Cisco Crosswork Cluster
After the successful backup of the old version of Cisco Crosswork, proceed to install the latest version of the
Cisco Crosswork cluster.

The number of VM nodes installed in the new version of Cisco Crosswork must be equal or more than the
number of VM nodes in the old version of Cisco Crosswork.

Note
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Before you begin

• Make sure that your environment meets all the installation prerequisites (see Installation Prerequisites
for VMware vCenter, on page 19 for VMware and Installation Prerequisites for AWS EC2, on page 121
for AWS).

Step 1 Install Cisco Crosswork cluster on your preferred platform (see Install Crosswork Cluster on VMware vCenter, on page
39 for VMware and Install Cisco Crosswork Network Controller on AWS EC2, on page 135 for AWS).

During installation, Cisco Crosswork will create a special administrative ID (virtual machine (VM)
administrator, with the username cw-admin, and the default password cw-admin). The administrative
username is reserved and cannot be changed. The first time you log in using this administrative ID, you will
be prompted to change the password. Data center administrators use this ID to log into and troubleshoot the
Crosswork application VM. You will use it to verify that the VM has been properly set up.

Note

Step 2 After the installation is completed, log into the Cisco Crosswork UI and check if all the nodes are up and running in the
cluster.
a) From the Cisco Crosswork main menu, choose Administration > Crosswork Manager > Crosswork Summary.
b) Click Crosswork Cluster tile to view the details of the cluster such as resource utilization by node, the IP addresses

in use, whether each node is a Hybrid or Worker, and so on.

Install the Cisco Crosswork Applications
After successfully installing the new version of the Cisco Crosswork cluster, proceed to install the latest
version of the Cisco Crosswork applications.

The Cisco Crosswork applications that you install must be the same ones that were backed up during Create
Backup and Shut Down Cisco Crosswork, on page 203.

Note

Step 1 Install the Cisco Crosswork applications using the steps described in Install Crosswork Applications, on page 169.
Step 2 After the applications are successfully installed, check the health of the new Cisco Crosswork cluster.

a) From the Cisco Crosswork main menu, choose Administration > Crosswork Manager > Crosswork Summary.
b) Click Crosswork Cluster tile to view the health details of the cluster.

Migrate Cisco Crosswork Backup
After successfully installing the new versions of the Cisco Crosswork applications, proceed to migrate the
Cisco Crosswork backup taken earlier to the new Cisco Crosswork cluster.

Before you begin

Before you begin, ensure that you have:
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• The hostname or IP address and the port number of a secure destination SCP server used in Create Backup
and Shut Down Cisco Crosswork, on page 203.

• The name and path of the backup file created in Create Backup and Shut Down Cisco Crosswork, on
page 203.

• User credentials with file read and write permissions to the directory.

Step 1 Check and confirm that all the VMs are healthy and running in your cluster.
Step 2 Configure an SCP backup server:

a) From the main menu, choose Administration > Backup and Restore.
b) Click Destination to display the Edit Destination dialog box.
c) Make the relevant entries in the fields provided.

In the Remote Path field, please provide the location of the backup created in Create Backup and Shut
Down Cisco Crosswork, on page 203.

Note

d) Click Save to confirm the backup server details.

Step 3 Migrate the previous Cisco Crosswork backup on the new Cisco Crosswork cluster:

a) From the Cisco Crosswork main menu, choose Administration > Backup and Restore.
b) ClickActions >Data Migration to display theData Migration dialog box with the destination server details prefilled.
c) Provide the name of the data migration backup (created in Create Backup and Shut Down Cisco Crosswork, on page

203) in the Backup File Name field.
d) If you want to perform the data migration backup despite any Cisco Crosswork application or microservice issues,

check the Force check box.
e) Click Start Migration to start the data migration operation. Cisco Crosswork creates the corresponding data migration

job set and adds it to the Backup and Restore Job Sets table. The Job Details panel reports the status of each backup
step as it is completed.

If you do not see your job in the list, please wait for a few minutes and refresh the Backup and Restore
Job Sets table.

Note

f) To view the progress of a data migration job: Enter the job details (such as Status or Job Type) in the search fields
in the Backup and Restore Job Sets table. Then click on the job set you want.

The Job Details panel displays information about the selected job set, such as the job Status, Job Type, and Start
Time. If there’s a failed job, hover the mouse pointer over the icon near the Status column to view the error details.

Crosswork UI might become temporarily unavailable during the data migration operation. When the
Crosswork UI is down, you can view the job status in the Grafana dashboard. The Grafana link is available
as View Data Migration Process Dashboard option on the right side of the Job Details window.

Note

g) If the data migration fails in between, you need to restart the procedure from step 1.

Step 4 After the data migration is successfully completed, check the health of the new Cisco Crosswork cluster.
a) From the Cisco Crosswork main menu, choose Administration > Crosswork Manager > Crosswork Summary.
b) Click Crosswork Cluster tile to view the health details of the cluster.
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Upgrade Crosswork Data Gateway
This is the final stage of the upgrade work flow. Ensure that the migration is complete and the new Cisco
Crosswork UI is available before you proceed with installing the latest version of Crosswork Data Gateway.

This procedure is required only for a Cisco Crosswork Data Gateway Base VM upgrade. Upgrade of other
components, such as collectors, is performed by Cisco Crosswork.

Note

Crosswork Data Gateway functions as a passive device in the network. The Crosswork Data Gateway upgrade
process consists of the following steps replacing all the old Crosswork Data Gateway VMs with Crosswork
Data Gateway VMs in the network.

Step 8 in this procedure requires you log out of Cisco Crosswork and log in again after verifying the deployment
and enrollment of the latest Crosswork Data GatewayVMswith Cisco Crosswork. After you log in, anAction
to be takenwindow appears prompting you to confirm that the upgrade is complete. Do not clickAcknowledge
unless you have completed all the verification steps mentioned in Step 3, Step 4, and Step 5 in the procedure.

Important

Step 1 Log out of Cisco Crosswork and log in again.
Step 2 After you log in, an Action to be taken window appears. Close this window and do not click Acknowledge.
Step 3 Install new Cisco Crosswork Data Gateway VMswith the same number and the same information (management interface

importantly) as the old Crosswork Data Gateway VMs. Follow the steps in the Cisco Crosswork Data Gateway Installation
Workflow, on page 79.

Step 4 Wait for about 5 minutes and navigate to Administration > Data Gateway Management.
Step 5 Check the Data Gateway Instances tab to verify that the new Crosswork Data Gateway VMs are enrolled with Cisco

Crosswork and have the Admin State as Up and Operational State as Not Ready.

Figure 42: Data Gateway Instances Window

Step 6 After the Operational State of the VMs changes to Ready, navigate to the Pools tab and verify that all the Crosswork
Data Gateway pools from the previous version of Cisco Crosswork, are listed here. Edit each Crosswork Data Gateway
pool to verify that the active Crosswork Data Gateway is same as one that you noted in the previous version of Cisco
Crosswork.

You can also verify the pool details by clicking on the pool name.Note
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Step 7 Verify that devices are attached to the Crosswork Data Gateways in the Cisco Crosswork UI.

a) Navigate to the Administration > Data Gateway Management page.
b) Check the Attached Device Count of the Crosswork Data Gateway.

Figure 43: Data Gateway Window

Step 8 Log out of Cisco Crosswork.

After the upgrade is complete:

• Crosswork Data Gateway VMs are enrolled with Cisco Crosswork.

• All destinations, Crosswork Data Gateway pools, device-mapping information can be viewed on the
Cisco Crosswork UI with the upgraded Crosswork Data Gateway VMs.

• Collection jobs start again automatically with the new Cisco Crosswork Data Gateway VMs.

• After upgrading the Crosswork Data Gateway VM, you must reconfigure the collector resources and the
disabled containers. Global Parameter resources that were configured prior to the upgrade are not retained.
To configure the resource parameters, on the Crosswork UI, navigate toAdministration >Data Gateway
Global Settings > Data Gateway > Resource. For more information on the resources, see Cisco
Crosswork Network Controller 6.0 Administration Guide.

What to do next

After you log in to Crosswork Network Collection UI, the following window prompting for confirmation is
displayed. Click Acknowledge in the pop-up that appears.

Do not click Acknowledge unless you have verified that the VMs are in the Up/Not Ready state. Doing so
results in VMs having the state as Error. See Troubleshoot Crosswork Data Gateway Upgrade Issues.

Important

Cisco Crosswork Network Controller 6.0 Installation Guide
209

Upgrade Cisco Crosswork Network Controller
Upgrade Crosswork Data Gateway



Figure 44: Acknowledgment Window

(Optional) Move Cisco NSO out of maintenance or read-only mode.

ncs_cmd -c maapi_read_write

Troubleshoot Crosswork Data Gateway Upgrade Issues
The following table lists common problems that might be experienced when upgrading the Crosswork Data
Gateway, and provides approaches to identifying the source of the problem and solving it.

Recommended ActionIssue

1. Wait for the Crosswork Data Gateway VMs to
have the state as Up or Not Ready state.

2. Once the VMs have the state asUp orNot Ready,
delete all Crosswork Data Gateway pools and
create them again.

Some of the Crosswork Data Gateway VMs are in
Error or Degraded state because you clicked
Acknowledge before the VMs came to the Up/Not
Ready state

1. Delete all Crosswork Data Gateway pools.

2. Check if the VMs now have the state as Up or
Not Ready.

3. If the VMs are still in a state of Error, manually
re-enroll the VMs with the new version of Cisco
Crosswork. See Re-enroll Crosswork Data
Gateway for more information.

Some of the Crosswork Data Gateway VMs are in
Error or Degraded state because you clicked
Acknowledge before the VMs came to the Up/Not
Ready state. The state of the VMs did not change to
Up/ Ready and they are still in Error.

1. In the Cisco Crosswork UI, navigate to Data
Gateway Management > Virtual Machines.

2. Click the Crosswork Data Gateway that is
degraded.

3. Click Actions and click Reboot.

Crosswork Data Gateways VMs are stuck in the
Degraded state with Image manager being in exited
state. The list of components for the Crosswork Data
Gateway either do not show Image manager or show
it in an exited state.

Post-upgrade Checklist
After you upgrade Cisco Crosswork to the latest version, check the health of the new cluster. If your cluster
is healthy, perform the following activities:
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• Perform a hard refresh or browser cache deletion before proceeding to use the system. Failing to do this
step can result in data discrepancy.

• Navigate to Administration > Collection Jobs in Cisco Crosswork UI and delete the duplicate system
jobs.

Figure 45: Collection Jobs Window

• Verify that the collection jobs are running on the Crosswork Data Gateway VMs in the Administration
> Collection Jobs page.

• Verify the restored AAA data by logging in using default credentials, and configure custom user roles
(Read-Write/Read) in the upgraded Cisco Crosswork.

• (Optional) Based on your network requirements, download the relevant map files from cisco.com and
re-upload them to the upgraded Cisco Crosswork.

• (Optional) If any NSO device onboarding policy was set in the previous version of Cisco Crosswork,
you must update the policy with new Network Element Drivers (NED) on the NSO.

• (Optional) Re-apply any third-party device configurations (used in the previous version of Cisco
Crosswork) to the new version of Cisco Crosswork.

• If you are using Crosswork Change Automation, verify that all the stock and custom playbooks are
migrated successfully.

• If you are using Crosswork Health Insights, verify that the the collection to the external destination is
working. Also, check if the alert dashboard is displaying the correct data.

• For Traffic Engineering, perform the following actions:

• Upgrade the software versions in your devices as per the supported Cisco IOS XE/XR versions
documented in the Traffic Engineering Compatibility Information.

• Verify feature packs (Local Congestion Mitigation (LCM), Bandwidth Optimization (BWOpt), and
Bandwidth on Demand (BWoD)) using the instructions in Upgrade Requirements, on page 200.

If you encounter errors in any of the above activities, please contact the Cisco Customer Experience team.
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Upgrade Using Parallel Hardware
This section explains how tomigrate to the latest version of Crosswork Network Controller using new hardware.
This method relies on installing the new Cisco Crosswork cluster on new hardware in parallel while the data
from the old Cisco Crosswork cluster is being backed up. This method is faster but requires twice the amount
of resources for creating the new cluster in parallel.

The stages of the parallel upgrade workflow are:

1. Deploy a new Cisco Crosswork Cluster, on page 212

While the cluster installation is in progress, you must upgrade NSO to version 6.1.4. The process to upgrade
NSO is not covered in this document. For more information, see the relevant Cisco NSO documentation. You
must also upgrade your SR-PCE to version 7.11.1. For install instructions, see the Cisco IOS XRv 9000 Router
Installation Guide..

Note

2. Backup Cisco Crosswork Cluster, on page 213

3. Update DNS Server and Run Migration , on page 215

4. Add Crosswork Data Gateway to Cisco Crosswork, on page 216

5. Shut Down the old Cisco Crosswork Cluster, on page 218

Deploy a new Cisco Crosswork Cluster
Install the latest version of Cisco Crosswork cluster and applications on a new set of VMs in parallel.

The new Cisco Crosswork cluster must be installed with the same FQDN and same number of nodes as in
the old version of Cisco Crosswork.

Note

Before you begin

• Make sure that your environment meets all the installation prerequisites (see Installation Prerequisites
for VMware vCenter, on page 19 for VMware and Installation Prerequisites for AWS EC2, on page 121
for AWS).

Step 1 Install the new Cisco Crosswork cluster on your preferred platform (see Install Crosswork Cluster on VMware vCenter,
on page 39 for VMware and Install Cisco Crosswork Network Controller on AWS EC2, on page 135 for AWS).

During installation, Cisco Crosswork will create a special administrative ID (virtual machine (VM)
administrator, with the username cw-admin, and the default password cw-admin). The administrative
username is reserved and cannot be changed. The first time you log in using this administrative ID, you will
be prompted to change the password. Data center administrators use this ID to log into and troubleshoot the
Crosswork application VM. You will use it to verify that the VM has been properly set up.

Note
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Step 2 After the installation is completed, log into the Cisco Crosswork UI by navigating to https://<NEW_VIP>:30603.
Step 3 Check if all the nodes are up and running in the cluster.

a) From the Cisco Crosswork main menu, choose Administration > Crosswork Manager > Crosswork Summary.
b) Click Crosswork Cluster tile to view the details of the cluster such as resource utilization by node, the IP addresses

in use, whether each node is a Hybrid or Worker, and so on.

Step 4 Install the applications which were part of the old version of Cisco Crosswork. For more information, see Install Crosswork
Applications, on page 169.

Step 5 After the applications are successfully installed, check the health of the new Cisco Crosswork cluster.

Backup Cisco Crosswork Cluster

Before you begin

Follow these guidelines whenever you create a backup:

• Cisco Crosswork will back up the configuration of the system to an external server using SCP. Before
you begin you need to have the following configuration in place and information about the SCP server
available:

• The hostname or IP address and the port number of a secure SCP server.

• A preconfigured path on the SCP server where the backup will be stored.

• User credentials with file read and write permissions to the directory.

• The SCP server storage requirements will vary slightly but you must have at least 25 GB of storage.

• Ensure that you have configured a destination SCP server to store the backup files. This configuration
is a one-time activity.

• Both the Cisco Crosswork cluster and the SCP server must be in the same IP environment. For example:
If Cisco Crosswork is communicating over IPv6, so must the backup server.

• Keep a record of the list of Crosswork applications you have installed in the current version of Cisco
Crosswork, as you can only install those applications after migrating to the new version of Cisco
Crosswork.

• If you have onboarded a custom MIB package in the previous version of Cisco Crosswork, download a
copy of the package to your system. You will need to upload the package after you complete upgrading
Cisco Crosswork. See Post-upgrade Checklist, on page 210 for more information.

• If you have modified the previous version of Cisco Crosswork to include third-party device types, you
must download the third-party device configuration file, and re-apply it to the upgraded Cisco Crosswork.
The device configuration file is located on the cluster node (at
/mnt/cw_glusterfs/bricks/brick3/sys-oids.yaml) and on the pod (at
/mnt/backup/sys-oids.yaml).

• If Cisco Crosswork Optimization Engine has feature packs (Local Congestion Mitigation (LCM),
Bandwidth Optimization (BWOpt), and Bandwidth on Demand (BWoD)) that are enabled, you must
disable them before proceeding. You must also, if available, export the current list of interfaces managed
by LCM or BWOpt (Traffic Engineering > Local Congestion Mitigation > Domain Identifier
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<domain_id> > Interface Thresholds > ExportOR Traffic Engineering > Bandwidth Optimization
> Interface Thresholds > Export icon). Follow the steps documented in Upgrade Requirements, on
page 200.

We recommend that you create a backup only during a scheduled upgrade window. Users should not attempt
to access Cisco Crosswork while the backup operation is running.

Note

Step 1 Launch the Cisco Crosswork UI by using a browser and navigating to https://<FQDN>:30603
Step 2 Check and confirm that all the VMs are healthy and running in your cluster.
Step 3 Configure an SCP backup server:

a) From the Cisco Crosswork main menu, choose Administration > Backup and Restore.
b) Click Destination to display the Edit Destination dialog box. Make the relevant entries in the fields provided.
c) Click Save to confirm the backup server details.

Step 4 Create a backup:

a) From the Cisco Crosswork main menu, choose Administration > Backup and Restore.
b) Click Actions > Backup to display the Backup dialog box with the destination server details prefilled.
c) Provide a relevant name for the backup in the Job Name field.
d) If any of the VMs or applications are not in Healthy state, but you want to create the backup, check the Force check

box.

The Force option must be used only after consultation with the Cisco Customer Experience team.Note

e) Uncheck the Backup NSO check box if you don't want to include Cisco NSO data in the backup.

If you want to include Cisco NSO data in the Cisco Crosswork backup process, follow the instructions given in
Backup Cisco Crosswork with Cisco NSO section in the Cisco Crosswork Network Controller 6.0 Administration
Guide instead of the instructions here.

f) Complete the remaining fields as needed.
If you want to specify a different remote server upload destination: Edit the pre-filled Host Name, Port, Username,
Password and Remote Path fields to specify a different destination.

g) (Optional) Click Verify Backup Readiness to verify that Cisco Crosswork has enough free resources to complete
the backup. Cisco Crosswork will also confirm that none of the applications are being updated, if the remote destination
is correctly defined and if the applications are healthy. If the verifications are successful, Cisco Crosswork displays
a warning about the time-consuming nature of the operation. Click OK.

If the verification is unsuccessful, please contact the Cisco Customer Experience team for assistance.

h) Click Start Backup to start the backup operation. Cisco Crosswork creates the corresponding backup job set and
adds it to the job list. The Job Details panel reports the status of each backup step as it is completed.

i) To view the progress of a backup job: Enter the job details (such as Status or Job Type) in the search fields in the
Backup and Restore Job Sets table. Then click on the job set you want.

The Job Details panel displays information about the selected job set, such as the job Status, Job Type, and Start
Time. If there’s a failed job, hover the mouse pointer over the icon near the Status column to view the error details.

If you do not see your backup job in the list, refresh the Backup and Restore Job Sets table.Note
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j) If the backup fails during upload to the remote server: In the Job Details panel, just under the Status icon, click the
Upload backup button to retry the upload.

Upload can fail due to connectivity problems with the SCP backup server (for example, incorrect
credentials, missing directory or directory permissions, missing path and so on). This is indicated by
failure of the task uploadBackupToRemote). If this happens, check the SCP server details, correct
any mistakes and try again. Alternatively, you can use the Destination button to specify a different SCP
server and path before clicking Upload backup.

Note

Update DNS Server and Run Migration

Before you begin

Before you begin, ensure that you have:

• The hostname or IP address and the port number of a secure SCP server.

• The name and path of the backup file created in .

• User credentials with file read and write permissions to the directory.

Step 1 Update the DNS server to point the FQDN of the previous version of Cisco Crosswork cluster to the <VIP> of the new
Cisco Crosswork cluster.

Step 2 Navigate to the upgraded Cisco Crosswork UI using https://<new_VIP>:30603.
Step 3 Configure an SCP backup server:

a) From the main menu, choose Administration > Backup and Restore.
b) Click Destination to display the Edit Destination dialog box.
c) Make the relevant entries in the fields provided.

In the Remote Path field, please provide the location of the backup created in Backup Cisco Crosswork
Cluster, on page 213.

Note

d) Click Save to confirm the backup server details.

Step 4 Migrate the old Cisco Crosswork backup:

a) From the Cisco Crosswork main menu, choose Administration > Backup and Restore.
b) ClickActions >Data Migration to display theData Migration dialog box with the destination server details prefilled.
c) Provide the name of the data migration backup (created in Backup Cisco Crosswork Cluster, on page 213) in the

Backup File Name field.
d) If you want to perform the data migration backup despite any Cisco Crosswork application or microservice issues,

check the Force check box.
e) Click Start Migration to start the data migration operation. Cisco Crosswork creates the corresponding data migration

job set and adds it to the Backup and Restore Job Sets table. The Job Details panel reports the status of each backup
step as it is completed.

If you do not see your job in the list, refresh the Backup and Restore Job Sets table.Note
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f) To view the progress of a data migration job: Enter the job details (such as Status or Job Type) in the search fields
in the Backup and Restore Job Sets table. Then click on the job set you want.

The Job Details panel displays information about the selected job set, such as the job Status, Job Type, and Start
Time. If there’s a failed job, hover the mouse pointer over the icon near the Status column to view the error details.

Crosswork UI and Grafana monitoring might become temporarily unavailable during the data migration
operation.

Note

g) If the data migration fails in between, you need to restart the procedure from step 1.

Step 5 After the data migration is successfully completed, check the health of the new Cisco Crosswork cluster.
a) From the Cisco Crosswork main menu, choose Administration > Crosswork Manager > Crosswork Summary.
b) Click Crosswork Cluster tile to view the health details of the cluster.

After a successful migration, please perform a hard refresh or browser cache deletion before proceeding to
use the system. Failing to do this step can result in data discrepency.

Note

Add Crosswork Data Gateway to Cisco Crosswork
Ensure that the migration is complete and the new Cisco Crosswork UI is available before you proceed with
installing the new version of Crosswork Data Gateway.

This procedure is required only for a Cisco Crosswork Data Gateway Base VM upgrade. Upgrade of other
components, such as collectors, is performed by Cisco Crosswork.

Note

Crosswork Data Gateway functions as a passive device in the network. The Crosswork Data Gateway upgrade
process consists of replacing all old Crosswork Data Gateway VMs with new Crosswork Data Gateway VMs
(latest version) in the network.

Step 6 in this procedure requires you to log out of Cisco Crosswork and log in again after verifying the
deployment and enrollment of the new CDG VMs with Cisco Crosswork. After you log in, an Action to be
taken window appears prompting you to confirm that the upgrade is complete. Do not click Acknowledge
unless you have completed all the verification steps mentioned in Step 3, Step 4 and Step 5 in the procedure.

Important

Step 1 Log out of the upgraded Cisco Crosswork and log in again.
Step 2 After you log in, an Action to be taken window appears. Close this window and do not click Acknowledge.
Step 3 Install new Cisco Crosswork Data Gateway VMs (latest version) with the same number and the same information

(management interface importantly) as the old Crosswork Data Gateway VMs. Follow the steps in the Cisco Crosswork
Data Gateway Installation Workflow, on page 79.

Step 4 Wait for about 5 minutes and navigate to Administration > Data Gateway Management.
Step 5 Check the Data Gateway Instances tab to verify that the new Crosswork Data Gateway VMs are enrolled with the

new Cisco Crosswork, and have the Admin State as Up and Operational State as Not Ready.
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Figure 46: Data Gateway Instances Window

Step 6 After the Operational State of the VMs changes to Ready, navigate to the Pools tab and verify that all the Crosswork
Data Gateway pools from the old Cisco Crosswork, are listed here. Edit each Crosswork Data Gateway pool to verify
that the active Crosswork Data Gateway is same as one that you noted in the older version of Cisco Crosswork.

For example, the Crosswork Data Gateway pool in the following image contains two VMs, where the active VM is
172.23.247.78

Figure 47: Edit HA Pool Window

Step 7 Verify that devices are attached to the new Crosswork Data Gateways in the upgraded Cisco Crosswork UI.

a) Navigate to the Administration > Data Gateway Management page.
b) Check the Attached Device Count of the Crosswork Data Gateway.

Step 8 Log out of Cisco Crosswork and log in again.
Step 9 After you log in, Cisco Crosswork presents you with the following window prompting for confirmation that the VMs.

Click Acknowledge in the pop up that appears.
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Figure 48: Acknowledgment Window

Do not click Acknowledge unless you have verified that the VMs are in the Up/Not Ready state. Doing
so will result in VMs having the state as Error. See Troubleshoot Crosswork Data Gateway Upgrade
Issues.

Important

Step 10 (Optional) Move Cisco NSO out of maintenance or read-only mode.
ncs_cmd -c maapi_read_write

After the upgrade is complete:

• The new Crosswork Data Gateway VMs are enrolled with upgraded Cisco Crosswork.

• All destinations, HA Pools, device mapping information can be viewed on the Cisco Crosswork UI with
the upgraded Crosswork Data Gateway VMs.

• Jobs start again automatically with the new Cisco Crosswork Data Gateway VMs.

Shut Down the old Cisco Crosswork Cluster

Before you begin

Gather the following information before shutting down the older version of Cisco Crosswork:

• All the IP addresses in the cluster.

• All the IP addresses of the CDGs.

Step 1 After a successful backup, shut down the Cisco Crosswork cluster by powering down the VMs hosting each node (start
with the Hybrid VMs):
a) Log into the VMware vSphere Web Client.
b) In the Navigator pane, right-click the VM that you want to shut down.
c) Choose Power > Power Off.
d) Wait for the VM status to change to Off.
e) Wait for 30 seconds and repeat steps 1a to 1d for each of the remaining VMs.

Step 2 Shut down the Crosswork Data Gateway VMs.
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a) Log in to the previous version of Crosswork Data Gateway VM. See Access Crosswork Data Gateway VM from
SSH, on page 110.

Crosswork Data Gateway launches an Interactive Console after you login successfully.

b) Choose 5 Troubleshooting.
c) From the Troubleshooting menu, choose 5 Shutdown VM to shut down the VM.

Step 3 (Optional) Move Cisco NSO into read-only mode to avoid any unintended updates to Cisco NSO during the upgrade.
Use the following command to move NSO to read-only mode:
ncs_cmd -c maapi_read_only

For more information, please refer to the relevant Cisco NSO documentation.

Update a Crosswork Application (standalone activity)
This section explains how to independently update a Crosswork application from the Cisco Crosswork UI in
case of minor updates or patch releases. This procedure is not part of the upgrade workflow discussed in the
earlier sections.

Before you begin, ensure that you:

• Take a backup of your data (using the backup/restore functionality) before any critical upgrade.

• Download the latest version of the Crosswork APPlication file (CAPP) from cisco.com to your local
machine.

Crosswork does not support the downgrade operation of a CAPP file. However, if you want to go back to an
older application version, you can uninstall the application and install the older version of the application. In
case of a downgrade, you are advised to take a backup of your data prior to the operation.

Note

Step 1 Download and validate the CAPP files:

a) Navigate to cisco.com and locate the CAPP files (.tar.gz) that you require.
b) Hover over the file and copy the MD5 or SHA512 checksum to your clip board.
c) Download the CAPP files to a server that can be reached from the Crosswork server.
d) Run a tool of your choice to calculate the checksum, and compare the checksum value in your downloaded file with

the value you copied in the clip board.

For example, on a MAC you can use the md5 command to calculate the MD5 sum on a file:
md5 cw-na-ztp-4.0.3-3-release-220614.tar.gz

ff47a72ed7dc4fc4be388db3a43fa13f

Verify that the result value matches with the posted value on cisco.com.

Step 2 Click on Administration > Crosswork Manager, and select the Application Management tab.

The Crosswork Platform Infrastructure and any applications that are added are displayed here as tiles.

Cisco Crosswork Network Controller 6.0 Installation Guide
219

Upgrade Cisco Crosswork Network Controller
Update a Crosswork Application (standalone activity)

https://developer.cisco.com/docs/nso/guides/
https://software.cisco.com/download/home
https://software.cisco.com/download/home
https://software.cisco.com/download/home


Step 3 Click on the Add File (.tar.gz) option to add the application CAPP file that you had downloaded.
Step 4 In the Add File dialog box, enter the relevant information and click Add.

Once the CAPP file is added, you can observe the existing application tile (in this example, Zero Touch Provisioning)
displaying an upgrade prompt.

Figure 49: Applications Window - Upgrade Prompt

Step 5 To upgrade, click the Upgrade prompt and the new version of the application is installed.

Figure 50: Applications Window - Update Progress

The upgrade progress is displayed on the application tile.

Step 6 Alternately, click on the tile, and select the Upgrade option from the drop down list.

Figure 51: Applications Window - Upgrade Option

In the Upgrade screen, select the new version that you want to upgrade to, and click Upgrade.
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Figure 52: Upgrade Window

Step 7 (Optional) Click on Job History to see the progress of the upgrade operation.

During an upgrade operation, typically only the components that have changed between the existing CAPP
file and the new CAPP file are installed, as the new version may continue to use the most of the resources
of the older version. This ensures a quick operation that happens without disruption to the current system
and session.

Note

During an upgrade, the application that is being updated will be unavailable until the update is completed.
During this time, any other users using the application will be notified via an alarm about the upgrade.

Note
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• Uninstall Cisco Crosswork, on page 225





C H A P T E R 13
Uninstall Cisco Crosswork

This chapter contains the following topics:

• Uninstall the Crosswork Cluster, on page 225
• Uninstall Crosswork Data Gateway, on page 226
• Uninstall Crosswork Applications, on page 228

Uninstall the Crosswork Cluster
This section explains the various methods to uninstall the Cisco Crosswork cluster.

• Delete the VM using the Cluster Installer, on page 225

• Delete the VM using the vSphere UI, on page 226

Delete the VM using the Cluster Installer
In case of a failed installation, the cluster installer tool is used to cleanup or delete any previously created
VMs based on the cluster-state. This is a critical activity during failed deployments. Any changes made to the
VM settings or the data center host requires a cleanup operation before redeployment.

The installer cleanup option will delete the cluster deployment based on the inventory in /data directory.Note

Step 1 Enter the directory storing the deployment info.

For example, _cd ~/cw-cluster.

Step 2 Run the container on the host.
docker run --rm -it -v `pwd`:/data <cw-installer docker container>

Step 3 Edit the copy of the template file (for example, v4.tfvars) in a text editor, adding the data center access parameters.
Remaining parameters can be provided with dummy values, or entered on the command line during the execution of the
operation.
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Step 4 Run the _cw-installer.sh install_ script with the clean directive along with the deployment manifest using the -m
flag.

Add -o option to remove the Cisco Crosswork image template from the data center.

For example:
./cw-installer.sh clean -m /data/deployment.tfvars -o

Step 5 Enter "yes" when prompted to confirm the operation.
Step 6 (Optional) To clean the cluster quickly (without verification), users can run the installer using the following command:

docker run --rm -it -v `pwd`:/data <cw installer docker image> -exec './cw-installer.sh clean -m
/data/deployment.tfvars'

Delete the VM using the vSphere UI
This section explains the procedure to delete a VM from vCenter. This procedure is used to delete any Cisco
Crosswork application VM.

• Be aware that this procedure deletes all your app data.

• If you want to delete Crosswork Data Gateway only, ensure you have done the following:

• Detach the devices from the Crosswork Data GatewayVMyouwant to delete. For more information,
seeDelete Cisco Crosswork Data Gateway VM from Cisco Crosswork topic in theCisco Crosswork
Network Controller 6.0 Administration Guide.

• Delete the Crosswork Data Gateway VM from Cisco Crosswork as described in this chapter.

Note

Step 1 Log into the VMware vSphere Web Client.
Step 2 In the Navigator pane, right-click the app VM that you want to remove and choose Power > Power Off.
Step 3 Once the VM is powered off, right-click the VM again and choose Delete from Disk.

The VM is deleted.

Uninstall Crosswork Data Gateway
This section explains the methods to remove Cisco Crosswork Data Gateway.

• Delete Crosswork Data Gateway VM from Cisco Crosswork, on page 227

• Delete Crosswork Data Gateway from the Crosswork Cluster, on page 227
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Delete Crosswork Data Gateway VM from Cisco Crosswork

Before you begin

The Crosswork Data Gateway VM you want to delete:

• Must be in the maintenance mode.

• Must not be a part of a pool or attached to a device.

Step 1 Log into Cisco Crosswork UI.
Step 2 From the navigation panel, select Administration > Data Gateway Management.

Click the Data Gateway Instances tab.

Step 3 In the Data Gateway Instances list, find the Crosswork Data Gateway instance you want to delete and click under
Actions column.

Click Delete.

Step 4 If the Crosswork Data Gateway instance is not in the maintenance state, Cisco Crosswork prompts you to switch it to
maintenance state. Click Switch & Continue.

Figure 53: Switch & Continue Pop-up Window

The Crosswork Data Gateway instance is deleted.

Delete Crosswork Data Gateway from the Crosswork Cluster
To remove Crosswork Data Gateway from the Crosswork cluster, follow the below steps:
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Step 1 Remove the Crosswork Data Gateway instance from the Crosswork UI. Note down the Data Gateway Instance Name
and PDG Identifier from the Crosswork UI.

Step 2 Execute the following commands to remove the pods from the Crosswork cluster:

• kubectl edit cdgoperator cdgoperator-cr -n cdg

• If there is only one Crosswork Data Gateway in the cluster, remove the CDG array including cdg_dep_plan
under the spec section.

• If there are more than one Crosswork Data Gateway in the cluster, remove only the CDG array entry under
cdg_dep_plan which has to be deleted and save it.

• kubectl delete infraservices <Data Gateway Instance Name> -n cdg

For example, kubectl delete infraservices op-cdg -n cdg

• kubectl delete collectors collector-<PDG Identifier> -n cdg

For example, kubectl delete collectors collector-26b0053f-5132-4379-a107-f924dfde77f4 -n cdg

• kubectl delete icon icon-<PDG Identifier> -n cdg

For example, kubectl delete icon icon-26b0053f-5132-4379-a107-f924dfde77f4 -n cdg

• If offload pods are present, kubectl delete offload offload-<PDG Identifier> -n cdg

For example, kubectl delete offload offload-26b0053f-5132-4379-a107-f924dfde77f4 -n cdg

Uninstall Crosswork Applications
This section explains how to uninstall an application in the Crosswork UI. The Uninstall option removes the
application, application-specific menus and associated data.

Crosswork Active Topology (if installed) must be uninstalled before you can uninstall Crosswork Optimization
Engine.

Attention

Step 1 Click on Admin > Crosswork Manager, and select the Application Management tab.

The Crosswork Platform Infrastructure and any applications that are added are displayed here as tiles.

Step 2 Click on the application tile that you want to uninstall, and select the Uninstall option from the drop down list.
Step 3 Click Uninstall to confirm when prompted.

The selected application is uninstalled and the application tile is modified to reflect the same.
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Figure 54: Application Management Window

You can also view the progress of uninstallation in the Job History window (Application Management > Job History).
If the uninstall fails, you can reattempt using the relevant options in the Job History window.

The uninstall operation does not remove the CAPP file from the repository. The CAPP file will remain visible
in the Crosswork UI, in case user wants to install in the future.

Note
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P A R T VIII
Enable Geo Redundancy

• Geo Redundancy Overview, on page 233
• Geo Redundancy Requirements, on page 235
• Enable Geo Redundancy Solution, on page 237
• Upgrade to Geo Redundancy Solution, on page 255
• Geo Redundancy Switchover, on page 265





C H A P T E R 14
Geo Redundancy Overview

This chapter contains the following topics:

• Disclaimer, on page 233
• Introduction, on page 233

Disclaimer
The chapters in this part explains the requirements and processes to install or upgrade Geo Redundancy in
the Crosswork Network Controller solution.

Geo Redundancy is a limited feature in Crosswork Network Controller 6.0 release. For any assistance, please
contact the Cisco Customer Experience team.

Attention

Introduction
The geo redundancy solution ensures business continuity in case of a region or data center failure for on-premise
deployment. It adds another layer of protection in the high availability stack for Crosswork through geographical
or site redundancy. Geo redundancy protects against entire site failure, reduces disruption during system
upgrades, and reduces overall data loss.

Geo redundancy involves placing physical servers in geographically diverse availability zones (AZ) or data
centers (DC) to safeguard against catastrophic events and natural disasters. Availability Zones are multiple,
isolated locations in a region with independent sources for power, cooling, and networking.

Some of the key factors that ensure geo redundancy are:

• VM Node availability: At least 3 VM nodes are deployed in each cluster to ensure optimal availability
of infrastructure and applications. This provides physical compute availability and is the industry standard
number suggested for running services for high availability. Deploying 3 VM nodes address split-brain
problems, supports RAFT-based services, and allows for support of various in-service maintenance by
supporting single VM failure.

• Geo availability of Nodes: TheVMnodes are recommended to be placed in different AZ/regions to avoid
a central point of failure that could bring down all the VM nodes.

Cisco Crosswork Network Controller 6.0 Installation Guide
233



• Network Availability: The VM nodes are connected to the network that meet link availability and latency
requirements of the users.
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C H A P T E R 15
Geo Redundancy Requirements

This chapter contains the following topics:

• Unified Endpoint Requirements, on page 235
• Crosswork Cluster Requirements, on page 235
• Crosswork Data Gateway Requirements, on page 236

Unified Endpoint Requirements
• Unified endpoint is used to hide multiple instances in high availability for the various components.

• DNS allows endpoints to be referred via Fully Qualified Domain Name (FQDN) which should point to
the active instance IP. User will need domain zone provisioning under which Crosswork components
would have IP addresses mapped to FQDN. The DNS authoritative server must have A or AAAA entry
for the IP address from the user for the domain zone dedicated to Crosswork components.

Crosswork Cluster Requirements
Geo redundancy solution requires double the number of VMs required for a regular Crosswork Cluster
installation. For more information, see Installation Prerequisites for VMware vCenter, on page 19.

Important Notes

• While preparing inventory file, you must flush out details of cluster constituents along with connectivity
information.

• Setup the DNS server for your setup. The DNS server should resolve the unified multi-cluster FQDN
domain (for example, *.cw.cisco) you want to use and be reachable from both the clusters, Crosswork
Data Gateway, NSO, and SR-PCE. For more information on DNS setup procedure, see the Cisco Prime
Network Registrar Caching and Authoritative DNS User Guide.

• The DNS server should forward any outside domains to the external DNS servers.

• You should concurrently bring up the active and standby clusters using the existing installer mechanism.
Make sure to use the previously identified DNS server in the installation of Crosswork cluster, Crosswork
Data Gateway, and NSO.
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• You can optionally install applications on both the clusters, but devices, providers, or destinations must
be onboarded only on the active cluster.

• Before enabling geo redundancymode, you are recommended to make a backup of the active and standby
cluster that will be used in the geo redundancy setup.

• Once the geo redundancy mode is set up, it cannot be undone as the certificates are regenerated using
common root CA. To revert to non-geo redundancy mode, you can restore the backup made prior to
enabling the geo redundancy mode.

Crosswork Data Gateway Requirements
Confirm that you have met the minimum requirements outlined for Crosswork Data Gateway installation. For
more information, see Installation Prerequisites for VMware vCenter.
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C H A P T E R 16
Enable Geo Redundancy Solution

This chapter contains the following topics:

• Geo Redundancy Workflow (Day 0), on page 237
• Geo Redundancy Scenarios, on page 252
• Install Geo HA Crosswork Data Gateway, on page 253

Geo Redundancy Workflow (Day 0)
This topic explains the workflow to enable geo redundancy on day 0. The workflow give a high level description
of the tasks necessary to install and enable geo redundancy in Crosswork Network Controller.

The recommended day-0 setup for enabling geo redundancy is an empty Crosswork cluster (without any
applications, devices or data gateways onboarded).

Note

The following table describes the stages to install and enable the geo redundancy mode on Crosswork Network
Controller.

Table 58: Geo Redundancy Workflow (Day 0)

ActionStep

Install using your preferred method:

• Using cluster installer tool: Install Cisco Crosswork on
VMware vCenter using the Cluster Installer Tool , on page
44

• Manual Installation: Manual Installation of Cisco
Crosswork using vCenter vSphere UI, on page 58

Verify if the installation was successful, and log into the Cisco
Crosswork UI.

• Monitor Cluster Activation, on page 69

• Log into the Cisco Crosswork UI, on page 71

1. Install the Active Crosswork cluster.
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ActionStep

Install using your preferred method:

• Using cluster installer tool: Install Cisco Crosswork on
VMware vCenter using the Cluster Installer Tool , on page
44

• Manual Installation: Manual Installation of Cisco
Crosswork using vCenter vSphere UI, on page 58

Verify if the installation was successful, and log into the Cisco
Crosswork UI.

• Monitor Cluster Activation, on page 69

• Log into the Cisco Crosswork UI, on page 71

2. Install the Standby Crosswork cluster.

For more information, see the Import Cluster Inventory topic in
the Crosswork Network Controller 6.0 Administration Guide.

3. Validate the Crosswork Inventory. In
case of manual installation of Crosswork
Cluster, you must import a cluster
inventory file (.yaml file) to the Crosswork
UI.

If you fail to ensure this step,
the geo redundancy
enablement will fail.

Important

Follow the instructions in Manage Backups chapter in Cisco
Crosswork Network Controller 6.0 Administration Guide.

4. (Recommended) Create a backup of
your Crosswork cluster.

Follow the instructions in Connectivity Checks, on page 239 topic.5. Perform the connectivity checks.

Follow the instructions in Enable Geo Redundancy, on page 241
topic.

6. Prepare and upload the cross cluster
inventory template in the Active and
Standby clusters to enable geo redundancy.

Follow the instructions in View Cross Cluster Status, on page
245 topic.

7. Verify that the geo redundancy was
successfully enabled on the active and
standby clusters.
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ActionStep

Follow the instructions in below topics:

• Storage settings: Configure Cross Cluster Storage Settings,
on page 246

• Sync settings: Configure Cross Cluster Sync Settings, on
page 247

• DNS settings: Configure Cross Cluster DNS Settings, on
page 248

• Arbitration settings: Configure Cross Cluster Arbitration
Settings, on page 250

• Notification settings: Configure Cross Cluster Notification
Settings, on page 251

8. Configure the cross cluster settings

Check the following:

• In the Cross Cluster Health Status, ensure the operational
state is Connected.

• In the Cross Cluster Health Status, ensure that Active cluster
state is Healthy.

• In the Cross Cluster Health Status, ensure that Standby
cluster state is Healthy.

• In the Cross Cluster Health Status, ensure the High
Availability state is AVAILABLE.

• Verify if the heartbeat count between the clusters is
incrementing and no failures are observed for over a
30-minute period.

• Confirm the completion of one successful sync between the
clusters.

9. Validate if geo redundancy is enabled

Connectivity Checks
Perform the following connectivity checks before enabling geo redundancy:

• Copy (using SCP) a file from Availability Zone 1 (AZ1) to Availability Zone 2 (AZ2), and from AZ2 to
AZ1 in corresponding Crosswork VMs and Crosswork Orchestrator pods to ensure connectivity between
both clusters.
# Perform the below steps from AZ1 to AZ2, and from AZ2 to AZ1:

root@dev4-jump:~# ssh cw-admin@192.168.6.100
Password:
Last login: Sat Jul 1 16:50:21 2023 from 192.168.6.6
Cisco Crosswork
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Copyright (c) 2023 by Cisco Systems, Inc.
Version: release-6.0.0 (Build 182)
Built on: Jul-01-2023 01:27 AM UTC

cw-admin@192-168-6-101-hybrid:~$ sudo su
[sudo] password for cw-admin:
root@192-168-6-101-hybrid:/home/cw-admin# kubectl exec -it -n=kube-system
robot-orch-76856487-562w6 -- bash
robot-orch-76856487-562w6:~# touch t.txt
robot-orch-76856487-562w6:~# scp t.txt cw-admin@YOUR_PEER_CLUSTER_MGMT_VIP:/home/cw-admin/
(cw-admin@192.168.5.100) Password:
t.txt

robot-orch-76856487-562w6:~# scp t.txt cw-admin@YOUR_PEER_CLUSTER_DATA_VIP:/home/cw-admin/
(cw-admin@192.168.5.100) Password:
t.txt

• Static routes are not required for cross cluster connectivity.

• Mesh connectivity is required between Crosswork Network Controller, Crosswork Data Gateway, NSO,
and data interface components across the AZs.

• L2/L3 connectivity is supported.

• Test the DNS resolution on system wide DNS server.
### Internal Authortative resolution

dig @your_dns_server_ip your_name.cw.cisco

; <<>> DiG 9.10.6 <<>> @172.28.122.84 geomanagement.cw.cisco
; (1 server found)
;; global options: +cmd
;; Got answer:
;; ->>HEADER<<- opcode: QUERY, status: NOERROR, id: 8167
;; flags: qr aa rd ra; QUERY: 1, ANSWER: 1, AUTHORITY: 0, ADDITIONAL: 1

;; OPT PSEUDOSECTION:
; EDNS: version: 0, flags:; udp: 1232
;; QUESTION SECTION:
;your_name.cw.cisco. IN A

;; ANSWER SECTION:
your_name.cw.cisco. 5 IN A 192.168.6.100

;; Query time: 126 msec
;; SERVER: 172.28.122.84#53(172.28.122.84)
;; WHEN: Fri Jun 30 23:47:51 PDT 2023
;; MSG SIZE rcvd: 67

### External forwarding and resolution

dig @your_dns_server_ip ntp.esl.cisco.com

; <<>> DiG 9.10.6 <<>> @172.28.122.84 ntp.esl.cisco.com
; (1 server found)
;; global options: +cmd
;; Got answer:
;; ->>HEADER<<- opcode: QUERY, status: NOERROR, id: 43986
;; flags: qr rd ra; QUERY: 1, ANSWER: 1, AUTHORITY: 0, ADDITIONAL: 1

;; OPT PSEUDOSECTION:
; EDNS: version: 0, flags:; udp: 1232
;; QUESTION SECTION:
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;ntp.esl.cisco.com. IN A

;; ANSWER SECTION:
ntp.esl.cisco.com. 1 IN A 171.68.38.66

;; Query time: 311 msec
;; SERVER: 172.28.122.84#53(172.28.122.84)
;; WHEN: Fri Jun 30 23:46:37 PDT 2023
;; MSG SIZE rcvd: 62

• Verify if the DNS TTL in your VM is lesser than 60 seconds (< 60s).
# DNS TTL with 5s for FQDN entry

cw-user@admin-M-C2EM ~ % dig +nocmd +noall +answer @your_dns_server_ip your_fqdn
geomanagement.cw.cisco. 60 IN A 192.168.6.100

Enable Geo Redundancy
This topic explains the procedure to enable geo redundancy from Crosswork UI.

Click on How it works? link to view a visual representation of how geo redundancy is enabled.Tip

Before you begin

Ensure you have met all the requirements specified in Geo Redundancy Requirements, on page 235.

Step 1 Log in to the Crosswork cluster that will function as the active cluster.
Step 2 From the main menu, choose Administration > Geo Redundancy Manager. The Geo Redundancy Manager window

is displayed.

Figure 55: Geo Redundancy Manager

Step 3 Click on Download a Template file to download the sample template (.yaml file) for the cross cluster inventory (for
more details, see Sample Cross Cluster Inventory Template). Fill the template file with the relevant information for active
and standby clusters and the unified cross cluster.
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Step 4 Click Browse and select the cross cluster inventory file that you prepared. The Import Inventory File dialog box is
displayed. Verify the contents of the template file.

Step 5 After you have verified, click Setup. A service interruption alert is displayed. Click Proceed to continue.

This is the final step to enable geo redundancy. It cannot be undone.Important

The progress can be viewed from the Jobs window, or by clicking the icon.

Figure 56: Inventory import

After the standby cluster is created, the setup status will be displayed as Completed on both clusters.

Figure 57: Geo Redundancy Jobs

Step 6 After inventory upload is completed in the first cluster, the same process must be repeated in the second cluster.
Step 7 Log in to the Crosswork cluster that will function as the standby cluster, and repeat the actions in steps 4 and 5.

Please activate Pairing mode if the standby cluster is activated more than 6 hours after the active cluster.Important
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Once the inventory upload is successfully completed on both clusters, the status will be updated in the Geo Redundancy
Manager window.

Figure 58: Geo Redundancy Status Update

Sample Cross Cluster Inventory Template
Here is an example of the cross cluster inventory file (.yaml) that you need to prepare to enable geo redundancy:
############## Crosswork Multi cluster yaml for enabling Geo Redundancy ##########
## meta version of yaml ###
meta_version: 1.0.0
## Crosscluster name , mutable
crosscluster_name: mycnc-geo-cluster
### Unified endpoint of multi cluster for management and data endpoint across clusters
crosscluster_unified_connectivity:
unified_end_point:
unified_endpoint_type:
#### fqdn_type,ip_type are options , only fqdn_type is supported.
fqdn_type: {}

#### DNS,BGP,NLB are options, only DNS is supported for now.
unified_endpoint_implementation: DNS
### The below is needed if fqdn_type is chosen,else data_vip,mgmt_vip could be used

for ip_type endpoint type
management_fqdn:
## cnc domain zone, DNS server would be checked for resolution
domain_name: your-name.domain
host_name: your-unified-cnc-mgmt-hostname

data_fqdn:
## cnc domain zone name, DNS server would be checked for resolution
domain_name: your-name.domain
host_name: your-unified-cnc-data-hostname

### Constituent clusters ####
clusters:
##### Mutable cluster name
- cluster_name: cluster-sjc
connectivity:
### Intra cluster (within a cluster) unified endpoint ###
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### Endpoint type is ip_type,fqdn_type , Implementation could be VRRP,NLB,BGP.
unified_end_point:
unified_endpoint_type:
ip_type: {}

#### VRRP,BGP,NLB are options, only VRRP,ip_type is supported for now in on prem.
For cloud NLB,

### fqdn_type could be used.
unified_endpoint_implementation: VRRP

### The below is needed if ip_type is chosen,else data_fqdn,mgmt_fqdn could be used
for fqdn_type endpoint type

## Your intra cluster data vip
data_vip: 10.10.10.11
## data vip subnet mask
data_vip_mask: 0
## Your intra cluster management vip
management_vip: 20.20.20.11
## management vip subnet mask
management_vip_mask: 0
## management and data fqdn for crosscluster instance
## management and data fqdn is applicable for only for unified crosscluster instance

## STANDBY or ACTIVE for leadership state
initial_preferred_leadership_state: ACTIVE
### DC location , needs to be unique per cluster, For cloud region-az could be used
site_location:
location: San Jose
#Mutable credentials

cluster_credential:
## This is the https credential post first time cluster login
https_credential:
username: admin
#### pwd/secrets are within single quotes,if special chars are used
password: your-password

ssh_credential:
username: admin
#### pwd/secrets are within single quotes,if special chars are used
password: your-password

##### Mutable cluster name
- cluster_name: cluster-nyc
## STANDBY or ACTIVE for leadership state
initial_preferred_leadership_state: STANDBY
connectivity:
### Intra cluster (within a cluster) unified endpoint ###
### Endpoint type is ip_type,fqdn_type , Implementation could be VRRP,NLB,BGP.
unified_end_point:
unified_endpoint_type:
ip_type: {}

#### VRRP,BGP,NLB are options, only VRRP,ip_type is supported for now in on prem.
For cloud NLB,

### fqdn_type could be used.
unified_endpoint_implementation: VRRP

### The below is needed if ip_type is chosen,else data_fqdn,mgmt_fqdn could be used
for fqdn_type endpoint type

## Your intra cluster data vip
data_vip: 30.30.30.11
## data vip subnet mask
data_vip_mask: 0
## Your intra cluster management vip
management_vip: 40.40.40.11
## management vip subnet mask
management_vip_mask: 0
## management and data fqdn for crosscluster instance
## management and data fqdn is applicable for only for unified crosscluster instance

### DC location , needs to be unique per cluster, For cloud region-az could be used
site_location:
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location: New York City
#Mutable credentials
cluster_credential:
## This is the https credential post first time cluster login
https_credential:
username: admin
#### pwd/secrets are within single quotes if special chars are used
password: your-password

ssh_credential:
username: admin
#### pwd/secrets are within single quotes if special chars are used
password: your-password

#### Mutable secret are within single quotes if special chars are used, used to kick-start
inter cluster mTLS
### needs to be >= 10 chars with at-least 1 special,upper,numerical characters
secret: Your-secret1
### Set this to true , if one is enabling geo mode on a system post migration setup, rather
than a fresh first time
## install
is_post_migration_activation: false
### Set this to true , if one is enabling geo mode on a system post Disaster Recovery when
both the clusters are down
is_skip_peer_check_enabled: false

View Cross Cluster Status
This topic explains how to view the cross cluster status after successfully enabling geo redundancy.

Step 1 From the main menu, choose Administration > Cross Cluster. The Cross Cluster window is displayed.

The cross cluster health status is displayed along with the high availability state, heartbeats round trip time, failed heartbeats,
and last active cluster change time. You can also view the status of the active and standby clusters along with the operational
state and last sync status.

Figure 59: Cross Cluster Overview

Step 2 (Optional) Click next to failed heartbeats to see a visual representation of the heartbeat count.
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Figure 60: Cross Cluster Overview

Step 3 (Optional) Click Actions > Showtech Request to download the showtech logs.

Configure Cross Cluster Storage Settings
This topic explains how to configure the cross cluster storage settings.

Step 1 From the main menu, choose Administration > Cross Cluster. The Cross Cluster window is displayed. Click on the
Configurations tab.

The Storage Settings window is displayed.

After a SCP host is configured, you can view the used and free space available in the server.Note
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Figure 61: Storage Settings

Step 2 Fill all the fields provided for the SCP Host server.

To add additional SCP host, select the Additional SCP host checkbox. Additional SCP host is needed only when the
current SCP host is not highly available across both AZs.

Step 3 (Optional) Select the checkbox to apply the same configuration to the other cluster.
Step 4 Click Save to save the changes.

Save is enabled only after all cross cluster settings are completed.Note

Configure Cross Cluster Sync Settings
This topic explains how to configure the cross cluster sync settings.

During the sync, the systemwill automatically go in to maintenance mode and can result in service disruptions.
It is recommended to schedule the sync accordingly to minimize disruption to other users.

Note

Step 1 From the main menu, choose Administration > Cross Cluster. The Cross Cluster window is displayed. Click on the
Configurations tab.

Step 2 Click on the Configurations tab, and click on the Sync Settings.
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The Sync Settings window is displayed. The Sync Status will display the current status of the clusters. the last sync
status, and the last successful sync job time.

Figure 62: Sync Settings

Step 3 (Optional) Click Initiate Sync to start the sync immediately. A confirmation prompt is displayed. Click Proceed to
continue.

• Do not click Initiate Syncwithout completing all other sync configurations (such as storage, DNS, and
sync settings).

• Once a sync is initiated, it cannot be stopped midway.

Important

Step 4 (Optional) To set a auto-sync schedule, toggle the Sync Enabled button, and set the sync times.

It is recommended to sync at least once every 12 hours.Note

Step 5 (Optional) Select the check box to apply the same configuration to the other cluster.
Step 6 Click Save to save the changes.

Save is enabled only after all cross cluster settings are completed.Note

Configure Cross Cluster DNS Settings
This topic explains how to configure the cross cluster DNS settings.
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The DNS record TTL for FQDN must be lesser than 60 seconds (< 60s).Note

Step 1 From the main menu, choose Administration > Cross Cluster. The Cross Cluster window is displayed. Click on the
Configurations tab.

Step 2 Click on the Configurations tab, and click on the DNS Settings.

The DNS Settings window is displayed. The management FQDN and data FQDN details are displayed.

Figure 63: DNS Settings

The DNS server should be configured with the same management FQDN and data FQDN shown on the UI.Note

Step 3 Add the details for the Authoritative DNS Server and Port.
Step 4 (Optional) Select the checkbox to apply the same configuration to the other cluster.
Step 5 Click Save to save the changes.
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Save is enabled only after all cross cluster settings are completed.Note

Configure Cross Cluster Arbitration Settings
This topic explains how to configure the cross cluster arbitration settings.

Step 1 From the main menu, choose Administration > Cross Cluster. The Cross Cluster window is displayed. Click on the
Configurations tab.

Step 2 Click on the Configurations tab, and click on the Arbitration Settings.

The Arbitration Settings window is displayed.

Figure 64: Arbitration Settings
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Step 3 Set relevant values for the Heartbeat Time Interval and Failure Detection Wait Period fields.
Step 4 (Optional) Select the checkbox to apply the same configuration to the other cluster.
Step 5 Click Save to save the changes.

Save is enabled only after all cross cluster settings are completed.Note

Configure Cross Cluster Notification Settings
This topic explains how to configure the cross cluster notification settings.

Step 1 From the main menu, choose Administration > Cross Cluster. The Cross Cluster window is displayed. Click on the
Configurations tab.

Step 2 Click on the Configurations tab, and click on the Notification Settings.

The Notification Settings window is displayed.

Figure 65: Notification Settings

Step 3 (Optional) Click Add Criteria to add a syslog server.
Step 4 Once the syslog server is added, provide the relevant information for the notification settings.
Step 5 (Optional) Select the checkbox to apply the same configuration to the other cluster.
Step 6 Click Save to save the changes.

Save is enabled only after all cross cluster settings are completed.Note
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Geo Redundancy Scenarios
This topic explains the expected system behavior for certain geo redundancy scenarios.

Application Installation

Table 59: Application Installation Scenarios

Expected System BehaviorScenario

An equivalency check done prior to the geo redundancy
enablement will identify any mismatch between the active
and standby clusters (in terms of applications or versions),
and prevent enablement. To proceed, please ensure that
applications and versions match on both clusters.

Application or version mismatch between
active and standby clusters prior to enabling
geo redundancy.

Any configured sync operation will fail until the mismatch is
corrected.

Application or version mismatch between
active and standby cluster after enabling geo
redundancy.

A sync operation can be configured as a periodic event or
initiated on demand. While a sync operation is in progress,
application installation will not be allowed.

Installing an application or patch while a sync
is in progress.

When sync is not happening, application installation is
allowed.

Installing an application or patch when sync
is not happening.

Backup and Restore

Table 60: Backup and Restore Scenarios

Expected System BehaviorScenario

This operation is allowed. You are recommended to make
data only backup of the active cluster for the following
reasons:

• In case the data sync is corrupted between clusters or in
the event of a disaster, you will have a point in time to
roll back.

• If you want to restore the cluster to a previous point in
time.

Taking a data only backup on the active
crosswork cluster.

This operation is not permitted.Taking a data only backup on the standby
crosswork cluster.
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Expected System BehaviorScenario

This operation is allowed.

In case the data sync is corrupted between clusters, you can
restore the data only backup made on the active cluster and
allow the normal sync flow to sync the standby cluster.

Disaster recovery from a corrupted data sync
between the clusters.

In the rare case that the active and standby clusters are
unrecoverable or unusable, please redeploy the active and
standby clusters and apply the data only backup on the active
cluster. The standby will sync in the normal sync flow.

Disaster recovery where both clusters need to
recovered

This operation is not permitted.Perform restore operation on the standby
cluster.

This operation is allowed. If you want to restore a previous
backup, perform the restore only on the active cluster, and
allow the standby cluster will sync on the next sync cadence.

Perform restore operation on the active cluster.

The following combinations are supported:

Table 61: Supported Backup Restore Combinations

SupportTo DeploymentFrom DeploymentBackup Type

SupportedGeo redundantGeo redundantData only

SupportedNon-geo redundantNon-geo redundantData only

Any other combination is not supported.

Password Update

Follow the below sequence while updating password on a geo redundant cluster:

1. Update the password on the active cluster.

2. Wait for the sync operation to complete, and the password update is pushed to the standby cluster.

3. Update the inventory file on the active cluster.

Install Geo HA Crosswork Data Gateway
Cisco Crosswork Data Gateway is installed as a base VM that contains only enough software to register itself
with Cisco Crosswork.

If you are redeploying the same Cisco Crosswork Data Gateway with Cisco Crosswork, delete the previous
Crosswork Data Gateway entry from the Virtual Machine table under Data Gateway Management. For
information on how to delete a Crosswork Data Gateway VM, see Delete Crosswork Data Gateway from the
Crosswork Cluster, on page 227.

Note
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To install Crosswork Data Gateway VM for use with Cisco Crosswork, follow these steps:

1. Choose the deployment profile for the Crosswork Data Gateway VM.

For the VM requirements, see Crosswork Cluster VM Requirements, on page 27.

2. Review the installation parameters and make sure that you have all the required information to install
Crosswork Data Gateway using your the preferred deployment scenario. For the parameter information,
see Cisco Crosswork Data Gateway Parameters and Deployment Scenarios, on page 80.

3. Install Cisco Crosswork Data Gateway using yours preferred method:

Table 62: Crosswork Data Gateway installation options

Install Cisco Crosswork Data Gateway using
vCenter vSphere Client, on page 93

VMware

Install Cisco Crosswork Data Gateway via OVF
Tool, on page 105

4. Complete the post-installation tasks mentioned in the section Crosswork Data Gateway Post-installation
Tasks, on page 112.

5. Verify that the Crosswork Data Gateway VM has enrolled successfully with Cisco Crosswork. For
information on how to verify the enrollment process, see Cisco Crosswork Data Gateway Authentication
and Enrollment, on page 112.

After verifying that the Crosswork Data Gateway VM has enrolled successfully with Cisco Crosswork, set
up the Crosswork Data Gateway for collection by creating a Crosswork Data Gateway pool. For more
information, see the Create a Crosswork Data Gateway Pool section in Cisco Crosswork Network Controller
6.0 Administration Guide.
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C H A P T E R 17
Upgrade to Geo Redundancy Solution

This chapter contains the following topics:

• Upgrade from Crosswork Network Controller 5.0 to 6.0 (Geo Redundant), on page 255

Upgrade from Crosswork Network Controller 5.0 to 6.0 (Geo
Redundant)

This topic explains the high level description of the tasks necessary to upgrade from Crosswork Network
Controller version 5.0 to version 6.0 (geo redundant enabled).

Any day N activity will yield the system ineligible to migrate to a geo redundant solution. You will need to
re-install the Crosswork cluster to enable geo redundancy.

Note

Table 63: Upgrade from Crosswork 5.0 to 6.0 Geo Redundancy (Day 0)

ActionStep

Follow the instructions in Convert Single Instance NSO to NSO
HA, on page 256 topic.

Crosswork Network Controller 6.0 supports NSO
version 6.1.4. The process to upgrade NSO is not
covered in this document. For more information,
see the relevant Cisco NSO documentation.

Note

1. Convert single instance NSO to NSO
HA

Deploy SR-PCE in a Point of Presence (PoP) site closer to the
Crosswork's Availability Zone. For more information, refer to
the relevant install instructions in the Cisco IOSXRv 9000 Router
Installation Guide.

Crosswork Network Controller 6.0 supports IOS
XR 7.11.1.

Note

2. Deploy SR-PCE
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ActionStep

Follow the instructions in Create Backup of the Cisco Crosswork
Cluster, on page 257 topic.

3. Create backup of the Crosswork 5.0
cluster.

Shut down the Cisco Crosswork 5.0 cluster by powering down
the VMs hosting each node (start with the Hybrid VMs).

1. Gather following information before shutting down the
cluster.

• All IP addresses of the cluster.

• All IP addresses of the Crosswork Data Gateways

2. Shut down the VMs of the Crosswork cluster. For vcenter
shutdown all the VMs using vcenter UI

3. Log into the VMware vSphereWeb Client. In theNavigator
pane, right-click the VM that you want to shut down.

4. Choose Power > Power Off. Wait for the VM status to
change to Off.

5. Wait for 30 seconds and repeat the steps for each of the
remaining VMs.

6. (Optional) Put NSO in read-only mode using ncs_cmd -c

maapi_read_only command.

4. Shut down the Crosswork 5.0 cluster

Follow the instructions in Install the Cisco Crosswork 6.0 Cluster
and Applications, on page 259 topic.

4. Install the Crosswork Network
Controller 6.0 cluster and applications.

Follow the instructions in Run Migration, on page 260 topic.5. Perform the migration.

Follow the instructions in Install the Standby Cluster and Enable
Geo Redundancy, on page 261 topic.

6. Install the standby cluster and enable
geo redundancy solution.

Follow the instructions in Upgrade Crosswork Data Gateway
5.0 to 6.0 Geo Redundancy, on page 262 topic.

7. Upgrade Crosswork Data Gateway 5.0
to 6.0 (geo Redundant)

Follow the instructions in Update Providers, on page 263 topic.8. Update the providers.

Follow the instructions in Complete Geo Redundancy
Enablement, on page 263 topic.

9. Complete the geo enablement operation.

Convert Single Instance NSO to NSO HA
This topic explains the procedure to convert a single instance NSO to NSO HA (High Availability). For
detailed instructions, please refer to the NSO Administration Guide on HA.

Make a backup and upgrade your NSO setup to the compatible version before executing the below steps.Attention
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Follow the below guidelines to create a HA setup from a standalone NSO.

Step 1 Determine the High Availability topology to follow: L2 or L3
Step 2 Make a backup of the original NSO system.
Step 3 Clone the original NSO to a new instance.
Step 4 Install the hcc package on both nodes.
Step 5 Configure the high availability and hcc as per the selected network topology.
Step 6 Request to enable high availability on both nodes.
Step 7 Verify the changes made.

Create Backup of the Cisco Crosswork Cluster
Creating a backup is a prerequisite when upgrading your current version of Cisco Crosswork to a new version.

We recommend that you create a backup only during a scheduled upgrade window. Users should not attempt
to access Cisco Crosswork while the backup operation is running.

Note

Before you begin

Follow these guidelines whenever you create a backup:

• Cisco Crosswork will back up the configuration of the system to an external server using SCP. Before
you begin you need to have the following configuration in place and information about the SCP server
available:

• The hostname or IP address and the port number of a secure SCP server.

• A preconfigured path on the SCP server where the backup will be stored.

• User credentials with file read and write permissions to the directory.

• The SCP server storage requirements will vary slightly but you must have at least 25 GB of storage.

• Ensure that you have configured a destination SCP server to store the backup files. This configuration
is a one-time activity.

• After the backup operation is completed, navigate to the destination SCP server directory and ensure that
the backup file is created. You will require this backup file in the later stages of the upgrade process.

• Both the Cisco Crosswork cluster and the SCP server must be in the same IP environment. For example:
If Cisco Crosswork is communicating over IPv6, so must the backup server.

• Keep a record of the list of Crosswork applications you have installed in the current version of Cisco
Crosswork, as you can only install those applications after migrating to the new version of Cisco
Crosswork.
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• If you have onboarded a custom MIB package in the current version of Cisco Crosswork, download a
copy of the package to your system. You will need to upload the package after you complete migrating
to new version of Cisco Crosswork.

• If you have modified the current version of Cisco Crosswork to include third-party device types, you
must download the third-party device configuration file, and re-apply it to the new version of Cisco
Crosswork. The device configuration file is located on the cluster node (at
/mnt/cw_glusterfs/bricks/brick3/sys-oids.yaml) and on the pod (at
/mnt/backup/sys-oids.yaml).

• If Cisco Crosswork Optimization Engine has feature packs (Local Congestion Mitigation (LCM),
Bandwidth Optimization (BWOpt), and Bandwidth on Demand (BWoD)) that are enabled, you must
disable them before proceeding. You must also, if available, export the current list of interfaces managed
by LCM or BWOpt (Traffic Engineering > Local Congestion Mitigation > Domain Identifier
<domain_id> > Interface Thresholds > ExportOR Traffic Engineering > Bandwidth Optimization
> Interface Thresholds > Export icon).

Step 1 Login to the Crosswork UI by navigating to https://<VIP>:30603.

The VIP refers to the Management Virtual IP of the cluster.

Step 2 Check and confirm that all the VMs are healthy and running in your cluster.
Step 3 Configure an SCP backup server:

a) From the Cisco Crosswork main menu, choose Administration > Backup and Restore.
b) Click Destination to display the Edit Destination dialog box. Make the relevant entries in the fields provided.
c) Click Save to confirm the backup server details.

Step 4 Create a backup:

a) From the Cisco Crosswork main menu, choose Administration > Backup and Restore.
b) Click Actions > Backup to display the Backup dialog box with the destination server details prefilled.
c) Provide a relevant name for the backup in the Job Name field.
d) If any of the VMs or applications are not in Healthy state, but you want to create the backup, check the Force check

box.

The Force option must be used only after consultation with the Cisco Customer Experience team.Note

e) Uncheck the Backup NSO checkbox if you don't want to include Cisco NSO data in the backup.

If you do want to include Cisco NSO data in the Cisco Crosswork backup process, follow the instructions given in
Backup Cisco Crosswork with Cisco NSO section in the Cisco Crosswork Network Controller 6.0 Administration
Guide instead of the instructions here.

f) Complete the remaining fields as needed.
If you want to specify a different remote server upload destination: Edit the pre-filled Host Name, Port, Username,
Password and Remote Path fields to specify a different destination.

g) (Optional) Click Verify Backup Readiness to verify that Cisco Crosswork has enough free resources to complete
the backup. If the verifications are successful, Cisco Crosswork displays a warning about the time-consuming nature
of the operation. Click OK.

If the verification is unsuccessful, please contact the Cisco Customer Experience team for assistance.
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h) Click Start Backup to start the backup operation. Cisco Crosswork creates the corresponding backup job set and
adds it to the job list. The Job Details panel reports the status of each backup step as it is completed.

You can also perform a data backup (backup using rest-api). The data backup is faster as it does not
include application binaries. To perform, do the following:

• Get JWT (using sso apis)

• API to take the data backup (https://<VIP>:30603/crosswork/platform/v1/platform/backup/dataonly)

• Payload for the api {"jobName": "jobname","force": false}

Note

i) To view the progress of a backup job: Enter the job details (such as Status or Job Type) in the search fields in the
Backup and Restore Job Sets table. Then click on the job set you want.

The Job Details panel displays information about the selected job set, such as the job Status, Job Type, and Start
Time. If there’s a failed job, hover the mouse pointer over the icon near the Status column to view the error details.

After the backup operation is completed, navigate to the destination SCP server directory and ensure
that the backup file is created. You will require this backup file in the later stages of the upgrade process.

Note

If you do not see your backup job in the list, refresh the Backup and Restore Job Sets table.Note

j) If the backup fails during upload to the remote server: In the Job Details panel, just under the Status icon, click the
Upload backup button to retry the upload.

Upload can fail due to connectivity problems with the SCP backup server (for example, incorrect
credentials, missing directory or directory permissions, missing path and so on). This is indicated by
failure of the task uploadBackupToRemote). If this happens, check the SCP server details, correct
any mistakes and try again. Alternatively, you can use the Destination button to specify a different SCP
server and path before clicking Upload backup.

Note

Install the Cisco Crosswork 6.0 Cluster and Applications
This install the latest version of the Cisco Crosswork cluster and applications.

While the cluster installation is in progress, you must upgrade your NSO setup to the compatible version.
Please monitor actively to ensure that the NSO leader is in the same site as Crosswork.

Important

Before you begin

• Make sure that your environment meets all the installation prerequisites (see Installation Prerequisites
for VMware vCenter, on page 19).

Step 1 Install Cisco Crosswork 6.0 cluster (see Install Crosswork Cluster on VMware vCenter, on page 39) using the same IP
addresses and same number of nodes as in old cluster.
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Step 2 After the installation is completed, log into the Cisco Crosswork UI (using https://<VIP>:30603) and check if all the
nodes are up and running in the cluster.

Step 3 Install the Cisco Crosswork applications which were installed in the old cluster. Ensure that you install the latest versions
that are compatible with the 6.0 cluster. For installation instructions, please refer to the Install Crosswork Applications,
on page 169 chapter.

The applications binaries and versions are not updated in the migration job.Note

Step 4 After the applications are successfully installed, check the health of the new Cisco Crosswork cluster.
a) From the Cisco Crosswork main menu, choose Administration > Crosswork Manager > Crosswork Summary.
b) Click Crosswork Cluster tile to view the health details of the cluster.

Run Migration
After successfully installing the new versions of the Cisco Crosswork applications, proceed to migrate the
Cisco Crosswork backup taken earlier to the new Cisco Crosswork cluster.

Before you begin

Before you begin, ensure that you have:

• The hostname or IP address and the port number of a secure destination SCP server used in Create Backup
of the Cisco Crosswork Cluster, on page 257.

• The name and path of the backup file created in Create Backup of the Cisco Crosswork Cluster, on page
257.

• User credentials with file read and write permissions to the directory.

Step 1 Check and confirm that all the VMs are healthy and running in your cluster.
Step 2 Configure an SCP backup server:

a) From the main menu, choose Administration > Backup and Restore.
b) Click Destination to display the Edit Destination dialog box.
c) Make the relevant entries in the fields provided.

In the Remote Path field, please provide the location of the backup created in Create Backup of the
Cisco Crosswork Cluster, on page 257.

Note

d) Click Save to confirm the backup server details.

Step 3 Migrate the previous Cisco Crosswork backup on the new Cisco Crosswork cluster:

a) From the Cisco Crosswork main menu, choose Administration > Backup and Restore.
b) ClickActions >Data Migration to display theData Migration dialog box with the destination server details prefilled.
c) Provide the name of the data migration backup (created in Create Backup of the Cisco Crosswork Cluster, on page

257) in the Backup File Name field.
d) If you want to perform the data migration backup despite any Cisco Crosswork application or microservice issues,

check the Force check box.
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e) Click Start Migration to start the data migration operation. Cisco Crosswork creates the corresponding data migration
job set and adds it to the Backup and Restore Job Sets table. The Job Details panel reports the status of each backup
step as it is completed.

If you do not see your job in the list, please wait for a few minutes and refresh the Backup and Restore
Job Sets table.

Note

f) To view the progress of a data migration job: Enter the job details (such as Status or Job Type) in the search fields
in the Backup and Restore Job Sets table. Then click on the job set you want.

The Job Details panel displays information about the selected job set, such as the job Status, Job Type, and Start
Time. If there’s a failed job, hover the mouse pointer over the icon near the Status column to view the error details.

Crosswork UI might become temporarily unavailable during the data migration operation. When the
Crosswork UI is down, you can view the job status in the Grafana dashboard. The Grafana link is available
as View Data Migration Process Dashboard option on the right side of the Job Details window.

Note

g) If the data migration fails in between, you need to restart the procedure from step 1.

Step 4 After the data migration is successfully completed, check the health of the new Cisco Crosswork cluster.
a) From the Cisco Crosswork main menu, choose Administration > Crosswork Manager > Crosswork Summary.
b) Click Crosswork Cluster tile to view the health details of the cluster.

Install the Standby Cluster and Enable Geo Redundancy
After completing the migration on the active cluster, install the standby cluster and enable geo redundancy.

When you are enabling geo redundancy after the 5.0 to 6.0 migration, you must set the following flag in the
inventory file:

## install
is_post_migration_activation: true

Note

Step 1 In the second site, install the standby cluster. For more information, refer to the installation instructions in Install Cisco
Crosswork on VMware vCenter using the Cluster Installer Tool , on page 44 or Manual Installation of Cisco Crosswork
using vCenter vSphere UI, on page 58.

Step 2 Install the applications (that were installed on the active cluster) on the standby cluster.

Migration is not required in the standby cluster, as the changes would be taken from the active cluster during
the periodic sync operation.

Note

Step 3 Ensure DNS connectivity on both sites. Perform DNS server update on both sites if needed to ensure that Crosswork
cluster is using the right DNS server.

Step 4 Ensure unified cross cluster endpoint is resolved on site 1 (active site).
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Step 5 Create and upload the inventory file on site 1 to create the active cluster, and verify the operation. For more information,
refer to the instructions in Enable Geo Redundancy, on page 241.

Upgrade Crosswork Data Gateway 5.0 to 6.0 Geo Redundancy
This topic explains the procedure to upgrade from Crosswork Data Gateway version 5.0 to version 6.0 (geo
redundant enabled).

For the 6.0 Crosswork Network Controller release, it is mandatory to deploy Crosswork Data Gateway using
the FQDN.When Crosswork undergoes an upgrade, the existing data gateways transition to the ERROR state
because of their enrollment using the VIP address, resulting in a discrepancy in the enrollment information.

To install Crosswork Data Gateway after an upgrade:

Before you begin

Ensure that you are aware of the following:

• After Crosswork is upgraded, the data gateways, virtual data gateways, HA pool, and device-mapping
configuration are restored.

• The Data Gateway Manager automatically assigns the active Crosswork site as the default site for all
existing data gateways.

Step 1 Redeploy the Crosswork Data Gateway instance by removing the old instance and replacing it with a new installation.
During the redeployment, use the unified management FQDN for ControllerIP in the OVF deployment script.

For information on removing a data gateway instance, see Delete Crosswork Data Gateway from the Crosswork Cluster,
on page 227 and installing a new instance, see Install Geo HA Crosswork Data Gateway, on page 253.

If the data gateways are redeployed using the same name and hostname attribute provided in the OVF script, the Data
Gateway Manager considers them as existing gateways and automatically enrolls them with the upgraded Crosswork
during the migration process.

It is recommended to initiate a sync operation to enhance the accuracy of the data after the addition of a new
device or the deployment of a new gateway. See Configure Cross Cluster Sync Settings, on page 247 for
information on how to perform a sync operation.

Important

Step 2 Modify the high availability Crosswork Data Gateway pools as following:

• If a new data gateway instance is added to a high availability pool from the Standby site, which is currently the
Active site, and a switchover occurs. The data gateway's role changed from Spare to Assigned.

• By default, the existing pools will be tagged as imbalanced, as there are no data gateways connected to the standby
site. For preserving the data gateway balance, deploy new data gateways on the standby site.

• The SBConfig is configured to the Shared option. You must configure it to be Site-specific.

• Configure the VIP or FQDNs for the standby site.
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Step 3 Accept an upgrade acknowledgment message that appears on the Crosswork UI when all the data gateways with the
Assigned role are in the UP state and the Spare gateways in the NOT_READY state.

Data gateways with the Assigned role start the data collection.

What to do next

If the data gateways cannot connect with the Active cluster, re-enroll the gateway from the interactive menu.
See the Re-enroll Crosswork Data Gateway section in the Cisco Crosswork Network Controller 6.0
Administration Guide for more information.

Update Providers
After enabling geo redundancy on the active cluster, update the providers.

Skip this step if you are not planning to enable geo redundancy.Note

Step 1 Add the RBAC JWT token on the Cisco NSO VMs.
Step 2 Upload and update the JWT package on the Cisco NSO High Availability VMs.
Step 3 Reload the NCS packages on both VMs.
Step 4 Update the JWT auth file with geo-CW FQDN cnc-host value on both VMs.
Step 5 Update the cert.pem on both VMs.
Step 6 Update NSO with unified cluster endpoint in the Manage Providers window.
Step 7 (Optional) Update SR-PCE IP address in the Manage Providers window.
Step 8 (Optional)While upgrading from a non-HA setup to geo redundant mode, Crosswork Data Gateway will end with multiple

VIPs for southbound devices. These devices need to be set up for syslogs, traps and MDT. In case of MDT, you can use
admin DOWN/UP to push the configuration changes to the devices.

Any other external destination needs to be in HA mode with its own unified endpoint in the form of VIP or
FQDN.

Note

Complete Geo Redundancy Enablement
After updating the providers, activate geo redundancy on the standby cluster.

Skip this step if you are not planning to enable geo redundancy.Note

Step 1 Create and upload the cluster inventory file on site 2, to create the standby cluster. Verify the operation. For more
information, refer to the instructions in Enable Geo Redundancy, on page 241.

Cisco Crosswork Network Controller 6.0 Installation Guide
263

Enable Geo Redundancy
Update Providers



Step 2 Configure the cross cluster settings. For more information, see step 7 in the Geo RedundancyWorkflow (Day 0), on page
237 topic.

Step 3 Perform a on-demand sync to sync the data from active to standby cluster.
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C H A P T E R 18
Geo Redundancy Switchover

This chapter contains the following topics:

• Perform Switchover, on page 265

Perform Switchover
Switchover is the process of interchanging the roles of the active cluster and standby cluster in the event of a
failure.

In case of a failure, the system performs many preliminary checks (heartbeat count, connectivity checks,
HTTP and SSH login checks, etc.) and raises alarms if they fail. If you notice an alarm, you are expected to
check both clusters to verify the authenticity of the alarms before they attempt a switchover.

If a switchover operation is completed on a standby VM (before the sync operation), there are no rows or
entries displayed on the Publish Details for tech-support jobs. This happens because the tech-support history
is written to ETCD which is not synced across geo redundancy setups. This is an expected system behavior.

Note

Before you begin

Before the switchover, it is important that both clusters have the same application versions and resource
footprints used.

Step 1 Log in to the standby cluster.
Step 2 From the main menu, choose Administration > Cross Cluster. The Cross Cluster window is displayed.
Step 3 Click Actions > Switch Cluster Role

The Switch Cluster Role dialog box is displayed with the initial state of the clusters. For the purpose of this topic, SJC
cluster (cluster-sjc) is in ACTIVE mode and NYC cluster (cluster-nyc) is in STANDBY mode.
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Figure 66: Switch Cluster Role

Step 4 Click on the NYC cluster to change it to ACTIVE state. Click Save to confirm change.
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Figure 67: Switch standby cluster to active

Step 5 Update the DNS server records of Management FQDN and Data FQDN to point to the new active cluster.
Step 6 Now log in to the SJC cluster (already active). In the Cross Cluster window, click Actions > Switch Cluster Role.

At this point, till the time you change the cluster state, both clusters will be in ACTIVE state.Note

Step 7 In the Switch Cluster Role dialog box, click on the cluster to change it to STANDBY state.
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Figure 68: Switch active cluster to standby

Click Save to confirm the change.

Wait for the device reachability to converge before moving to resume operations on the standby cluster.Note

Step 8 After few minutes, log in to the first cluster. The switchover will be completed.
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